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Copyright and Licensing Information 

Impact/SQL Version 10.6.0  

Copyright © 1992-2016 by USA Digital Solutions, Inc., Phoenix, Arizona. 

No part of this publication may be reproduced in any form without prior written permission of USA Digital 

Solutions, Inc.  For additional information, contact USA Digital Solutions, Inc., 10835 N. 25
th
 Ave., 

Phoenix, AZ 85029, or call 602-866-8199 x 2. 

Microsoft, Windows, Office, Word, Excel, and MS-DOS are registered trademarks of Microsoft 

Corporation in the United States and/or other countries.  Crystal Reports is a registered trademark of SAP 

AG.  RealEC Technologies, Inc. is a division of Black Knight Financial Services.  All other brand and 

product names are trademarks or registered trademarks of their respective companies. 

IMPORTANT NOTICE – READ CAREFULLY 

Use of this software and related materials is provided under the terms of the Impact/SQL License and 

Support Agreement.  By accepting the License, you acknowledge that the materials and programs 

furnished are the exclusive property of USA Digital Solutions, Inc.  You do not become the owner of the 

program, but have the right to use it only as outlined in the Impact/SQL License and Support Agreement. 

All USA Digital Solutions, Inc. products are designed to ASSIST in maintaining data and/or producing 

documents and reports based upon information provided by the user and logic, rules, and principles that 

are incorporated within the program(s).  Accordingly, the documents and/or reports produced may or may 

not be valid, adequate, or sufficient under various circumstances at the time of production.  UNDER NO 

CIRCUMSTANCES SHOULD ANY DOCUMENTS AND/OR REPORTS PRODUCED BE USED FOR 

ANY PURPOSE UNTIL THEY HAVE BEEN REVIEWED FOR VALIDITY, ADEQUACY AND 

SUFFICIENCY, AND REVISED WHERE APPROPRIATE, BY A COMPETENT PROFESSIONAL. 

  



USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 2 of 183 

Introduction to Impact/SQL Utilities 

The Impact/SQL Utilities module provides the system administrator with the tools required to oversee the 

configuration of the entire Impact/SQL suite. The Utilities module controls both the operating configuration 

of all of the other Impact modules and contains some tools used to monitor the system and address 

issues that might arise.  

This manual will explain all of the configuration parameters controlled from the Impact/SQL Utilities 

module and explain the available tools. There are a tremendous number of configuration options that can 

affect the functionality of the system.  Other program functions that used to be discussed in this manual 

(Invoice Export and Income Export) are now found in the Accounting module, and are explained in that 

module’s manual.  As each company functions in its own unique way, there are some functions within 

Impact/SQL that may not be utilized, but you are encouraged to examine and consider all of them to 

ensure you are getting the most out of Impact/SQL.   

IMPORTANT NOTE: The settings made through Impact/SQL Utilities are very critical and 

some of them, once determined, cannot be altered without serious consequences. Therefore, 

those responsible for system administration must be very clear on what each of the settings 

is for and the ramifications of their use. A careful review of the information in this manual 

should help in that regard. Access to the Utilities module should be limited to those with an 

absolute need to be in it, and those individuals must have adequate training. 

Please contact USA Digital Solutions, Inc. before making any changes in the Utilities module 

unless you are comfortable with the subject matter.  

There are three major areas of focus in Impact/SQL Utilities:  

Fundamental system configuration 

Configuration of the large number of “lookup tables” with company-specific information 

Tools to correct problems or perform functions that are not routine 

Again, some of the settings will be established during system installation and testing and will not be 

changed going forward. Others may be altered as the company changes how it uses Impact/SQL as time 

goes by. For example, turning on a function like “Wire In Processing” might be done post-implementation. 

While there may be more than one person who utilizes the Utilities module, there should not be many 

more; and, those that do have access should communicate clearly with each other to keep everyone 

aware of changes that are being made therein. Generally, a System Administrator and the manager of the 

Escrow Accounting area will be the primary users of Utilities. Due to the impact of some of the settings, it 

is imperative that only qualified users are given access to Utilities. It is also critical that all changes made 

through Utilities are documented. A change might be made that has an unanticipated effect on the user 

environment and it will be easier to troubleshoot if there is documentation about all changes made 

through Utilities. 

NOTE: Several functions discussed herein require the Impact Windows Service, which was 

introduced with version 8.0 and is documented separately, to be installed and running. 
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General Information and Helpful Hints 

This manual progresses through the functions in Impact Utilities in the order that they appear on the 

menus within the module.  This is not how you will work with the product, as that will depend on your 

responsibilities and the structure of each individual business, as well as the configuration of Impact at 

each business.  Before discussing the system functionality in detail, there are some general features that 

you should be aware of.  These are discussed below. 

Some formatting conventions used in this manual are: 

When you need to press the Enter key, you will see ENTER in this manual. 

When you see text displayed on a menu or window such as the words “Edit” or “Cancel”, you will 

see Edit or Cancel in this manual. 

System Files > License Manager means that you select System Files from the main menu and 

then select License Manager from the sub menu. 

Quick Keys 

In the Impact/SQL Utilities module, as in other Impact/SQL modules, there are opportunities to move 

through the options available without using the mouse. Most menu items contain an underlined letter. If 

you hold down the ALT key and press the underlined letter of the option list you want displayed, the menu 

will drop down.   

ALT+S will open the System Files drop-down menu list; 

ALT+U will open the User Tables drop-down menu list; 

ALT+T will open the Tools drop-down menu list; etc. 

Info Icons 

The  Info icons are found in various screens throughout the Utilities module. When you click an Info 

icon next to a field, a non-editable pop-up box is displayed, providing additional information about the 

field.  

 

Closing Impact/SQL Utilities 

As with most Windows applications, you can close Impact/SQL modules by clicking  in the upper-

right hand corner of the Utilities desktop.  
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Dates 

For dates in the current year, enter the two-digit month and two-digit day; for example, “0625” for June 25, 

2015 (in 2015). Do not enter hyphens or slashes when entering dates into Impact. If the date is not within 

the current year, but in the current century, enter the date as two-digit month, two-digit day and two digit 

year, for example: “062516” for June 25, 2016.  If entering a different century other than the current 

century, you must enter a four-digit year.   

You can also click the  Calendar icon, just to the right of the date entry area, or press the CTRL+D 

Quick Key to display the Calendar tool.  Select the desired date from the calendar presented. 

 

 

 

 

 

 

 

  

For the Calendar tool, click on this 

box or use the CTRL+D Quick Key to 

display the Calendar tool. 

Date entry area 
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Logon 

Access to the Impact Utilities module (as to all Impact modules), is controlled by a user-rights table, and 

administered by a limited set of user initials that have sufficient authority granted to them.  This is a very 

important control, and should be carefully managed.  Depending on the nature of the rights assigned to a 

user, they will have access to various pieces of the overall Impact suite, but generally not complete 

access.  This functionality helps reinforce audit controls, and needs to be considered in conjunction with 

the network security plan. 

The system can be configured to require a logon routine, each time the user opens an Impact module, or 

it can be configured to provide for an automatic logon utilizing the NT user name.  By providing for an 

automatic logon utilizing the NT user name, control over the access to the application is very flexible: both 

the system administrator and the rights table within Impact can control access.  The system administrator 

can control access by disabling the user’s NT user name, a likely event in the case of an employee’s 

departure. In addition, the user name can be disabled within Impact Utilities – which will only affect the 

user’s ability to access Impact modules.  This would be done if the user is still using the rest of the 

network, but should no longer be accessing Impact. 

There is not an automatic expiration of passwords setting within Impact, so to ensure strong controls the 

users should routinely change their own password which can be done from within any Impact/SQL 

module, if the automatic logon based on NT user names is disabled.  For this reason, the use of an 

automatic logon based on NT user names can be a more effective control – assuming automatic 

expiration of passwords is implemented through the NT operating system.  This matter is more fully 

explained later in this Utilities manual. 

If the system is configured for NT Authentication, and more than one database is available, a screen like 

that shown below will be presented, after the user double-clicks on the Impact Utilities icon on their 

desktop.  The user should select the database to be accessed and click on OK to continue. 

 

 

 

 

 

 

 

 

 

  

Use the drop-down list 

arrow to access other 

databases, if available. 



USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 6 of 183 

When configured to require a logon step, the user will be identified within the system by their initials (three 

maximum), and will be given a password. 

Enter your user initials in the first field, and then TAB to the Password field. Enter your password and, if 

the correct database is identified in the Log on to: field, click OK. If the database is not correct, then TAB 

to the Log on to: field and select the correct database by clicking on the drop-down list arrow and 

highlighting a database name; then click OK. Most users will only have one database available. 

Alternatively, if you do not want to use the mouse to click OK, you can press the TAB key until OK is 

highlighted, and then press ENTER. 

NOTE: When you enter your password, it will not display on the screen, but will be represented by a 

series of asterisks “****”. 

If you don’t want to continue, click Cancel instead. This will cause the Log On to Impact/SQL Utilities 

dialog box to close and the Impact Utilities module will not be opened. 

KEEP YOUR PASSWORD PRIVATE. You should not share your password or log on to the system and 

then let someone else operate under that session.  Access to the Utilities module should be severely 

limited.  

If you forget your password, the administrator of the Impact application must assign a new one. 

There are three user levels that provide access to the Impact Utilities module:  

Utilities 

Utilities – User Tables Only 

System Administrator 

User levels are assigned in Utilities > Users (discussed later in this manual). 
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The Impact/SQL Utilities Desktop 

Impact Utilities Desktop 

Impact will display a desktop as shown below when you log onto the Utilities module. 

When the Utilities module is initially opened menus present across the top of the screen.  Each menu 

option has a drop-down menu below it, which will be displayed when you click on the option name.  Once 

you have clicked on one option name, and the menu list below it is presented, you can slide your cursor 

down the list, with your mouse, to get to the function you wish to use.  If you are not sure under which 

option heading the desired function is housed, click on any option heading and, once the menu list is 

presented, slide your mouse to the left or right, to other option headings, and their menu lists will present 

without you having to click again, and you can then browse all of the menu choices available to you. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The current date should be displayed in the lower-right corner of the Impact desktop. If users do not have 

the current date displayed, they should notify their system administrator and NOT continue to enter 

activity to the system – having the correct dates on activity is very important. The current date is used for 

the print date on documents, the receipt date, check date, and voiding of check date, for example. 

Current date

The Impact Utilities desktop 

may show your company logo 

Logged in user’s name 

and access level 
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There are some Impact users that have multiple sets of Impact Initials (“profiles”) so that they might 

perform a variety of typically unrelated tasks in one module – or to work in different branches (but not all 

with a single set of initials).  Historically, these users had to log out of Impact and log back in to be able to 

select a different “profile” (set of Impact Initials).  There is a function in Impact that permits those with 

multiple profiles to switch between those that they have which are applicable to the module they are in, 

while staying in the module.  If a user has multiple profiles for the particular module they are in, with 

different permissions or branch assignments, they will see their Name, Branch Assignment and Access 

Level, from the profile they are currently logged into Impact with, in the middle of the bottom of the Impact 

desktop, in the form of a link (blue-colored text).  Clicking on the link will bring up a screen of the other 

profiles that they have available to them related to the module they are in.  The user should highlight the 

desired profile and click on OK and the user’s access level and/or branch will be altered accordingly.  

Should there be a file open on the desktop when this action is triggered, the user will be warned about 

that and will be asked if the file should be closed and the switch made or not. 
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Exit Impact 

You should exit out of Impact when you are leaving your desk for an extended period, or are going home 

for the day. To exit, click on the  Exit icon, located in the upper right corner of the Impact desktop 

window.  Always exit out of Impact at the end of each day, before logging off of your computer. If you 

leave your Impact Utilities session logged on, others will have access to your “rights”, and this could raise 

security concerns.  You can also use File > Exit to close Utilities. 

Impact Widget Dashboard 

At the bottom of the Utilities desktop window there is a dark band, labeled as the Impact Widget 

Dashboard.  In the Utilities module, the Record Locks widget is the only widget available on this 

dashboard. 

 

 

 

 

 

 

 

 

 

To open the widget, click the  Widget icon on the right side of the dashboard and select Record 

Locks. The Record Locks widget displays a list of locks on all records. 

 

 

 

 

 

The three icons located at the top-right corner of the widget window are used to: 

 Refresh the window content 

 Collapse or  Expand the window 

 Close the window 

To find a specific record lock, use the Filter box. Enter information about the record lock in the box, such 

as the Area Locked, Lock Key (file number) and the User who locked the record. The records that 

match the entered information will display in the grid.  Click the  Clear icon, to the right of the filter field, 

to clear the filter. 

To remove a lock on a record, select the checkbox next to the record and then click . Click 

Yes when the confirmation message displays to remove the lock.  
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File Menu 

The File menu only has one item under it: Exit.  This option can be used to close the module, or click 

 in the upper-right hand corner of the screen to close the Utilities desktop. 

System Files Menu 

The System Files menu has up to fourteen entries on it – one of which may not be accessible, 

depending on a setup option setting (it is grayed out if it is not accessible).  Each item is very distinct from 

the other and will be explained in detail in the following pages. The items do not ‘flow’ one to the next as 

in a process workflow order. These functions cover a wide range of initial configuration options and 

include some routine maintenance functions (such as adding a branch or bank).  

NOTE: Remember, improper changes to some settings can have serious consequences – so do not 

make changes you are not sure of. Consult USA Digital Solutions, Inc. if you are in doubt. 

The options on the System Files menu are: 

 Xref 

 Users 

 File Table 

 Branches 

 Banks 

 IRS Reporting Entities 

 Set Next Escrow\Direct File Number 

 Set Next Title File Number (optional) 

 Set Posting Information 

 Set Next Invoice Number 

 Printer Setup 

 Setup Options 

 License Manager 

 Messaging Manager 
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Xref 

The Xref menu selection takes the user to three screens on which basic company information and “paths” 

are assigned for all of the functional components of Impact/SQL. The “path” is the UNC path through 

which the program will search for required files. The only entry that must be a mapped drive is the Local 

Work Path (on Path 2 tab). The locations for the Escrow Master Documents, the Report files, the Legal 

Clause files, among others, are defined on the Xref screens.   

NOTE: These paths will have been set up by the USA Digital Solutions, Inc. installation manager 

and should only be changed at the direction of USA Digital Solutions, Inc. personnel.  

 

 

 

 

 

 

 

 

 

The first tab, on the Xref screen, is Company Info, shown above. 

The Company Number is used for CRRAR configuration (FNF only). 

The Company Name field is very important.  The entry made here will be used for the Company Name in 

all documents produced out of Impact/SQL.  It should be entered in mixed upper and lower case so as to 

appear normally in documents.  This is the name that will be entered as the payee when the “:T” (read as 

colon T) payee shortcut is used. 

The System Name field can be used to identify a different name from that shown in the Company Name 

field – which would be useful if a subsidiary division, with its own Impact/SQL database, wanted to show 

both the parent company’s name and the division name on reports. The parent company name would go 

in the Company Name variable, and the subsidiary division’s name would go in the System Name field. 

Then, as Crystal Reports is used to develop custom reports, the appropriate names are available for use 

on the reports. The Company Name would be the name printed on the HUD and Settlement Statements 

and documents (as mentioned above. 

The NMLS/License ID, Other License ID and Other License Issued By fields are to be used to record 

licensing information for the company.  That data is used on the Contacts table of the Closing Disclosure. 

The two “Path” tabs are described in the following pages.  
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The specific XREF paths defined on the Path 1 tab are: 

 

Report Path All standard and custom Crystal Reports report templates. 

Project Path Location of project information. Projects are established in 

the Escrow module.  

Crystal Reports Path The location of the Crystal Reports Designer program, if it 

is installed. 

Legal Clause Path Where the Word documents of standardized legal clauses, 

used to assist in the creation of legal descriptions, are 

located. 

System Path Houses all the data files.  

Escrow Master Documents Path The ESCTMP folder is where all the master forms for the 

escrow documents are stored. They are attached to the 

‘Escrow.dot’ template. The global AutoText used in the 

Escrow module is also stored here. 

Laser Forms Path Where the master template for each check (and duplicate 

check files, if used), the overflow stub (STUB.RPT), and 

the transfer fee slip (TRANSFER.RPT) are stored. Each 

check corresponds to a bank number assignment. For 

example, if the bank number for an escrow trust account 

on your system is 01, then the corresponding check 

template would be CHECKS01.rpt. 

Escrow Clause Path  The ESCCLS folder is where all the Escrow clauses are 

stored. They are attached to the ‘Escrow .dot’ template. 
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Title Clause Path  The TTLCLS folder is where all the Title clauses (the Title 

Codebook) are stored. These are Word documents 

attached to the ‘Title.dot’ template, and have special 

formatting applied to each code (Word document).  

Title Master Documents Path  The TTLTMP folder is where all the master Word forms 

are stored for Title. This includes the prelim, commitment, 

policies, endorsements, miscellaneous transmittal letters, 

and the global AutoText used in the Title module. 

Subdivision Masters Path  The SUBDIV folder is where all the master subdivisions 

that are created by the Title Department, within the Title 

module, are stored. 

Messaging Components Path The path to where the messaging components are 

installed. 

Impact Plugin Path The path to where the Impact Windows Service Plugins 

are installed.  Typically this is located on the same server 

that the Impact Windows Service is installed on. 
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The specific XREF paths defined on the Path 2 tab are: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  
Title Plant Interface Path No longer used. 

Local Work Path Where all of the users’ temporary files are located.  This must be 

a mapped drive, as it must be a unique path per user. 

Local Save Path Where “SAVE” files used with Crystal Reports are stored.  

NOTE: This XREF path is used in Impact/SQL, version 7.8. 

Desktop Logo Path Where the “company.gif” file is located in graphic information 

format.  This is the Impact desktop backsplash logo. Files can 

also be in PNG & JPG formats. 

Local EXE Path Where the Impact executables (“.exe” files) are stored (the 

programs that run Impact) 

Help Path Not currently used. 

Other Base Path Where base orders established on a previous system are 

located. These bases are used in the Title Department when 

creating prelims. 

Dot File Path Where all the Word template files are located.  

Receive Path Reserved for future use. 

Send Path Reserved for future use.  

SoftPro Addin Path Where any Add-Ins related to SoftPro 360 are located 

Addin Path Where any Add-Ins for other products are located 

Document Logo Name Path Where document logos are located (often I:\Logos\) - mapped 
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Users  

The Users function is the security control center for all users of all Impact/SQL modules. This function 

was called Password in pre-8.x versions of Impact/SQL.  New users’ accounts must be created here 

before they can access the system and the user accounts for those that leave the company should be 

terminated here. Changes to a Name, Password, Title, Email Address, Branch Number, Access 

Code, and Type of User are made using this function. 

Great care should be taken to only provide the “rights” required for a user to do his/her job. The risks of 

serious errors being made by an untrained user go up substantially if they are given rights to access 

functions beyond their scope. In addition, the rights that users are assigned will determine which functions 

are made available to them on the screen. Limiting the functions to those required for them to do their job 

will simplify their environment. 

When first opened, the Users function will display the following screen:  

 

 

 

 

 

 

 

 

The Active column on the Users screen indicates if a user is active or not.  The  Active icon indicates 

a user is active.  The  Inactive icon indicates a user is inactive.  Users with the “Terminated Employee” 

access level are considered inactive. 

Use the Show Inactive Users checkbox to display inactive users, along with active users, in the list of 

users. 

The Filter field can be used to aid you in locating a specific entry to modify or delete.   

 

 

Simply enter some contiguous information that you believe is in any of the four fields presented (Initials, 

NT Name, Name and Branch) and the system will search the entire table and display those records that 

match the search criteria.  

Shows 

Active / 

Inactive 

Users 
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Add a New User 

To add a new user, click   at the top of the screen. The User Info screen is displayed. 

 

 

 

 

 

 

 

 

 

 

 

Enter the following information about the new user: 

NOTE: Depending on the company’s configuration, the Dual Authorization Access section may 

not display. Other items may be disabled or enabled on the screen, depending on the access level 

selected for the user, as explained below. 

User Initials – Enter up to three characters. The initials must be unique to the database. (No two users 

can have the same initials in the system). 

NT User Name – Enter the user name of the Windows NT account.  Only accessible if the option for 

Enable NT Logon is turned on. 

Name – Enter the full name of the user. The names should be entered consistently in upper and lower 

case, if that is the company preference, or all in uppercase. These names will appear on reports and in 

documents. 

Password – Enter a password consisting of numbers and letters, up to a maximum of six (6) characters. 

As with the login screen, the password will not be displayed (it will present as a line of asterisks “******”) 

and so it must be replaced if forgotten. Even though the use of NT Authentication eliminates the need for 

this password to be entered by the user, one must still be entered here. 

Title – Enter the user’s job title. Again, consistency of entry format should be followed with regard to case 

(upper and lower case). 

Email – Enter the email address of the user. The full email address should entered, not just the portion 

before the “@” sign. For example, Bob Smith, of Great Title Agency, Inc. has the e-mail address 

“bsmith@greattitleagency.com”. The address should be entered completely as shown, not as “bsmith”. 

These addresses should be entered with care as they will be used by the system to send notifications to 

the user from within several functions (such as when prelims are ready or when wire transfers are 

complete).  
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Phone Number – Enter the phone number of the user. Do not enter hyphens, the system will auto format 

the number.  There is a field for the user’s extension, if needed. 

Fax Number – Enter the fax number of the user.  Do not enter hyphens, the system will auto format the 

number. 

Branch Number – Select a Branch Number from the drop-down list. This field is required.  

Title users should be assigned to the Title branch (099 – or the appropriate Title branch number if 

more than one has been created).  

Escrow users should be assigned to their home branch and they will be restricted to only 

accessing files assigned to their branch number.  

Accounting users should be assigned to the “999” branch number. This will permit them to work 

with all branch data.  

Floaters should be assigned to branch “099” or the floater’s home branch with the access code 

“Floater”. This will permit them to work in any branch. 

Access Code – Use the tables on the following pages to determine the appropriate Access Code to 

assign to the user.  Access Codes are across the top of the chart and the modules (and some 

components within them) are listed down the left side. 

NOTE: Access Code is the most critical field on this screen. This is the place where “rights levels” 

are assigned to a user. As has been said repeatedly, care should be taken to assign just the rights 

required by a user to perform their job. This will limit the functions they see on the screens and limit 

the potential risk of them taking actions or changing settings on which they have not been trained. 

 

NOTE: It is possible that more than one set of initials may be assigned to a user to give them the 

combination of permissions desired. 

 

NOTE:  The description of the balance of the User Info screen will follow the Access Code tables. 
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The following table (on several pages) details the rights provided with each access code: 

= No rights    = Rights 

 

  

Module 
0 - 

Terminated 
1 - 

Receptionist 
2 - Escrow 
Secretary 

3 - Escrow 
Officer 4 - Escrow Manager 

Accounting     

     Setup Banks      

     Add Banks to Branches      

     Change Banks      

     Accounting Lock/Unlock      

       

Escrow     

     Income Analysis    Only theirs All within branch 

     Log Book    Only theirs All within branch 

     Tickler Maintenance     

     Projects     

     Cancel Escrow     

     Trial Balance    Only theirs All within the branch 

     Savings Accounts     

     Print Savings Accounts  

only their 
branch 

only their 
branch only their branch 

     Print HUD Certification Stamp     

     Void Checks     

     Assigned Escrow Report     

     Closing Report     

     Deposit Slips     

     Daily Receipts Journal     

     Daily Disbursements Journal     

     Wire Out Journal (if Dual Auth enabled)     

     Wire Out Audit (if Dual Auth enabled)     

     Accounting Lock/Unlock     

       

Utilities     

     SQL Error Log      

     View Clear Locks      

     Copy Naf (must be NAF admin)      

     Check Template      

       

Title     

       

Order Desk     

       

MIS     

       

Reconveyance Tracking     

      

Archive Viewer     

      
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The second set of access codes: 

= No rights    = Rights 

Module 
5 - 

Accounting 

6 - 
Accounting 

Mgr 7 - MIS 8 - Title 9 - Policy 

Accounting     

     Setup Banks      

     Add Banks to Branches      

     Change Banks      

     Accounting Lock/Unlock      

       

Escrow     

     Income Analysis      

     Log Book      

     Tickler Maintenance      

     Projects      

     Cancel Escrow      

     Trial Balance      

     Savings Accounts      

     Print Savings Accounts      

     Print HUD Certification Stamp      

     Void Checks      

     Assigned Escrow Report      

     Closing Report      

     Deposit Slips      

     Daily Receipts Journal      

     Daily Disbursements Journal      

     Wire Out Journal (if Dual Auth enabled)      

     Wire Out Audit (if Dual Auth enabled)      

    Accounting Lock/Unlock      
       

Utilities     

     SQL Error Log      

     View Clear Locks      

     Copy Naf (must be NAF admin)      

     Check Template      

       

Title     

       

Order Desk     

     

MIS     

       

Reconveyance Tracking     

      

Archive Viewer     

      
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The third set of access codes: 

= No rights    = Rights 

Module 10 - Utilities 11 - CP 12 - E & T 13 - Sys Admin 14 - Utl Tables only 

Accounting      

     Setup Banks      

     Add Banks to Branches      

     Change Banks      

     Accounting Lock/Unlock      

            

Escrow     

     Income Analysis    if EO   

     Log Book    if EO   

     Tickler Maintenance    if EO   

     Projects      

     Cancel Escrow      

     Trial Balance 

 All within the 
branch if not 

assigned to 999     

     Savings Accounts      

     Print Savings Accounts 

 Indiv. 
file only    

     Print HUD Certification Stamp      

     Void Checks      

     Assigned Escrow Report      

     Closing Report      

     Deposit Slips      

     Daily Receipts Journal      

     Daily Disbursements Journal      

     Wire Out Journal (if Dual Auth enabled)      

     Wire Out Audit (if Dual Auth enabled)      

     Accounting Lock/Unlock      
            

Utilities      - User tables only

     SQL Error Log     

     View Clear Locks     

     Copy Naf (must be NAF admin)     

     Check Template     

           

Title     

            
Order Desk     

      

MIS     

            

Reconveyance Tracking     

      

Archive Viewer     

      
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The fourth set of access codes: 

= No rights    = Rights 

Module 

15 - Order Desk 
w/ Escrow & 

Title 16 - FLTR 17 FLT w/Chk 18 - Sub escrow 

Accounting    

     Setup Banks     

     Add Banks to Branches     

     Change Banks     

     Accounting Lock/Unlock     

          

Escrow 
 No access to 
disbursements

 No access to 
disbursements 

 the following areas are 
disabled for Sub Escrow: IRS, 
Copy File, Order Title Search, 

Rent Schedule, Balance 
Statement, Commissions 

(HUD 700), Lender Summary, 
HUD 800, HUD 900, HUD 

100 thru HUD 510, HUD 1000

     Income Analysis    

     Log Book    

     Tickler Maintenance    

     Projects    

     Cancel Escrow    

     Trial Balance    

     Savings Accounts    

     Print Savings Accounts    

     Print HUD Certification Stamp    

     Void Checks    

     Assigned Escrow Report    

     Closing Report    

     Deposit Slips    

     Daily Receipts Journal    

     Daily Disbursements Journal    

     Wire Out Journal (if Dual Auth enabled)    

     Wire Out Audit (if Dual Auth enabled)    

     Accounting Lock/Unlock    

          

Utilities    

     SQL Error Log     

     View Clear Locks     

     Copy Naf (must be NAF admin)     

     Check Template     
          

Title    

          

Order Desk    

          

MIS    

          

Reconveyance Tracking    

     

Archive Viewer    

     
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The fifth set of access codes: 

= No rights    = Rights 

Module 
19 - Order Desk 

Only  

Accounting 

     Setup Banks  

     Add Banks to Branches  

     Change Banks  

     Accounting Lock/Unlock  

    

Escrow 

     Income Analysis 

     Log Book 

     Tickler Maintenance 

     Projects 

     Cancel Escrow 

     Trial Balance 

     Savings Accounts 

     Print Savings Accounts 

     Print HUD Certification Stamp 

     Void Checks 

     Assigned Escrow Report 

     Closing Report 

     Deposit Slips 

     Daily Receipts Journal 

     Daily Disbursements Journal 

     Wire Out Journal (if Dual Auth enabled) 

     Wire Out Audit (if Dual Auth enabled) 

     Accounting Lock/Unlock 

    

Utilities 

     SQL Error Log  

     View Clear Locks  

     Copy Naf (must be NAF admin)  

     Check Template  
    

Title 

    

Order Desk 

    

MIS 

    

Reconveyance Tracking 

  

Archive Viewer 

  
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Ltd Practicing No – Enter the Limited Practicing Officer Number, if the escrow officer has one 

(requirement in state of Washington). 

NMLS/License ID – Enter the user’s NMLS licensing number, if required.  Used on the Closing 

Disclosure form. 

Other License ID – Enter any additional licensing number, if required.  Used on the Closing Disclosure 

form. 

Other License Issued By – Enter the state abbreviation or licensing entity name for the issuing entity for 

the “Other License ID” entered above.  Used on the Closing Disclosure form. 

Employee ID – Enter up to 20-character ID. This feature can be used for reporting purposes. 

Type of User & Additional Permissions – This section (right side of the User Info screen) contains 

several unrelated items.  There are three types of users and the appropriate box(es) should be checked 

for each user. In addition, there are controls for Document Administration, NAF Administration, 

disbursements, receivables, receipting, altering marketing reps and, for Accounting access-coded users, 

a file lock control and reconciliation permissions. Wire out dual authorization permissions are also granted 

here.  If a box is checked, some specific functionality is enabled as discussed below. 

Escrow Officer - If checked, the user’s name will appear in 

the drop-down list as an available escrow officer within the 

branch of the user. Users will only see escrow officers 

assigned to the branch the file is assigned to. Some reports 

are generated by “Escrow Officer”. 

Title Officer – If checked, the user’s name will appear in the 

drop-down list as an available internal title officer. Users will 

only see the Title Officers assigned to the title branch(es) 

available to the escrow branch of the file. Some reports are 

generated by “Title Officer”. 

NOTE: If the system is configured for Multiple Title 

Departments then all Title Officers must be assigned to 

branch 099 or none assigned to branch 099.  If most are not 

and at least one is assigned to branch 099 only those 

assigned to branch 099 will be available to users. 

Processor – If checked, the user’s name will appear in the 

drop-down list as an available processor. Processors are 

escrow assistants or central processing staff members. Some 

reports may be generated by “Processor”. If Processor is 

checked, the Escrow Officer, Title Officer, and Document 

Administrator options are not available for selection. 

Document Administrator – If checked, the user will have 

Document Maintenance as an option under the Documents 

menu. The user may have both escrow and title document 

maintenance access if they have an access level that allows multiple module access. Users that have this 

functionality will require special training. 

NAF Administrator – If checked, permits the user to edit the Name and Address File (NAF). Generally, a 

company will want to limit the number of individuals who can edit the NAF to prevent the file from being 

filled with inconsistent and redundant entries. This works in conjunction with the Setup Options relating to 

the NAF. 
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Add/Modify Disbursements – If checked, the user will have access to the disbursements menu in 

Escrow, if their access level will permit it. 

Add/Modify Receivables – If checked, the user will have access to add and modify receivables. 

Print Checks – If checked, the user will be able to print checks, if their access level will permit it.  

Approve Disbursements – If checked, the user has the ability to approve disbursements. This checkbox 

is available if Dual Authorization on Disbursements is enabled. Dual Authorization on Disbursements is 

enabled in Utilities > Setup Options > Escrow Functions > Disbursements > Enable Dual 

Authorization on Disbursements.  The (…) ellipse icon is used to open a screen on which permissions 

can be granted/removed for approving specific users’ disbursements – as an added control. 

Add/Modify Receipts and Incoming Wires – If checked, the user has receipting and incoming wire 

entry ability, if their access level will permit it. 

Add/Modify Bank Reconciliations – Users with Accounting or Accounting Manager access level can be 

granted permission to work trust account reconciliations.  This lets that role be restricted so not all 

Accounting users need to have that permission. 

Lock/Unlock File – This checkbox will be accessible if the user’s Access Level is Accounting, Accounting 

Manager, Escrow Officer, Escrow Manager, Floater with Check Write, Floater without Check Write and 

System Administrator.  If checked, enables the ability for the user to lock or unlock accounting activity on 

specific files. 

Change Marketing Reps – This checkbox controls whether the user can alter marketing reps, once they 

have been initially entered, if the setup option for this control is turned on. 

Dual Authorization Access – This section will display if the Dual Authorization of Wires is enabled in 

Utilities > Setup Options > Accounting Functions > Wire Processing > Outgoing > Enable Dual 

Authorizations for Wire Outs. There are two rights associated with this access:  

Wire Out Approver requires another approver’s interaction.  

Wire Out Self Approver does not require a second approval. 
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Hud/Worksheet Stamp – The Hud/Worksheet Stamp tab will display for access levels of Escrow Officer, 

Escrow Secretary, Escrow Manager or Floater With Check Write, if the Enable Hud/Worksheet Stamp 

Functionality option is enabled in Utilities > Setup Options > Escrow Functions > HUD Printing. This 

allows you to assign a small (<64K) image file to the user.  This image file will appear on the HUD and 

Settlement Statements if the Include the Certification Stamp print option is selected.  Settlement 

Statements, being customized by system, must be modified for the stamp to appear.   

 

Click Select Image to open a Windows Explorer window that will let you browse to the location of the 

BMP file to be used as the certification stamp for the user.  These files are created by the client, not USA 

Digital Solutions, Inc.  Supported file types are GIF, BMP & JPG.  If the selected image should no longer 

be used, click Delete Image to de-select it. 

Click OK to save the settings established for the new user or click Cancel to return to the Users screen 

without saving the new user’s settings.  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 26 of 183 

Print a Report of All Users 

To generate and print a report of all of the users defined in the user file, click  at the top of the 

Users screen. The Print dialog box is displayed. 

 

Complete the options on the Print dialog box, and then click OK to print the report. 

NOTE: It is recommended that the users report be printed routinely and reviewed for terminated 

employees and for employees who have moved from one department to another who, therefore, 

may have improper rights assigned to them. 

 

Modify an Existing User 

To view or change the settings for an existing user, highlight the user you wish to modify, and then click 

 Modify to the right of the selected user or double click on the user. 

 

The User Info screen is displayed, with the settings for the selected user. At this point, you can view 

and/or change the settings. Click OK to save your changes to the user’s settings or click Cancel to return 

to the Users screen without changing the existing settings. 
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Delete a User 

To delete the user highlighted on the Users screen, click  Delete to the right of the selected user.  

 

The system will attempt to delete the user. Impact will not delete a user that has files assigned to their 

initials. You will need to re-assign the files to another Escrow Officer’s (or Title Officer’s) initials before 

being permitted to delete the Escrow Officer (or Title Officer) from the Users file. If you have created a 

user in error, or a user has not been assigned to any files, then you can delete the user from the file. 

When any employee departs the company, their Access Code should be immediately changed to 

Terminated Employee. Then, if they have files assigned to them, those should be re-assigned, if so 

desired, before deleting the user is attempted. Non-escrow officers or non-title officers can be deleted 

immediately, but should be flagged as Terminated Employee at a minimum upon their departure so they 

cannot access Impact/SQL.  Escrow and Title officers that have been assigned to files can be marked 

Terminated Employee, and they will remain assigned to the files they are assigned to, until the 

assignments are changed, but will not appear on the EO and TO drop-down lists, so they cannot be 

assigned to new files. 

Close the Users Screen 

Click  in the upper-right corner of the screen to close the Users screen and return to the main Utilities 

desktop.  
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File Table 

The File Table function is used to establish the locations and file count restrictions for the storage 

provided for document files relating to legal descriptions, prelims, policies, and MS Word documents – 

both for escrow and direct order files. Generally, these settings are established by USA Digital Solutions, 

Inc. at setup and do not need to be adjusted. The system administrator may wish to check on the number 

of files that are being stored in each location for each type, which can be done here.  

 

Impact/SQL utilizes ten sub-directories for each type of file per database. This permits files to be spread 

across systems or drives. A maximum number of files per sub-directory is identified in the Max Files field. 

Depending on the operating system in use and the drive space available, the Max Files setting may be 

relatively small or large. Initially, files are assigned to the first identified sub-directory until it has reached 

the maximum count then the next sub-directory is utilized. As files are deleted and the counts within sub-

directories fall, files will be assigned to the first sub-directory in the list with space, then to the next with 

space available, and so on. The Document Deletion function can be set to remove documents from 

some of these directories to free up disk space. Configuration of the Document Deletion function is done 

in the Impact Windows Service administration module, not through Utilities. 

The system will automatically increase the max count per directory if all directories reach the limit that is 

set. 

NOTE: These paths will have been set up by the USA Digital Solutions, Inc. installation manager 

and should only be changed at the direction of USA Digital Solutions, Inc. personnel.  
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Branches 

The Branches function, on the System Files menu, provides for the entry of new branches into the 

system, and for the editing of settings for an existing branch.  This module is exactly the same as that 

found in the Impact Accounting module via the Misc. > Set Up Branch path.  Generally, the function in 

Utilities would be used by the system administrator or USA Digital Solutions, Inc. when setting up the 

system the first time, and then Accounting staff would use the function within Accounting on an on-going 

basis.   

IMPORTANT NOTES: 

The original Title Department office is always assigned the branch number ‘099’ (not ‘99’, but ‘099’). 

The Accounting Department (Escrow Accounting, not Financial) is always assigned the branch 

number ‘999’. 

The branch number ‘998’ is often reserved for a “Training Branch”. 

ALL bank accounts must be assigned to branch ‘999’ (Accounting), in addition to the branch(s) that 

use them. 

When the function is selected, the Branches screen is displayed, presenting the branches that have 

already been set up in Impact/SQL.  The branch Status, Number, Name and Address are shown, along 

with action icons and buttons.   

The Status column on the Branches screen indicates if a branch is active or not.  The  Active icon 

indicates a branch is active.  The  Inactive icon indicates a branch is inactive.  The Status is set on the 

Branch Information tab when the branch is added or modified.  If the Branch Active - No radio button is 

selected, the branch is inactive, which could indicate the branch is closed, merged with another or sold.  

The No setting will prevent users from creating new escrows within the branch, but will not prevent users 

form working files that have already been opened in the branch.  Reconciliations can continue to be done 

that involve transactions originated at the inactive branch.   

 

  Filter by 

Active/ 

Inactive 

Status 
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Add a New Branch 

To add a new branch, click  at the top of the screen to display the New Branch screen.   

The Branch Information tab is the only tab displayed at first. After a new branch number is entered, 

other tabs will appear. Up to four tabs across the top of the screen will display, representing four screens 

of information about each branch.  The settings established on these screens are very important and 

should be done with care.   

The four tabs are:  

Branch Information 

Bank Information 

Savings Information 

Title Departments (only shown for Escrow branches if the option for multiple Title Departments 

is set in the Utilities Setup Options) 

Branch Information Tab 

The Branch Information tab is where the basic information about each operating unit is established.  

While it is called “branch” information, Title and Accounting units are also established as “branches”.  A 

training branch (998) may also be set up, by USA Digital Solutions, Inc., to facilitate that effort. 
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Complete the following fields on the Branch Information tab: 

Branch Type –Select the Branch Type from the drop-down list.  There are three types of branches:  

Escrow – This type is assigned to normal escrow branches and to the Accounting “999” office, 

and provides for the routine escrow functionality within Impact.  This setting permits receipts and 

disbursements to be generated under the number established for the office, in addition to income 

tracking.  Again, the Escrow Accounting office is set up as an “escrow” office. 

Title – This type should be assigned to pure title offices; no receipts or disbursements are 

permitted under Title branches.   

NOTE:  If a Title Department is going to generate receipts and track income, then establish 

a separate “escrow”-type branch for this purpose.  Sub-escrows need to be established 

under an “escrow” branch.  Direct Orders are only created in Title-type branches. 

Other – If an office is being set up as a “control branch”, it should be designated with the Other 

type.  A “control branch” is one established solely for the purpose of managing the check, receipt, 

deposit and wire-out numbers issued across a range of branches, when the numbers are not 

assigned across all branches using the same bank. 

Branch Number – Enter a number three positions long, zero-filled from the left, if less than three non-

zero numbers.   

NOTE: The number “099” is reserved for the primary Title unit, and the number “999” is reserved for 

the Accounting unit.  As noted above, “998” is generally also used, as the “Training Branch”.  

Therefore, there are 996 office numbers available for use, at a maximum. 

Name – Enter a name for the office that is accurate and descriptive.  It is the identifier that will appear on 

most reports and many documents, and may or may not appear with the branch number.  The names 

should be unique; to prevent confusion in cases where the number is not presented. 

Address Information – Enter the physical location of the branch. This will appear on many documents 

and reports so do not use the same address for all branches, unless they really are in the same location.  

The Phone and Fax Numbers should also be for the specific office. 

Manager’s Initials –Complete this field only if all escrows opened in the office should be assigned to one 

escrow officer.  The initials should be a valid set of user initials, as set up under System Files > Users.   

County – Enter the name of the county that will be the default value loaded into the county field in each 

escrow file opened under the branch number being established.  It can be changed, in each escrow file, if 

needed.  The use of a default is because most transactions opened by an office will relate to properties 

from the surrounding area.  There is a Setup Option that will let the auto-filling of the County field be 

disabled. 

Last EOM (End-of-Month) Date – Enter a date that will be used to specify the “as-of date” for the EOM 

Balance data on the Bank Information and Savings Information screens.  This is the starting date from 

which Impact will aggregate data, at each posting, until the Close Month function is performed, rolling the 

new end-of-month figure up to be the new starting figure for the next month’s aggregations.   

NOTE: The system will maintain this date automatically in the normal course of business, however 

when adding a new branch this date should be filled in with the Last EOM date.  
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Alternate Company Name – Select the Use checkbox to activate this field, and then enter an alternate 

company name. The alternate name will be used on letterhead and other documents for this specific 

branch, rather than the name established for the database-wide company (through System Files> Xref.).  

It will be used as long as the Use box is checked.  Normally, you would also have another IRS Reporting 

Entity involved as well, if more than one “brand” is being utilized in one database.  This option is available 

only to Escrow type branches. 

Default Underwriter – Select the default underwriter for the office from the drop-down list, to override the 

database-wide default.  If an underwriter is selected here, it will automatically be loaded in the Initial 

Questions area, after an escrow file is opened.  The default underwriter can be changed before the order 

is sent to Title from Escrow.  If 0-None is selected on the Branch Information screen, then the default 

underwriter established under Utilities > System Files > Setup Options > General will be loaded into 

the Initial Questions area.  The underwriters are set up in the Impact Title module, under Documents > 

Document Maintenance > Edit Underwriter Menu Table.  There is more to establishing an underwriter 

than adding them to the Underwriter table.  DSI Support should be contacted to add an underwriter. 

IRS Reporting Entity – Select the IRS Reporting Entity for the office from the drop-down list. If you are 

using an alternate name, you might also have a separate IRS Reporting Entity.  This is the name and tax 

ID number that appears on the 1099-S forms.  If you have multiple IRS reporting entities, then you will 

generate a separate file for each, under 1099-S Reporting, for the IRS. 

Email – Enter an email address (may be a distribution list) for the branch. 

Company Cost Center – Available for entries that can be used in reporting.  

Branch Cost Center – Available for entries that can be used in reporting. 

Company Identifier – Available for entries that can be used in reporting. 

NMLS/License ID – Enter the branch NMLS licensing number, if applicable.  Used on the Closing 

Disclosure form. 

Other License ID – Enter any additional branch licensing number, if applicable.  Used on the Closing 

Disclosure form. 

Other License Issued By – Enter the state abbreviation or licensing entity name for the issuing entity for 

the “Other License ID” entered above.  Used on the Closing Disclosure form. 

ALTA Universal ID – Enter the ALTA Universal ID for the branch, if available. 

Document Logo Name – for any branch that is to have a logo other than the standard logo, enter the 

document logo name for the custom branch logo.  Nothing should be entered if the standard 

DocLogo.doc or DocLogoT.doc logo files are to be utilized.  Note: The logo for Title docs is driven by the 

title branch selected on the file.  The logo file must have already been placed in the logo path location 

specified in Xref, tab 2, or the filename entry will not be saved here upon clicking on the OK button. 

Branch Active Yes/No – Select the No radio button to “turn off” a branch, if it is closed, merged with 

another or sold, for example.  The No setting will prevent users from creating new escrows within the 

branch, but will not prevent users form working files that have already been opened in the branch.  

Reconciliations can continue to be done that involve transactions originated at the “turned off” branch.  

This toggle also permits the system administrator to set up branches in advance of their “go live” date (by 

creating them, but making this setting No) and then switching them on at the appropriate time. 
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Bank Information Tab 

The Bank Information tab relates to the Escrow Trust bank account(s) used by the branch and the 

numbering sequences to be used for checks, receipts, deposits and wires out for each branch/bank 

account combination.  The tab will appear once a Branch Number is entered on the Branch Information 

screen.  Savings accounts are not administered here. On an on-going basis, this screen (shown below) 

will also present the aggregate month-to-date accounting balances for each branch/bank account 

combination.   

The Active column on the Bank Information tab indicates if a bank is active or not.  The  Active icon 

indicates a bank is active.  The  Inactive icon indicates a bank is inactive.  If the Inactive Bank 

Account checkbox is selected on the Edit Associated Bank screen, then the bank’s status will display 

as Inactive. 

 

Set Default Bank 

If the Default icon displays in the bank’s row, then that bank has been selected as the default bank. 

The default bank is selected using the Default bank for this branch checkbox on the Associate New 

Bank/Edit Associated Bank screen.  

Relate Bank Accounts to a Branch 

To relate a bank account to a branch, click  at the top of the Bank Information tab. The Select 

Bank dialog box is displayed. 

NOTE: Before a bank account can be related to a branch, the bank account must be established 

within Impact.  This can be done in Utilities > System Files > Banks > New or in Accounting > 

Misc. > Set Up Bank.  The assumption will be made here that the bank has already been set up. 
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account 
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Inactive 
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Select the desired bank account from the drop-down list, and then click OK.  If you clicked  in 

error, click Cancel to return to Bank Information tab.   

Any number of accounts may be assigned to a branch. 

NOTE: All bank accounts should be assigned to the Accounting “999” branch. 

Once a bank account has been selected to be assigned to the branch, the Associate New Bank screen 

will be presented, on which information about the branch/bank relationship can be defined. 

 

 

Default bank for this branch – For all but the Accounting branch (999), select this checkbox to tag one 

bank as the default bank for this branch. 

Inactive Bank Account – You can set up a bank ahead of time for a branch and set it as inactive using 

this checkbox, until you are ready to have Escrow users “see” the bank.  Accounting users will see all 

banks, regardless of active status. 
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The next step is to assign starting numbers for the numbering of Checks, Receipts, Deposits and Wires 

Out. There are three options for governing how numbers are assigned to these items: by Branch, by Bank 

or by a Check Control branch.  Use the drop-down arrow for each item type to make your selection.  

Numbers assigned By Bank is the strongly recommended option for each type, for each account, for 

each branch.   

Check Numbers Assigned By: 

By Branch: This option is most appropriate if you have separate accounts for each branch, but 

the By Bank option will serve in that instance as well.  Should your company be using pre-

numbered checks (not recommended), you may want to use this option.  Great care should be 

taken, if multiple branches are using one account, as you want each branch to have unique 

sequence number ranges, to space your starting check numbers sufficiently apart, from branch to 

branch, to prevent one branch from “running into” another.  If this selection is made, enter one 

less than the starting number in the field to the right of the selection.  As the account is used 

(checks are issued), the number that appears in this field will increment up.   

NOTE: While the field for check number can hold up to 15 digits many banks are limited to 

12 digits (or less) for their check numbers.  Confirm your bank’s limit before determining the 

numbering scheme for your company. 

By Bank: This is the most common, and recommended, setting, with laser printers using MICR 

toner, generating checks on blank check stock.  Whether you have separate accounts for each 

branch or not, using this setting will govern the administration of check numbers across all offices 

that are using each account.  If this selection is made, the starting number entered in the field to 

the right of the selection will be the same for all offices that will be using the account.  Once the 

number is set on one branch/bank screen, it will be used everywhere the same bank and “by 

bank” setting is selected.  This field will reflect the last check number used. 

By Check Control: This option should be selected ONLY if you are using one account for 

multiple branch numbers AND have other branches, also sharing the account, which will have 

unique sequences assigned to them.  In this situation, you cannot use the “by bank” option, as 

not all of the sharing units are to be pulling the next available number from a single point.  This is 

most applicable to physical locations that may have multiple operating units (‘branches’) within 

them, and which are using pre-numbered checks (not recommended), and where not all of the 

branches are to pull from the same starting number.  For those offices that are sharing a number 

sequence, select the control branch option. Rather than entering a starting number under this 

option, you will enter a branch number: the check control branch’s number.  The check control 

branch will need to have already been set up, and, within its configuration, the bank account will 

have been selected, with the by branch option and a starting check number.  This can be a “real” 

branch; it need not be a “dummy” branch number.  You can use the branch number of one of the 

“sharing” units as the control branch. 
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Receipt Numbers Assigned By 

These options are identical to Check Numbers Assigned By. The considerations in assigning numbers 

to receipts are also similar, and the By Bank option is common, and recommended, in most instances, as 

this prevents the chance of duplicate numbers being assigned to receipts.  It also permits a Receipts 

Journal to be run by bank so missing receipts can easily be identified (when troubleshooting issues).  

Some companies wish to tag their receipt numbers with the branch number in the leading digits (for 

example: “562000001”, for branch 562’s first receipt), to help the Accounting staff be able to rapidly 

identify the branch responsible for a receipt.  In this instance, you would need to use the “by branch” or 

“by check control branch” options.  As each company’s environment is unique, how the numbers are 

assigned is left to each company – but should be carefully considered. 

Deposit Numbers Assigned By 

These options are also identical in presentation, and the considerations are similar to receipts.  The By 

Bank option is recommended in most instances. 

Wire Out Numbers Assigned By 

These options are also similar.  Wires Out are considered disbursements in Impact.  Again, the By Bank 

option is recommended in most instances.  Wires Out are numbered regardless of whether the Wire Out 

Processing feature is in use or not. 

Month-to-Date Aggregate Information 

This information, shown on the left of the Bank Information tab will be filled over time as transactions are 

done, and may be of use when troubleshooting issues.  At the initial assignment of a bank to a branch, 

the fields will be zero.  As daily posting is done, the “buckets” are incremented up by the total amount for 

each type of transaction for the branch/bank account combination.  When the Close Month function is 

run, the final Current Balance will be moved up to the EOM Balance and the other buckets will be 

cleared out, in anticipation of the new month’s data coming in.  The Current Balance should match your 

Trial Balance total for the branch/bank account.  On rare occasion, these figures might need to be 

altered – but that should only be done under USA Digital Solutions, Inc. direction. 

Modify Bank Information 

To view or change the settings for an existing bank, highlight the bank on the Bank Information tab you 

wish to modify, and then click  Modify to the right of the selected bank. The Edit Associated Bank 

screen is displayed, with the settings for the selected bank. At this point, you can view and/or change the 

settings. Click OK to save your changes to the settings or click Cancel to return to the Bank Information 

tab without changing the existing settings. 

Remove Bank Information 

The  Remove icon removes link between the bank account and the branch. It does not delete the bank 

account. To remove the link, highlight the bank on the Bank Information tab you wish to remove, and 

then click  Remove in the selected row. 
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Savings Information Tab 

The Savings Information tab presents the aggregate month-to-date totals of savings activity for the 

selected branch.  When creating a new branch, these figures will be zero, and nothing need be done on 

this screen – unless a starting balance is required when switching from another system to Impact.  The 

Current Balance should reflect the total of the Savings Trial Balance, as of the current posting date, for 

the branch involved.  The savings balance is a total of all savings accounts assigned to the escrow file.  

An escrow file may have unlimited savings accounts. 
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Title Departments Tab 

Impact can be configured to permit more than one Title Department to be made available to the branches.  

However, at least one title “branch” must be set up before branches can have it assigned to them.   If 

more than one title branch is set up, the Title Departments tab will be made available in Branch Setup.  

Branches designated as “Title” branches will not have the Title Departments tab presented in Branch 

Setup. 

The Title Departments tab displays a list of the previously selected title units available for use by the 

branch being configured – this will be blank for a new branch set up (as shown below). 

 

Add a Title Department 

Click  at the top of the screen to display the Select Title Department dialog box, from 

which you will select a title unit to be assigned to the branch.   
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Select the desired Title Department, and click the OK button.  Repeat, if you wish more than one title 

branch to be available to the escrow branch in question.  Click Cancel to indicate you are finished with 

selecting title units for the branch.   

 

Set Default Title Department  

Select the appropriate one of the assigned Title Departments, and click  to flag that 

department as the default for the Escrow branch. 

If more than one title unit is assigned to a branch, all will be visible within the Escrow module, when 

submitting an order to Title, unless an Internal Title Officer has been selected (and the TO’s are not all 

assigned to 099).  In that case, the order will be submitted to the Title Branch of the Title Officer. 

NOTE:  If the option for multiple Title Branches is enabled, then each Escrow Branch under Setup 

Branch must have at least one Title Branch assigned to it. 

Print a Report of All Branches 

To generate and print a report of all branches defined click  at the top of the Branches screen. 

The Print dialog box is displayed. 

 

Complete the options on the Print dialog box, and then click OK to print the report. 

Note: It is recommended that the branch report be printed out routinely, and reviewed for accuracy. 
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Modify a Branch Record 

To modify a record on the Branches screen, click  Modify to the right of the selected branch or double 

click the highlighted entry.  

 

The Modify Branch screen is displayed, with the same four tabs that are described under Add a New 

Branch, but now there is data in the fields (refer to the Add a New Branch topic for more information).  

Use the Modify function to update branch configurations and to view the month-to-date figures for each 

branch/bank account.  

NOTE: Care should be taken when changing some settings (such as how check and other 

transaction type numbers are assigned) once they have been in use.    

Delete a Branch Record 

To delete a branch record that has no activity, for example, a branch that was set up in error, click  

Delete. 

 

Once a branch has activity of any kind, it cannot be deleted.  Attempting to delete a branch with activity 

will result in a warning message explaining why the branch cannot be deleted. 

Close the Branches Screen 

Click  in the upper-right corner of the screen to close the Branches screen and return to the main 

Utilities desktop.  
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Banks 

The Banks function on the System Files menu provides for the entry of new escrow trust bank accounts 

into the system, and for the editing of settings for existing bank accounts.  Each account is called a Bank 

in Impact/SQL.  Every escrow trust bank account will be assigned a separate bank number within Impact, 

even if at the same financial institution.  Depending on your user permissions level this function may or 

may not be available.   This module is exactly the same as that found in the Impact Accounting module, 

under Misc. > Set up Banks.  Generally, the system administrator or USA Digital Solutions, Inc., when 

setting up the system the first time would use the function in Utilities, and then the Accounting Manager 

would use the function within Accounting on an on-going basis to add or modify escrow trust bank 

account information.     

The Banks screen shows all bank accounts that have already been set up in Impact.  A Filter drop-down 

list allows you to control the accounts to be displayed by Active, Inactive, or Closed status. 

 

The  Info icon, located to the right of each account listed, displays a non-editable screen of information 

about the account. For example:  

 

Filter by 

Active/ 

Inactive/ 

Closed 

Status 
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NOTE #1: When a new bank account is established, USA Digital Solutions, Inc. must create the 

laser check and laser deposit slip template files.  Please give USA Digital Solutions, Inc. as much 

advance notice as possible of plans for utilizing a new account.  

NOTE #2: The bank’s specifications for its reconciliation export and positive pay import files must 

also be forwarded to USA Digital Solutions, Inc., so we can confirm that the filter programs already 

in existence will work properly, or assist in creating new filters as needed (assuming you intend to 

use a bank download in the reconciliation process, and intend to upload check issue data to the 

bank for positive pay processing). 

NOTE #3:  Once a bank account has been established it must always be assigned to the 

Accounting branch “999” and to each branch that will be using the account. 

Add a New Bank Account 

To add an escrow trust bank account into Impact, click  at the top of the screen. The Info tab 

on the New Bank screen is displayed. 

 

Bank Number – The next sequential bank number is automatically selected as the next number to be 

used.  You may not change this selection.  If multiple bank numbers have been established and one was 

deleted then Impact will use the first available sequential number for the bank assignment. 

Active – When a bank account is initially set up, you may wish to make it inactive (Active checkbox NOT 

selected), until the real “go live” date is reached.  Then, at the time you wish to make the bank account 

available to users, you will select the Active checkbox. 

Name/Address – Enter the name of the financial institution and address in their respective fields.   

Account Number – Enter the account number.   

NOTE: If bank downloads are used with the reconciliation process (with the Import function), the 

account number entered here should be in the same format as seen in the bank download.  You do 

not have to worry about this initially, but if the import in the reconciliation fails with a message that 

the File Format is Invalid, you may need to change the account number here.  For example, the 

bank export may have a number of leading zeroes before the account number that would need to 

be entered here.  This field can be altered without impacting checks or deposit slips (they do not get 

their number from this field). 
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Last Statement Date/Last Statement Balance – These fields are used by the reconciliation module as 

starting figures.  Nothing need be entered in the date field and the balance field can be left at $0.00. 

Overhead Fee Escrow No – This field will be on the screen if the system is configured to use overhead 

fee accounts (System Files > Setup Options > Accounting > Enable Overhead Fee Account).  If so 

configured, this is the escrow file into which the company’s fees (:T & :E payees) would be automatically 

transferred to upon disbursal at closings.  The fees can then be taken, en masse, from this escrow on a 

periodic basis (daily is recommended).  A separate escrow file per bank account must be set up, and the 

number of the escrow is entered in this field.  The overhead fee escrows should be set up under the 

Accounting branch “999”.  This is discussed in more detail later under the Setup Options section of this 

manual. 

Max Length of Other Wire Reference – Enter the character limit for the bank’s “other information” field, 

used to provide additional information on the bank’s wire out form.  This is only available if you are using 

Impact’s wire out feature, where Accounting confirms the wire out with a bank tracking number. 

Cutoff Time – Enter the cutoff time for transmitting wires. This field is just for printing on the wire out 

form.  It provides notification to the user that their accounting department will not transmit wires after the 

cutoff time. This will not prevent the user from entering a wire out after the cutoff time. 

Date Closed – This field is used to close a bank account in Impact.  It should be left blank when adding a 

new account.  See Modify a Bank Account for more details on this field. 

The Deposit Routing No/Disbursement Routing No – These fields provide data that can be used in 

Wiring Instructions.  This will allow a single set of wiring instructions to be used with multiple banks. 

SWIFT Code – The SWIFT code for the bank, if entered here, will be available to be used on Crystal 

Reports-produced or MS Word-produced wiring instruction documents.  Its use will provide the SWIFT 

number based on the bank assigned to the file.  The Crystal Reports and MS Word master templates 

used for wiring instructions must be edited on a site-by-site basis to utilize the SWIFT code. 
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New Bank – Positive Pay Tab 

Selecting the Positive Pay tab will present the screen shown below.  It is used to detail information 

needed by some positive pay filters to generate positive pay export files.   

 

Click OK to save your entries, or Cancel to close the form without saving your entries.  You will return to 

the Banks screen, from where you can add another bank account, modify an existing bank account or 

delete an unused bank account.  A report of all of the account information in the table can also be printed.   

The  Close button in the upper-right corner of the screen will prompt you about saving changes, if 

any were made, and, once that prompt is replied to, will return you to the Banks screen. 

Print a Report of All Bank Accounts 

To generate and print a report of information on all banks that exist in the system, click  at the top 

of the Bank screen. The Print dialog box is displayed. 

 

Complete the options on the Print dialog box, and then click OK to print the report. 
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Modify a Bank Account 

To change a bank’s existing information, click  Modify to the right of the account on the Banks list or 

double-click the highlighted entry.   

 

The tabs shown are the same as the New Bank screens, Info and Positive Pay, but with the fields filled 

with previously entered data (refer to the Add a New Bank Account topic for more information).  The 

current (last reconciled) bank statement date and balance will be in their respective fields.   

The following information can be changed on the Modify Bank screen: 

Active – You can change the bank’s active status – If you are “turning on” an account or “turning off” an 

account.  If a bank account that has activity against it is made inactive, no new escrows will be permitted 

to be assigned to the bank, but existing files with balances may continue to be worked off, and postings 

and reconciliations will continue to post to the account. 

Name/Address – Enter the name of the financial institution and address in their respective fields.   

Account Number – Enter the account number.   

NOTE: If bank downloads are used with the reconciliation process (with the Import function), the 

account number entered here should be in the same format as seen in the bank download.  You do 

not have to worry about this initially, but if the import in the reconciliation fails with a message that 

the File Format is Invalid, you may need to change the account number here.  For example, the 

bank export may have a number of leading zeroes before the account number that would need to 

be entered here.  This field can be altered without impacting checks or deposit slips (they do not get 

their number from this field). 

Last Statement Date/Last Statement Balance – These fields are used by the reconciliation module as 

starting figures.  There should be no need to change this information. 

Overhead Fee Escrow No – This field will be on the screen if the system is configured to use overhead 

fee accounts (System Files > Setup Options > Accounting > Enable Overhead Fee Account).  If so 

configured, this is the escrow file into which the company’s fees (:T & :E payees) would be automatically 

transferred to upon disbursal at closings.  The fees can then be taken, en masse, from this escrow on a 

periodic basis (daily is recommended).  A separate escrow file per bank account must be set up, and the 

number of the escrow is entered in this field.  The overhead fee escrows should be set up under the 

Accounting branch “999”.  This is discussed in more detail later under the Setup Options section of this 

manual. 

Max Length of Other Wire Reference – Enter the character limit for the bank’s “other information” field, 

used to provide additional information on the bank’s wire out form.  This is only available if you are using 

Impact’s wire out feature, where Accounting confirms the wire out with a bank tracking number. 
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Cutoff Time – Enter the cutoff time for transmitting wires. This field is just for printing on the wire out 

form.  It provides notification to the user that their accounting department will not transmit wires after the 

cutoff time. This will not inhibit the user from entering a wire out after the cutoff time. 

Date Closed – To close an account, enter a date in this field.  The system will run through some tests to 

determine if the account can be closed, and will report back any reasons why it cannot be, if that is the 

case. An account can be closed if there are no files with outstanding balances using that account and 

there are no outstanding (unreconciled) items for the account.  Once closed, no activity will be permitted 

with the account, by any users (Escrow or Accounting).  Reports on that bank’s activity will still be able to 

be run.   

The Deposit Routing No/Disbursement Routing No – These fields provide data that can be used in 

Wiring Instructions.  This will allow a single set of wiring instructions to be used with multiple banks. 

 

Click OK to save and exit, or click Cancel to close without saving your entries.  

Click  in the upper-right corner of the Modify Bank screen, will prompt you about saving changes, if 

any were made, and, once that prompt is replied to, will also return to the Banks screen. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 47 of 183 

Delete a Bank Account 

The  Delete icon, on the right of each account listed, will only be effective if there is no activity on the 

account; receipts, checks, wires out, and escrows are not assigned to it.  If an account was set up in error 

and has no activity against it, the account will be able to be deleted. 

 

 

 

 

 

 

 

 

Close the Bank Screen 

Click  in the upper-right corner of the screen to close the Banks screen and return to the main 

Utilities desktop.  
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IRS Reporting Entities 

The IRS Reporting Entities screen must be completed to provide accurate information on all 1099-S 

forms issued out of the system and to identify the transmitter information for reporting 1099-S information 

to the Internal Revenue Service. 

 

Add a New Entity 

To add a new entity, click  at the top of the screen to display the New IRS Reporting Entity 

Information screen. 

 

Company Information as it appears on the 1099-s form – Complete the Name Address, Phone, and 

Contact fields for the company. 

Transmitter Information for reporting to the IRS – Complete the TCC Number of the firm.  Do not 

include the “-“ (dashes) in the TCC field. Make sure to enter the contact information as well. If a different 

firm is responsible for transmitting the data to the IRS annually, then the information on the right side of 

the screen will be different from that on the left. Otherwise, it will be the same, with the addition, at the top 

of the screen, of the transmitter’s TCC Number (received from the IRS).  
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Multiple reporting entities can be set up in Impact/SQL to accommodate multiple legal entities within one 

database. The appropriate reporting entity for each branch is selected on the Branch Information 

screen. 

USA Digital Solutions, Inc. is the transmitter of 1099-S information for many of our clients.  There is a fee 

for this service. In that situation, the information on the right side of the screen would be USA Digital 

Solutions, Inc.’s. (What is shown below is sample data.) 

Click OK to save and exit, or click Cancel to close without saving your entries.  

Modify an Existing Entity 

To modify an existing entity, click  Modify on the right of each existing Company entry or double click 

the highlighted entry to display the Modify IRS Reporting Entity Information screen.   

 

 

The fields are filled with previously entered data (refer to the Add a New Company topic for more 

information).  Modify the fields, as needed. 

Click OK to save and exit, or click Cancel to close without saving your entries.  

Delete an Unused Entity 

To remove an unused entity, click  Delete to the right of each existing Company entry in the list. 

 

Close the IRS Reporting Entities Screen 

Click on the  Close button in the upper-right corner of the IRS Reporting Entities screen to display a 

prompt about saving changes, if any were made, and, once that prompt is replied to, will return to the 

Utilities desktop.  
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Set Next Escrow\Direct File Number 

During initial setup, the starting escrow number to be used by the system needs to be established if 

automatic assignment of numbers is turned on in System Files > Setup Options > General Functions > 

File Numbering. Automatic escrow numbers may be assigned within a branch or system wide, again a 

setting controlled in Setup Options. Depending on which setting has been selected, when you select 

System Files > Set Next Escrow\Direct File Number, you will see one of the following two screens: 

         Escrow Numbers Assigned by Branch  Escrow Numbers Assigned System Wide 

 

 

 

 

 

 

 

By Branch: If this is the configuration option selected, you will need to enter a Branch Number, and then 

the Next Escrow Number and Last Escrow Number to be used by the system for that branch. If you 

enter a Title branch number, you will be entering the range for Direct Order (DO) numbers. You will need 

to enter a range for each branch in the system. The Next Escrow Number field will increment up as files 

are opened. The numbers assigned by branch should not overlap. The numbers can be up to eight 

positions and may be all numbers or a combination of alpha and numeric. The Last Escrow Number will 

limit the automatic numbers issued to the range specified.  

System Wide: If this is the configuration option selected (recommended), you will enter only the starting 

number for each type: Escrow Number and Direct Number, or just one number if you check the 

Escrow/Direct the same box. The number(s) will increment up as files are opened. The numbers can be 

up to eight positions and may be all numbers or a combination of alpha and numeric.   

With either approach:  There must be four (4) numbers in a group in order for a numbering scheme with 

alpha characters to sequence.  For example: AB0001AB would sequence the numbers, with alpha 

characters “AB” on both ends; another example would be ABC00001.  Often, “00000001” is the starting 

value on a new database. 

Click OK to save and exit, or click Cancel to close without saving your entries.  
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Set Next Title File Number (optional) 

This option is used if Title wishes a different numbering scheme to be used on escrow files to represent 

the Title File Number. This is not used with Direct Orders.  

This System Files menu option will only be available if the Enable Title File Numbering option is 

selected in Setup Options > General Functions > File Numbering. This applies to each of the three 

options under Enable Title File Numbering, Begin at:   

Manually 

When File is Opened  

When File is Ordered. 

 

If this option is enabled, the Set Next Title Number screen is displayed, showing the next Title Available 

Title Number to be assigned. This number can be changed on this screen.   

 

Click OK to save and exit, or click Cancel to close without saving your entry.  

 

NOTE: This is a system setting and applies to the database even when Escrow Numbers are 

assigned by branch. 
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Set Posting Information 

The starting information on this screen is entered at the original configuration of the system. The 

information will increment as transactions are entered (Transaction Number), as postings are done 

(Date Last Posted), and as the Close Month function is performed (Current Posting Month).   

 

NOTE: These values should NOT be changed except under USA Digital Solutions, Inc.’s direction. 

Click OK to save and exit, or click Cancel to close without saving your entries.  
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Set Next Invoice Number 

During system configuration, the starting Invoice Number and Pre-Bill Number will be established on 

this screen. The values will increment up as invoices and pre-bills are generated. Pre-Bill is an option for 

invoices that presents estimated charges for work to be performed. Different invoice forms are designed 

for pre-bills than for regular invoices. 

 

NOTE: Care should be taken in changing these numbers once they have been established to 

prevent duplications. 

Click OK to save and exit, or click Cancel to close without saving your entries.  
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Printer Setup 

Each workstation or user’s work session must have printers defined within Impact/SQL AFTER printers 

have been established through Windows or the network operating system. Impact/SQL does not simply 

utilize the default Windows printer. Generally, two printers are defined: one Document / Report Printer 

and one Check Printer (also for deposit slips). Generally, both printers are laser printers and the check 

printer is loaded with blank check stock and MICR toner so that its output can be “read” by bank check 

processing equipment.   

 

As most users do not have access to Utilities, this function is also available under the Misc. menus in the 

Escrow, Title, and Accounting modules.  The printers presented are those configured for the user’s 

Windows session. 

On each tab, select the document printer to be used by highlighting it. Click OK to save and exit, or click 

Cancel to close without saving. 
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Setup Options 

The primary configuration of all of the Impact modules is done through System Files > Setup Options. 

The settings established here are based in large part on the Configuration Worksheet completed by the 

company prior to installation of Impact/SQL and the system will be configured by USA Digital Solutions, 

Inc. personnel. 

NOTE: Extreme care should be taken when making changes to these settings, especially after the 

system has been in operation, as they can have drastic ramifications to the behavior of the system. 

Changes should be discussed with USA Digital Solutions, Inc. prior to being made if there is ANY 

doubt as to the effect of the change. 

Users with experience with the Setup Options in Impact/SQL versions prior to 8.0 will recognize that there 

has been a complete reworking of the user interface starting with version 8.0.  The interface is now based 

on a “tree” layout, with the categories on the left side of the screen and details shown on the right.  In 

addition, the assorted options have been re-grouped by functional areas and are no longer grouped by 

the predominant Impact/SQL module to which they relate. 

 

The functional categories available to users with Utilities access are: 

 General Functions 

 Accounting Functions 

 Escrow Functions 

 Title Functions 

 Order Desk 

 Word Functions 

 Email Functions 

 CRRAR Functions  
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When a group header is highlighted, on the left side of the screen, as shown above, the right side of the 

screen will present a display of the current settings under that functional category, with a scroll bar to 

move through the display.  When a “branch” of the tree is highlighted, below a functional heading, the 

presentation on the right side of the screen will change to display the editable options.  Each will be 

discussed in the following pages. The  Print function at the top of the screen can be used to print the 

entire current setting set. 

Click OK to save and exit, or click Cancel to close without saving (safest route). 

General Functions 

Default Underwriter 

The Default Underwriter for the database is set on this screen.  Underwriters are established, in Impact, 

via the Document Maintenance menu in the Title module.  Up to 99 underwriters can be set up in 

Impact.  Once set up, one can be picked to be the default for the database.  As is noted on the screen, 

the database-wide setting can be overridden for individual branches, via the Branch setup screen.  The 

default underwriter will appear on the Initial Questions Dates/Transaction Information screen when a file 

is opened.  Escrow or Title users may override the default underwriter, file-by-file, as necessary. 

 

File Numbering 

The File Numbering options deal with file numbering, both for Escrow and Title. 

 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 57 of 183 

File Numbers Assigned by Each Branch – This option is used in conjunction with having file numbers 

automatically assigned. If enabled, then the number ranges for files at each office must be set under 

System Files > Select Next Escrow\Direct File Number. See that section of this manual for a 

discussion of that function. The alternative is file numbering with one sequence across the database. 

Enable Alphanumeric File Numbers – Allowing alphanumeric file numbering permits users to use letters 

in their file numbers as opposed to just numbers. This can come in handy when establishing Project files 

or naming files for training purposes where the “name” of the file is a handy reference rather than the 

users having to remember a specific file number. In the normal course of business, however, if automatic 

file numbering is turned on, most file numbers will be numeric and sequentially issued – generally only a 

manual assignment would be done alphanumerically. 

Enable Title File Numbering – This option will provide for a separate file number for the title file than that 

used for the escrow file. This is not required; it is a business preference. There are three sub-options that 

determine when and how the title file number is assigned.   

Manually, if selected, will require the Title user to assign a manual number after the title search is 

ordered.  The user will need to select the file using the escrow number assigned via Escrow > 

Edit > Update Search and Exam Info and change the file number from the original escrow 

number to the desired number. Once that is done, both numbers will appear in the status bar.   

When File is Opened, if selected, will automatically assign a title file number when an escrow file 

is created. The title number will appear after the escrow number in the status box (lower left 

corner of the Impact screen).   

When File is Ordered, if selected, will not assign a title file number until the title order is 

generated. This will preclude numbers from being assigned that are related to escrow files that 

will not be involved with title or which are cancelled.  

Allow Automatic Escrow Numbers – Turning this option on, which will then require completing the 

System Files > Select Next Escrow\Direct File Number screen, will provide for automatic and 

consecutive numbering of escrow files (and Directs, if linked). If not selected, then the user will be forced 

to enter a unique file number manually. 

Allow Manual Escrow Numbers – If the company wishes to permit the users to enter manual numbers, 

even if automatic numbering is turned on, this option should be checked. This is useful, for example, 

when transferring from another system to Impact/SQL and you wish to be able to enter numbers already 

established on the other system as you transfer file information to Impact/SQL. This option will also be 

required to be turned on if you want the users to have the ability to enter alphanumeric file names for 

Projects, Overhead Fee Accounts, or training files, for example. 

Allow Automatic Direct Order Numbers – This is similar to automatic escrow file numbers above, but 

for Direct Orders.  

NOTE: On the System Files > Select Next Escrow\Direct File Number screen, you can tell 

Impact/SQL to use the same automatic numbering scheme for both Escrow and Direct Order files. 

Also, if Direct Orders are not used by the company, Automatic Direct Orders will be enabled as a 

default. (One type of Direct Order setting is required.) 

Allow Manual Direct Order Numbers – This option is similar to manual escrow numbers above, but for 

Direct Orders. 
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Invoicing 

The Invoicing options deal with Invoicing; for Accounting, Escrow, and Title. 

 

Allow Invoice Date to be Changed – If this option is not enabled, the system will be set to only allow the 

current system date to be used on new invoices and no invoice dates will be permitted to be edited. 

Default Invoice Type To: Regular or Pre-Bill – If the company, in the normal course of business, issues 

“estimated cost” invoices on each order (pre-bills), then the Pre-Bill option should be selected from the 

drop-down list. Otherwise, the Regular option should be selected. The numbering for each type is distinct 

and set under System Files > Set Next Invoice Number. 

Accounting 

Allow Invoice Entry – When this option is enabled, users in the Accounting module will have an 

option, Invoicing > Add and Modify Invoices, to enter invoices for fees. While invoicing 

historically has been a Title function, this option permits Accounting users to issue invoices.  

If enabled, the following checkboxes display: 

Create and Edit Pre-Bill – This option allows an Accounting user to create and modify pre-bills. 

Create and Edit Regular – This option allows an Accounting user to create and modify regular 

invoices. 

Switch Pre-Bill to Regular – This option allows an Accounting user to switch pre-bills to regular 

invoices. 

Delete – This option permits an invoice to be deleted by an Accounting user. Because invoices 

are issued with automatic, sequential numbers, if the company wishes to preserve a record of 

each invoice issued, this option is not recommended.   

Allow Voiding – This option permits an invoice to be voided.  
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Escrow 

Allow Invoice Entry – When this option is enabled, users in the Escrow module will have an 

option, File > Add and Modify Invoices, to enter invoices for fees. While invoicing historically 

has been a Title function, this option permits Escrow users to issue invoices.  

If enabled, the following checkboxes display: 

Create and Edit Pre-Bill – This option allows an Escrow user to create and modify pre-bills. 

Create and Edit Regular – This option allows an Escrow user to create and modify regular 

invoices. 

Switch Pre-Bill to Regular – This option allows an Escrow user to switch pre-bills to regular 

invoices. 

Delete – This option permits an invoice to be deleted by an Escrow user. Because invoices are 

issued with automatic, sequential numbers, if the company wishes to preserve a record of each 

invoice issued, this option is not recommended.   

Allow Voiding – This option permits an invoice to be voided. 

 

Title 

Allow Invoice Entry – When this option is enabled, users in the Title module will have an option, 

Misc. > Add and Modify Invoices, to enter invoices for fees.  

If enabled, the following checkboxes display: 

Create and Edit Pre-Bill – This option allows a Title user to create and modify pre-bills. 

Create and Edit Regular – This option allows a Title user to create and modify regular invoices. 

Switch Pre-Bill to Regular – This option allows a Title user to switch pre-bills to regular invoices. 

Delete – This option permits an invoice to be deleted by a Title user. Because invoices are issued 

with automatic, sequential numbers, if the company wishes to preserve a record of each invoice 

issued, this option is not recommended.   

Allow Voiding – This option permits an invoice to be voided. 
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Miscellaneous 

This set of options is a catch-all category for items that do not have a number of related options. 

 

Enable Multiple Title Departments – This option permits the existence of more than one title department 

branch. If turned on, each escrow branch that is set up must be linked to one or more of the title 

departments that are established. See Branch Setup > Title Departments tab.  With multiple title 

departments, orders can be routed (by printing or emailing) to a more targeted audience. 

Remove Delete Icon from Receipts and Disbursements – This option used to be able to only be 

set/modified by USA Digital Solutions, Inc. personnel; it has now been “exposed” for use by local system 

administrators.  Selecting the option will prevent users from being able to delete receipts or disbursement 

entries.  It is strongly recommended that this option be turned ON, to prevent a break in item sequencing.  

From an audit standpoint, being able to delete items is not recommended.  Receipts can be zeroed out 

and disbursements can be voided, as alternatives to deleting them. 

Enable Viewing of the File History log – Certain events that occur within Impact/SQL when you access 

a file are tracked and written to a history log.  If this option is enabled, you can select the File > View 

Escrow History menu in Escrow or the File > View File History menu in Title to display the History Log 

screens.   The items tracked are detailed in the Escrow manual. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 61 of 183 

Enable File Tracking – This option controls the Tracking function that provides a place where dates can 

be recorded relating to the start date and completion date of various requirements of each file. For 

example, some items might include: demand for the payoff for the 1st mortgage, the appraisal, and the 

termite inspection. A default tracking table can be established under Utilities > User Tables > Tracking 

Descriptions > Escrow (or Direct Order) for both Escrow files and Title Direct Order files, and can be 

further customized by Transaction Type. The tracking entries may be customized by file as well. The 

entries of the Date Ordered and Date Received are made manually through the Escrow and/or Title 

modules. 

Allow Title to Access Escrow Tracking – This is a sub-option under the Enable File Tracking 

option discussed above.  If enabled, the Tracking screen maintained in the Escrow module is 

made available to Title users. This is handy as some of the items being tracked may be under 

Title’s control. When they complete the work, they can then record that fact which increases 

communication channels with Escrow. 

Enable Warning Message When Accessing a Closed and/or Cancelled File – When this option is 

enabled, and a user tries to access a closed and/or cancelled file, a pop-up notification will be received 

warning the user of the file’s status.  This can help ensure work is not done in the wrong file (if a similar 

but incorrect file number was entered, for example).  The date in this message is, traditionally, the date 

the fee check was taken (assuming the option to set the Closed Date when the fee check is cut is 

enabled). 

For Closed Files Use Initial Questions Close Date – This sub-option lets the date in the 

warning message (above) be the Close Date from the first screen of Initial Questions. 

Allow Escrow to View Conversation Logs from Title, and 

Allow Title to View Conversation Logs from Escrow – These two options relate to conversation logs 

available to Title on Escrow files, in addition to those which are available to Escrow on Escrow files.  With 

these options, the two conversation logs can be shared in one or both directions. 

Force deletion of current users attachment files after specified number of days - This option is 

designed to limit the space requirements of “user attachments”, a function which lets users attach 

dissimilar documents to files so they can be emailed or published together.  It is intended as a temporary 

function, and this option enforces that by prompting users about older documents. 

Number of days to retain files: ## - the number of days to allow documents to be retained as 

user attachments is defined with this sub-option. 

Default Property County to Branch County on New Orders – This option does as it says, which is the 

historic behavior for Impact.  Some clients do not wish for that behavior, so it was made optional.  

Deselecting this option will keep the county from defaulting to that on the Branch setup screen. 

Prompt for Automated Title Search – This option is only available if USA Digital Solutions, Inc. 

Messaging is installed, and with a title provider’s integration configured. If not, this option is grayed out. 

Click  for additional information about the field. 

Auto Publish to Document Management Systems – When this option is enabled, the system will 

prompt the user as to whether they wish to publish whatever document they have just edited to a third-

party document management system.  When not enabled, manual triggering of the publishing is required 

(available when a document management system integration is in place). 
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NAF (Name and Address File) 

The NAF (Name and Address File) is used to house the company-wide, or branch level, directory of 

names and institutions that are commonly involved with transactions.  Using the NAF to enter data 

speeds data entry and helps ensure data consistency for reporting.  

 

There are two options on the NAF screen: 

Enable Central NAF – Having a centralized Name and Address File (NAF) where all users share the 

same listing, when combined with a limited number of NAF administrators, can greatly enhance the 

effectiveness of the NAF. This will help limit redundant entries, making it easier for the users to find and 

select the correct entry, and can make managerial reporting of more use by limiting data-splitting across 

the redundant entries. If this option is not enabled, there will be a separate NAF established for each 

branch number; and, separate NAF Administrators will need to be available for each branch. 

Enable Automatic ID Numbers in NAF – When this option is enabled, the NAF (Name and Address 

File) issues a unique ID number for each entry in it. This can be useful when integrating data from the 

NAF with other non-Impact systems such as a general ledger accounts receivable package.  If selected, 

the Start At: field is accessible, for entry of the starting ID number.  The figure presented in that field will 

not increment up as numbers are assigned; it simply indicates where the numbering started.  Numbers 

cannot be manually assigned, so an entity would be established in the NAF first, have its number 

assigned, and then that number could be attached to the corresponding entity in the outside system. 
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Title Instructions 

Settings related to Title Instructions are controlled on this screen. 

 

Print Full Legal on Title Instructions – This option, combined with properly configured Title Instruction 

report templates, controls whether the full legal description is presented on the Title Instructions.   

Do not print the Title Instructions; email Instead:  

 Send email to Title Officer 

 Send email to Title Department 

This option allows the Title Instructions to be routed to one or more persons or to a department 

instead of being printed. An e-mail account will need to be configured for use by the Print Title 

Instructions module.  The Print Title Instructions module is configured through the Impact 

Windows Service interface, documented separately.  An e-mail address for the recipient(s) is 

entered on the Branch setup screen for the Title Branch(es) and the User setup screen for Title 

Officers.   

Send Email to Marketing Reps Upon Order Acceptance – This option will send an email notification to 

the Marketing Reps on the file upon the receipt of the Title Order in Title.  The Marketing Reps must have 

their emails loaded in the Marketing Reps User Table for this function to work. 

Attach Copy of Title Instructions to Email – This sub-option will attach a copy of the Title 

Instructions to the email notification to the Marketing Reps upon order acceptance. 
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Accounting Functions 

Deposit Slips 

The first category of settings, in the Accounting Functions group, is Deposit Slips.  All options relating 

to deposit slips are consolidated on this screen. 

 

Print Deposit Slips on Check Printer – If this option is enabled (recommended), all deposit slips will 

route to the user’s check printer where they will be printed on the blank check stock with MICR toner. 

Also, the encoding will be done in the MICR font. This will result in an item that can be “read” by banks’ 

item processing equipment. Users will then not need to prepare a deposit slip manually and the company 

will not have to purchase pre-encoded deposit slips. This may limit deposit slip errors and enhance 

reconciliation efforts. 

Allow Escrow to Prepare Deposit Slips – Receipts coded with “depositable” receipt type codes will not 

appear directly in reconciliations; they must be tagged for inclusion on a deposit slip, if either this Escrow 

option or the Accounting equivalent is checked. If neither is checked, all receipts will appear individually in 

the reconciliation file. Depending on who is preparing and making the physical bank deposits of 

depositable items (checks and cash) the company may want to turn this option on. If Escrow personnel 

are performing this function, then the option must be turned on. This will allow Escrow users to tag 

receipts generated with a “depositable” receipt type code into deposits and to generate deposit slips out 

of the system, precluding the need to prepare a deposit slip manually. If the Accounting staff is preparing 

the deposits, there is no need to turn this option on. 

Restrict Access by Branch – This option refers to the Escrow users only being able to see 

receipts from their branch in the deposit slip preparation screen. This option is highly 

recommended so deposits are not mixed up across branches. Accounting users will still see all 

receipts on the deposit slip preparation screen.  

Allow Accounting to Prepare Deposit Slips – If this option is enabled, Accounting users will have 

access to the deposit slip preparation screen. While Escrow users can be restricted to seeing only the 

receipts from their respective branches during deposit slip preparation (option discussed above), 

Accounting users will see all receipts that are available from all branches. The company may wish to turn 

this option on even if the bulk of deposits are prepared by Escrow users as there may be instances where 

Accounting may need to make a deposit for Escrow (for making deposits of loss fundings, for example, or 

just as a backup resource for Escrow). The options discussed above should be used in conjunction with 

this option to best “fit” Impact’s configuration into your company’s specific policies regarding deposits, 

specifically as Escrow users may not be permitted certain behaviors, which Accounting will then need to 

perform. 
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Allow Manual Deposit Slips – This option is used when a company is switching from not using Impact-

generated deposit slips to using them. Outstanding deposits would be entered manually so they will 

appear in the next reconciliation.  This is a rarely used option. 

Allow Escrow to Void Deposit Slips – When enabled, this option permits voiding of deposit slips.  When 

a deposit slip is voided, the receipts that were assigned to it will move back to the deposit slip preparation 

screen for inclusion on another deposit.  A receipt may not be modified if it is included in a deposit slip, so 

the slip would need to be voided to allow modification of a receipt that was on it. 

Allow Backdating of Deposit Slips – Users authorized to prepare deposit slips (Escrow and/or 

Accounting) can be given access to backdate a deposit ticket with this option.  As deposit slips should be 

prepared promptly each day, there is generally no need for this functionality. 

Income 

There are quite a few income-related options.  “Income” refers to the escrow fees, title premiums and 

other pass-through fees collected under the Company’s name.  The Company’s payee shortcut for 

income items is :T (read as “colon T”). 

 

Fee instrument Type – There are two options available: 

Check – A check must be physically generated out of each file to provide for the collection of 

Company fees (escrow, title, and miscellaneous). The Company check is identified by the use of 

the “:T” payee (read “colon T”). When “:T” is entered in the payee field during data entry on the 

HUD or worksheet, it means the funds are to be issued to your Company. These checks must 

then be endorsed and deposited into the operating account.  The information on fee checks is 

stored in the Income Analysis system, for reporting purposes.  

Transfer Slip – This option can be a great timesaver and involves no negotiable instruments. 

You can select this option, with two alternatives for how fees are tracked for transfer to the 

operating account, and stop the generation of paper fee checks file-by-file. In lieu of checks, 

transfer slips (aka fee slips) will be issued, when the “:T” payee is used, on the document printer 

and the fee information (dollars by income code by file) will be entered into the Income Analysis 

system. Reporting from that system can support the routine transferring of funds from the escrow 

trust account(s) to the Company’s operating account. The funds may also be transferred to an 

“overhead fee account” (another escrow file) should the Company desire to see the funds 

retained on the Trial Balance until physically moved to the operating account. (See Enable 

Overhead Fee Accounts below for more information).   
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Should multiple escrow trust accounts be used at a specific branch, the reporting out of the 

Income Analysis system cannot be relied upon to support the transfers until a “Bank” break is 

added to the reporting. Overhead fee accounts can be used in that situation in conjunction with 

fee transfer slips; there must be an Overhead Fee Account (OFA) for each escrow trust account. 

With the use of overhead fee accounts, the funds are either disbursed by check from the 

overhead fee accounts, after being collected there via the transfer slip function, by wire out 

disbursement, or negative receipt in the case of a bank transfer.   

Voids of fee transfer slips are managed smoothly by passing the reversing entries to the Income 

Analysis system and overhead files, if used, thereby netting down subsequent transfers to reflect 

the voiding of a previously taken fee. 

Set Number – This option is required for the Transfer Slip setting. When this option is 

clicked, it will ask for the next fee ticket number. The number cannot be 0, and the numbering 

sequence must not conflict/overlap with the check numbering sequences of any of the banks 

set up in Impact/SQL.  Generally, a high starting number, with many more digits than those of 

the banks’ check sequences, is utilized.  The sequencing is for all transfer slips, across all 

escrow trust accounts. 

Enable Overhead Fee Account – (Refer to the Banks section earlier in this manual, and the discussion 

of the income options above, for more information related to this topic in making the determination 

whether to use this option.) If fee transfer slips have been selected to be used, the funds can be reflected 

as having been pulled from the escrow files. The Trial Balance will reflect a lower balance in total even if 

the funds have not yet been pulled from the escrow trust bank account. Alternatively, the funds can be 

reflected as having been pulled from the escrow files and transferred to an “overhead fee account”. There 

would be one overhead fee account, which is just an escrow file that will be continuously used for this 

purpose, set up for each escrow trust account. If this function is turned on and a fee transfer slip is 

generated, the funds will be automatically receipted out of the escrow file and into the overhead fee 

account established for the escrow trust account of the file from which fees are being taken. The funds 

will remain in the overhead fee account ledger, and would therefore be reflected on the Trial Balance, 

until a check or transfer out was issued to remove the funds, which would then be deposited in the 

operating account and recorded in the general ledger of the Company. A void of a fee transfer slip will 

flow through to the overhead fee account as a reversing entry and a reversal of a void will flow through 

with the appropriate re-crediting of the fee. The primary consideration for use of an overhead fee 

account(s) is whether the company wishes for fees to continue to be reflected on the Trial Balance until 

they are actually moved out of the escrow trust account(s). 

Require Income Codes on Fee Checks and Transfer Slips – This option affects Escrow users directly 

in day-to-day operation. If turned on, the option requires that every line item on a fee check or fee slip 

must be coded with an income code.  While some lines may be coded by default based on their entry 

point on the HUD, not all lines will be. This option forces the users to edit the fee disbursements (those 

made out to the “:T” payee) to include an income code on every line item. The revenue check or fee slip 

will not be able to be printed until all items are coded. This is a highly recommended option as it ensures 

that all revenue data makes it into the Income Analysis system and that information reported out of that 

system is full and complete. This is mandatory if bulk transfers of fees are being done based on reporting 

from the Income Analysis database. 
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Close Escrow Files on Issuance of Fee Checks or Transfer Slips – When this option is enabled, it will 

cause the date of the fee check/fee slip to be entered into the Close Date and Recorded Date fields 

within Impact/SQL Escrow. The “fee check/fee slip” is identified as the check/slip issued to the “:T” payee 

(read “colon T”, for Title Company). If the company’s policy is to issue fee checks on the day of closing, 

then this option helps to guarantee that the files are properly tagged with the correct closing date. If fees 

are routinely, by company policy, taken before or after the formal closing date, then the Company may 

decide this option should not be turned on. If turned off, the escrow staff must be trained to routinely enter 

the appropriate date(s) into the Close Date and Recorded Date fields or reporting that keys off of those 

dates will be meaningless. When this option is turned on, the Allow Escrow to enter, modify or delete 

Closed and Recording Dates manually option (discussed below) can be disabled so the only way a file 

can be flagged with a Close Date is with a fee check/fee slip being issued. The only way to change a 

Close Date if being forced from the fee check is through Utilities > Tools > Update Escrow Information 

if the Allow Escrow to enter, modify or delete Closed and Recording Dates manually option is 

disabled. The Close Date appears on the Trial Balance report and on some MIS reports in addition to 

being stored in the ledger. 

Remove Closed and Recording Dates upon Voiding of Fee Checks or Transfer Slips – This option 

will remove the Closed and Recording Dates on a file when the fee check/slip is voided.   Normally, the 

Close Escrow File on Issuance of Fee Checks or Transfer Slips option is turned on (above) and the dates 

entered as a result of that option are the ones being removed when the void is done.  This may impact 

MIS and other reporting (based on Closed Date) if voids are done on prior month items. 

Allow Escrow to Enter, Modify or Delete Closed and Recording Dates Manually – If this option is 

turned on, the user can, or must, if the Close Escrow files on issuance of Fee Checks or Transfer 

Slips option is not turned on, enter the close date for a file without involving the fee check/fee slip 

process. This option adds Close File to the Escrow Disbursements menu. Note: the Close Date in Initial 

Questions is not the same field; that one is the “Estimated Close Date”, which does not “close” the file. 

Warn if Invoice Exists When Printing Fee Check/Slip – This option will result in the user being warned 

that an invoice exists for a file if a fee check/slip is being printed.  The user may still print the fee 

check/slip. 

Restrict Changes to Posted Income to Allow Only the Income Code to Be Changed– This option 

limits changes to posted income data, via Accounting > Misc > Adjust Income Analysis, to just income 

codes.  Amounts, dates and other data will not be permitted to be changed.  This provides tighter control 

over income data but does permit errors in income code selection to be corrected without going through a 

complete fee check/slip voiding and reissuing cycle. 

Enable Adjust Income Analysis by Item– There are two variations of the Adjust Income Analysis 

editing function – By File Number and By Item.  The By File Number alternative is the default function, 

beginning with Impact/SQL version 8.0.  Historically, the By Item method was the norm.  Both are 

described in detail in the Accounting manual.  The By File Number option provides greater control over 

ensuring that the original fee check/slip remains intact, from a dollar total standpoint, than the By Item 

function does – which is why By File Number is the new standard.  Clients that insist on the old, By Item, 

approach, can turn on this option…otherwise the By Item approach is not presented.  The  Info icon 

brings up the screen shown in the earlier screenshot, explaining the option is not available if FNF 

standards are enabled. 

Allow Escrow to View Income – The Company can control whether they wish Escrow module users to 

be able to view and/or print their own income information from the Reports menu. The Escrow Manager 

will be permitted to print income data for the entire branch while individual Escrow Officers will only be 

permitted to print their own information. If management does not want this data to be available for such 

access, then this option should not be checked. All income reporting would then come out of the 

Accounting and MIS modules exclusively. 
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Manual Checks 

There are two options on the Manual Checks screen, both relating to escrow users and manual checks.   

NOTE: Accounting users can always enter manual checks.  Manual checks, in this context, are 

checks that are not prepared in Impact, but which are truly hand-completed outside of Impact 

(during a printer failure, for example). 

 

Allow Escrow to Enter Manual Checks – In normal operation, checks are issued out of Impact/SQL to a 

laser printer on blank check stock. This functionality ensures that information about checks is captured by 

the system through their generation. There can be, however, instances where manual checks might need 

to be issued: the check printer(s) might be disabled, the entire system may be out of commission, and 

there is demand for an immediate check. In this case, the Company should have a policy governing who 

will issue manual checks (Escrow or Accounting) and will need to have some pre-printed check stock at 

the disposal of the appropriate people. After a manual check is prepared, data about the check (payee, 

amount, escrow file, date) will need to be entered into Impact/SQL. This option allows for that information 

to be entered by Escrow users in addition to Accounting users. Generally, as these are “special events” 

and will have potential positive pay processing and/or reconciliation impacts, Accounting needs to be 

aware of the existence of manual checks and so often the entry of that data is restricted to Accounting 

users. It may be that the physical issuance of manual checks is also restricted to Accounting users, but 

that is outside of Impact/SQL’s reach. Manual check entry also allows for the entry of address information 

on the checks. 

Allow Floaters w/Check Write to Enter Manual Checks – One category of users, controlled by Access 

Code in the Users table, is Floaters - with Check Write ability. As these individuals may be in and out of 

many branches, the company may wish to restrict their functionality a bit more than an Escrow user 

permanently assigned to one branch or, conversely, expand it if they are “power” users. If the option is 

selected permitting Escrow users to do manual checks, Floaters - with Check Write ability can be 

restricted if the company so desires or the company may only want these users to do manual checks and 

not all of Escrow. 
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Miscellaneous 

The Miscellaneous screen, under Accounting Functions, addresses two functions that do not fit in the 

other categories…and they are not related to each other. 

 

Allow File Transfers on Files with Negative Balances – File transfers, between branches and/or 

banks, will not be permitted for negative balance files, if this option is not enabled. 

Positive Pay Options – Select an option from the drop-down list to allow the system to be configured for 

no positive pay (None), Positive Pay, Reverse Positive Pay, or Both.  This option depends on the 

banks used by the Company for their escrow trust account(s).  

Positive Pay: This feature generates a file of checks issued out of Impact, for transmission to the 

bank, to be matched against items presented for payment. Please refer to the Impact Accounting 

manual for a more complete discussion on Positive Pay. This option, when selected, makes the 

feature available to Accounting module users. The decision to use this function does not need to 

be made at the initial setup. 

Reverse Positive Pay: As with Positive Pay, the need for this feature to be enabled is a function 

of the bank being utilized by the Company. Some banks will not accept a Positive Pay upload, but 

will generate a file of items presented for payment that the company can then, through 

Impact/SQL, match against checks issued. The Company will then notify the bank of items to be 

rejected. Please refer to the Impact Accounting manual for a more complete discussion on 

Reverse Positive Pay. This option, when selected, makes the feature available to Accounting 

module users. The decision to use this function does not need to be made at the initial setup. 
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Overdrafts 

The Overdrafts options screen address permitting overdrafting of escrow files as well as logging reasons 

for overdrafts. 

 

Allow Overdrafts with Password – There are two methods available to the company for handling 

overdrafts (caused by a check): (1) with passwords or, (2) the company may choose to forbid overdrafts 

completely. Leaving this option unchecked will prevent overdrafts caused by a check from being 

permitted in any instance. Checking this option permits overdrafts with two different safety mechanisms: 

dynamic or static passwords.  

The sub-option Use Dynamic Password, when checked, will trigger the use of a two-step 

password routine if a user tries to disburse more funds than are in a file. The user will be 

presented with a “key” (set of numbers) and will be prompted to call the responsible Accounting 

user for the password that goes with the key presented. The Accounting user will enter the key 

provided by Escrow into the password module in Accounting and a unique key will be returned 

which is then given to the Escrow user to be entered into that system. This password will permit 

the file to be overdrawn. A log of all of the instances of overdrafts being authorized through this 

mechanism is maintained in the system and can be printed out. If Use Dynamic Password is not 

checked, but Allow Overdrafts with Password is checked, then the Password field will be 

opened up into which a static (unchanging) password is to be entered. Selected users will need to 

be given this password with which they can permit a file to be overdrawn. As static passwords 

tend to get pretty wide distribution quite quickly, the dynamic approach is safer, but it takes more 

time in execution at each overdraft. If a static password approach is taken, routine changing of 

the password is highly recommended and serious training on limiting its distribution is necessary. 

Allow Overdrafts on Outgoing Wires with Password – This option behaves similarly to the Allow 

Overdrafts with Password option above, but relates specifically to outgoing wires as opposed to checks. 

The two alternatives of password protection discussed above (dynamic and static) are applicable here as 

well. Please refer to the discussion above for further details. 

Require Reason on Overdrafts – In addition to requiring a password in an overdraft situation, a reason 

for the overdraft can be required. This option forces a reason to be entered. This reason will be printed on 

one version of the Trial Balance and on the Overdraft Report, if available.  
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Posting 

There are only two options relating to the posting of the daily work, and both are recommended to be 

turned on. 

 

Include the Following Reports in the Posting Analysis – There are two reports that can be added to 

the output generated when the daily work’s posting process is started: 

Daily Receipts Journal by Bank  

Daily Disbursement Journal by Bank 

These are handy reports to have on hand to assist in researching posting issues that might arise. While 

the routine output generated, as the Posting Analysis, contains the posting detail, these two reports are 

formatted to make the data more readable, on a macro level. 

Reconciliation 

These options relate to the escrow trust account reconciliation functionality. 

 

Auto-Clear Voided Checks – With this option enabled, checks that have been voided as of a date up 

through the date of the reconciliation being done will automatically be flagged as cleared and will not 

appear in the reconciliation when it is opened. Checks that are voided as of a date beyond the 

reconciliation date will still appear in the reconciliation with a Status flag of “V”. These are referred to as 

“future voids”. If the option is not turned on, voided items will appear in the reconciliation and will have to 

be cleared by hand. It is recommended that the option be turned on. 

Mark Zero Dollar Items as Cleared – When you perform a reconciliation, zero (0.00) dollar amount 

items, through the date of the reconciliation, are automatically marked as cleared when this option is 

enabled.  It is recommended that the option be turned on. 
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Create Auto Adjustments for Check Issued/Paid Differences on Recon Import – This option is 

utilized when using the Recon > Import function in Accounting to build the reconciliation file. This feature 

automatically creates a bank adjustment, in the reconciliation, for any difference between the amount of 

the check issued, and the amount that was actually paid at the bank. 

Only Clear Deposit Slips by Ticket Number on Recon Import – This option will require a match on 

both ticket number and dollar amount, when Import is utilized in preparing a reconciliation file, before a 

deposit slip will be marked cleared.  Some bank downloads of cleared items contain the deposit slip 

number, and this option utilizes that feature.  This aids in making sure that common-dollar deposits are 

properly cleared – rather than just the first deposit for the dollar amount that matches the download item. 

Include Book Adjustment for Total Undeposited Receipts – An automatic Undeposited Receipts 

adjustment, in the reconciliation, on the Book tab in the bottom summary data area, is controlled by this 

option. In addition, the Receipts Journal, when run for “undeposited receipts only” through the date of the 

reconciliation, presents the data from the deposits details table, which is undeposited through the date of 

the reconciliation…and so should match the automatic adjustment created if this option is enabled. 

Prompt User to Print Reports Before Posting Reconciliation – Critical reports that are printed out of 

the Reconciliation function (Summary, Cleared and Uncleared) cannot be re-printed after a reconciliation 

is posted.  This option, to prompt the user to print the reports before posting of the reconciliation, is 

designed to ensure that the reports are printed.  This is helpful when there is turnover in the Accounting 

area and the habit of printing before posting is not ingrained in the personnel doing reconciliations. 

Wire Processing – Incoming 

There are two sub-sections under the Wire Processing section:  Incoming and Outgoing.  This is 

because the functions are separate and distinct and need not both be enabled or disabled at the same 

time. 

 

Enable Incoming Wire Processing – This option controls whether the incoming wire processing 

functionality of Impact/SQL is turned on. With this function turned on, Escrow users fill out an incoming 

wire screen on an anticipated wire, which is then reviewed by Accounting. The funds associated with that 

wire are not receipted into the escrow file until Accounting has provided a Fed Wire ID upon confirming 

the physical receipt of the wire at the bank. This can help limit overdrafts as the receipting of wired funds 

is more controlled, as wires should not be receipted into multiple files.  

Prompt for Additional Email Addresses on Accounting Acceptance – This option is made available if 

incoming wire processing is turned on. This option will result in a prompt asking the Accounting user if 

they want to add additional email addresses to the acceptance notice that is generated for the originator 

of the information on the incoming wire screen and the escrow officer on the file (if not the same person).  
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Wire Processing – Outgoing 

The outgoing wire processing functionality is separate and distinct from incoming wire processing. Some 

companies may use one, but not the other, depending on their structure and distribution of 

responsibilities. This process has the Escrow user complete an outgoing wire screen detailing information 

about the wire they wish to send. The funds are immediately withdrawn from the balance in the file.   

 

Enable Outgoing Wire Processing: The following three options are available from the drop-down list: 

None: If selected, only Accounting users will have the short form available to them to enter 

information on wires out.  Escrow would communicate, on paper, with Accounting about wires 

out. 

Short Form in Escrow: If selected, Escrow users enter basic information about the wire out, and 

Accounting does not confirm the wires.  This option is used if Escrow personnel are doing the 

wire activity with the bank directly.   

All: If selected, a “long form” is presented to Escrow users, onto which they detail information 

about the wire out they want sent, and Accounting is then notified of the desired wire and when 

they execute the wire and get the bank confirmation it has gone out (indicated by the entry of a 

Fed Wire ID on the wire out form by Accounting), a notice is returned to the originator of the 

request and the EO on the file. 

Prompt for Additional Email Addresses on Accounting Confirmation – This option is the same as the 

similarly labeled option under Incoming Wires, discussed above.  

Allow Escrow to Put Outgoing Wires on Hold – This sub-option allows the user to create a long form 

wire out request in advance and place a hold on it, thereby not releasing it to Accounting. If the file is to 

be overdrawn by the wire out and overdraft protection is turned on, the user will be prompted for the 

overdraft password. (With the MFS Wire Integration option turned on, the user will not be prompted 

about the overdraft until the wire out is released from the hold.)  

Allow Accounting to Enter Manual Outgoing Wires – This option will permit Accounting users to 

complete the short form outgoing wire screen, within Accounting, while Escrow users are using the long 

form format, which interacts with Accounting.  This will permit Accounting to create an outgoing wire 

directly. 
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Enable Dual Authorization by Escrow – This sub-option provides for dual authorization of wires out, 

before they appear on the Accounting wire out confirmation screen.  This option, when enabled, will 

provide a Wire Approval screen, in Escrow, and Escrow users must be configured as either a Wire Out 

Approver (user can approve wires entered by other users) or Wire Out Self Approver (wires entered by 

such a user do not require a second approval) in the Password file.   

Allow Escrow to Void Outgoing Wires –This option determines whether Escrow users are permitted to 

void outgoing wires via the Misc. > Void Wire Out menu. The user will be required to enter the wire 

number. Once the wire is identified, the user will have the option of voiding the wire out or canceling the 

operation. As it can lead to duplicate disbursal of funds if voids are done improperly, care should be taken 

when providing this function to a wider range of users than just Accounting. However, in a smaller 

environment where Escrow staff handles all of the interactions with the bank(s) on wires, this setting 

might be appropriately turned on. 

Escrow Functions 

Data Entry 

There are quite a few options on the Data Entry screen, under Escrow Functions.  They all relate to the 

configuration of the Escrow users’ data entry screens, and default options thereon. 

 

Type of Entry – There are four choices under this option and those to be available to users should be 

checked.  The types are HUD, Worksheet, CDF (Closing Disclosure Form) and Commercial.  

Default Entry Type - It is up to the Company as to whether to present a default entry type and, if so, 

which one.  The options are None, HUD, Worksheet, HUD with GFE, Worksheet with GFE, and CDF 

(Closing Disclosure Form).  The choice made will pre-suppose for the users which format they will use, 

but they can still pick the format they prefer.  Regardless of the manner of data entry, either the 

Settlement Statement or HUD documents can be generated (on residential, non-CDF files).  

Enable Order Type Designation – This option turns on the ability to flag each file with an order type.  

Order types can be used for assisting with data breakdowns for reporting to the California Department of 
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Insurance (which uses this type of breakdown in their reporting) or for other custom reporting purposes.  

The Default Order Type Designation options are:  

None 

Escrow & Title 

Escrow Only  

Title Only 

Enable Impact Express –The Impact Express function provides for the quick entry of a number of new 

escrow files over a range of consecutive numbers with a minimal amount of requested information initially. 

As an escrow number cannot be “unused” once selected for use, the company may wish to turn off this 

function to prevent the erroneous use of a large number of file numbers by accident. 

Enable Bill To in Initial Questions – This option will put the Bill To Customer screen on the Initial 

Questions menu of screens in Impact Escrow, so the party to be invoiced for escrow & title fees can be 

identified.  If invoicing is not being done by the Company, there is no need to have this option enabled.  If 

data has been entered in earlier data entry for the party identified by the check box selected, it will 

automatically populate the fields presented. If not, the data for the party to be billed (for escrow and title 

fees) must be entered manually or pulled from the NAF.  While there is not an Accounts Receivable 

module within Impact/SQL, data on invoices that have been generated can be exported to external A/R 

systems for follow-up tracking. 

Show Commission in Initial Questions – If this option is enabled, the Commissions menu option will 

also be available on the Initial Questions menu, of Residential files. If this option is NOT enabled, then 

the Commissions menu option will be only available from the HUD and Worksheet data entry menus. 

Show Recording/Transfer Charges in Initial Questions – If this option is enabled, the Gov’t 

Recording/Transfer Charges data entry screen will be displayed in the Initial Questions section of 

screens, right after the Commissions screen, if present, or after Parties. 

Enable Misc Data Entry in Initial Questions – A custom data entry screen, which can be utilized in 

Escrow, can be defined in the Utilities module. The company may identity data fields they wish to collect 

on each file through this utility. If enabled, this screen is available from the Initial Questions menu. 

Select the Misc Data Entry menu item to open the Miscellaneous Data Entry screen. Also, a report can 

be printed from that screen.  Enabling this option will enable configuration of the screen through Utilities 

> User tables > Dynamic Data Entry.  

Enable Prelim Distribution in Initial Questions – This option turns on the preliminary title report 

distribution tracking function. The Prelim Distribution List screen is called from the Escrow module via 

Initial Questions and provides a place where the escrow officer or support staff can track the number of 

copies of the Prelim, the CC&R’s, and sets of other documents, which should be sent to a wide range of 

pre-identified parties (seller, buyer, lender, broker, etc.).  The methods of delivery (Via) drop down 

provided on the user screen in Escrow are pre-established through Utilities > User Tables > Prelim 

Distribution Via. 

Create Distribution Letter for Escrow Branch – If this sub-option is selected, this listing can 

also be used to trigger the generation of opening letters after the prelim/commitment has been 

issued.  

Enable Legal, Vesting and Plotted Easements – If this sub-option is selected, three additional 

document types are listed on the Distribution screen. 
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Enable Marketing Reps #3 and #4 in Initial Questions – Normally, on the Initial Questions > Dates / 

Transaction Info screen, fields are presented for two marketing representatives per file. This option 

expands the field set to four marketing representatives and allows for all four to participate with split 

percentages. The primary rep’s percentage is inferred as 100% less the percentages identified for the 

others. Marketing representatives are established in the system through Utilities > User Tables > 

Marketing Reps. 

HUD Title Option (Files without GFE only) – These options relate to how title charges are displayed on 

the HUD, and are only applicable to files of “with no GFE” entry types.  Click on the  Info icon on the 

screen for additional information about this field. 

The options available on drop-down list are: 

None  

HUD Lines 1109-1110B – When using the rate calculator, normally the system uses HUD line 

1108 to show the total charges paid by the buyer and seller and shows the policy liability amounts 

on 1109-1110B (with no dollar amounts in the buyer and seller columns). If the HUD Lines 1109-

1110B option is enabled, then HUD 1108 shows the payee for the title charges (no buyer/seller 

amounts) and 1109-1110B show the policy liability amounts AND the amount paid by the buyer 

and seller. 

Title Fee Breakdown – If the company routinely splits title fees between itself and other title 

companies, such as when out-of-county policies are sold, then it may want to turn on this option. 

It provides a mechanism at the bottom of the title fee detail screen for generating a split of title 

fees based on a percentage and for identifying the payee for the split. A check will be generated 

to the payee identified. The detail of the split will be shown on the fee slip detail as a reduction to 

the Company’s fees.  

On Refi’s Copy Seller Name to Buyer Name – With the introduction of the Parties routine for entering 

parties to the file, this option is no longer utilized and should be unchecked. 

Calculate Commissions Based on % Of Sales Price/Commission Base – This option provides for the 

calculation of agent commissions to be based on a percentage of the commission base (normally the 

sales price), as opposed to a percentage of the total commission amount. Click on the  Info icon for 

additional information about this field. 

Allow Escrow to Edit Full Legal After Acceptance by Title – Escrow is permitted to edit the full legal 

description attached to a file after the title order has been accepted by Title (printed or emailed to Title 

after being “ordered”)  if this option is enabled.  Often, Title departments do not want Escrow to be able to 

edit the full legal, after the order has been sent to Title. 

Enable Secondary Escrow Officer – When this option is enabled, a user has the ability to identify a 

Secondary Escrow Officer on an Escrow file.  

Prompt for Order Title Search and Print from Initial Questions – This option displays a prompt to the 

user asking if the file should be submitted to Title, when they exit Initial Questions.  An Escrow Only 

operation would likely turn this option off. 

Enable Escrow Processors 2 & 3 – This option boosts the number of Processors that can be associated 

with any file from one to three. 

On Commissions Validate Scrivener Fee (CO Only) – This option provides for a validation test to see if 

a “Scrivener Fee” has been added to any of the Listing Agent’s sub-agents (on Residential or Commercial 

files) for sales transactions.  The testing is done on the Commissions screen.  If enabled, the test is done 

on files whose transaction type’s “Refi” property is flagged “No”.  This testing is applicable to Colorado 

only, due to a workflow established there.  
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GFE Defaults 

 

Disclose Seller Recording Fees in Column – This option affects default behavior of the HUD 1200 

section on “with GFE” files. This setting will be the default for new files; however, the user may change 

the setting on the HUD 1200 screen, file-by-file. 

Default Descriptions – Enter a default description for each of the following: 

Seller Paid Loan Charges 

Seller Paid Owners Policy 

Settlement or Closing Fee 

Link Seller Credit to Buyer Amount (1103 & 1204) – This option adds a Lnk checkbox to these two 

screens (which is checked by default) and which will trigger the system to automatically populate the 

seller credit to buyer amount field based on the buyer amount.  If the link does not apply to a specific file, 

the user can uncheck the Lnk checkbox and edit the amounts independently. 
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Proration Defaults (GFE, COM, CDF) 

These settings apply as the database-wide defaults for proration calculations for GFE, Commercial and 

CDF files.   

 

Prorations Based On –This option sets the default Based On setting for new prorations during setup.  

Select the default setting for each of the following: 

County Taxes – Select 360 Days, 365 Days, or Days in Period. This affects HUD 100, 210, 

400, and 510. 

City/Town Taxes – Select 360 Days, 365 Days, or Days in Period. This affects HUD 100, 210, 

400, and 510 

Assessments – Select 360 Days, 365 Days, or Days in Period. This affects HUD 100, 210, 

400, 510. 

Daily Interest – Select 360 Days or 365 Days. This affects HUD 901. 

Other – Select 360 Days, 365 Days, or Days in Period. This affects HUD 100, 210, 400, 510, 

and 1300. 
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Disbursements 

The Disbursements setup options screen, under Escrow Functions, controls Escrow functionality 

regarding disbursement of funds out of escrow files. 

 

Allow Escrow to Void Checks – Errors can be made during check entry. The issue is whether the 

company wishes all Escrow users to be able to void checks or whether that action should be limited to 

Accounting users and, potentially, the Escrow Manager – see below. Limiting the voiding of checks to 

Accounting users will require a greater degree of communication between Accounting and Escrow and 

will require Accounting to be prompt in response to Escrow in order to prevent a bottleneck. Some 

companies insist on Accounting authorizing and performing every void. This option is provided for them, 

as turning it off will prevent Escrow from voiding any checks. 

Allow Escrow to Reverse a Voided Check – Impact will permit the reversing of a void. This may be 

required if the wrong check was voided or a check was voided legitimately (it was lost) and then was 

found to be truly outstanding (it cleared the bank). Such items can complicate reconciliations and 

therefore some companies want only Accounting users to be able to reverse voids so they can be made 

aware of the item and be prepared to give it the attention it needs. This option will restrict Escrow users 

from reversing voids if not enabled. 

Allow Escrow to Void Fee Slip – This option is similar in nature to the void check option discussed 

above.  It is only relevant if the Company is using fee slips for collection of escrow and title fees with the 

“:T” payee instead of checks. As fees can be a sensitive issue and the changing of fees after they have 

been approved might need to be noted by someone other than the Escrow Officer this option is separate 

from the check option above. 

Allow Escrow to Reverse a Voided Fee Slip – This option is similar to the reversing of a voided check 

option described above, but relates specifically to fee slips. 
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Restrict Voiding of Checks to Escrow Manager Access Only – If the company wishes to restrict the 

voiding of checks from most Escrow users, but permit users designated as Escrow Managers (System 

Files > Users w/ Access Code = Escrow Manager), in addition to Accounting users, to be authorized to 

void checks, then this option should be turned on. This can ease the bottleneck discussed above (Allow 

Escrow to Void Checks). 

Restrict Voiding of Fee Slips to Escrow Manager Access Only – This option is similar to the voiding of 

checks by Escrow Manager access level only option discussed above, but relates specifically to fee slips. 

Restrict Voiding of Checks to Current Day Only – Another alternative to completely restricting Escrow 

users from voiding checks is to limit the checks they can void to current day items only. These are most 

likely checks cut in error and which are most likely still in the possession of Escrow personnel limiting the 

risk of them clearing the bank along with re-issues. Check this option to give this flexibility to Escrow 

users. 

Restrict Voiding of Fee Slips to Current Day Only – This option is similar to the voiding of checks 

restriction to current day items only, but relates specifically to fee slips.  

Print Sub Agents on Commission Checks – To reflect any reductions made to the Listing and Selling 

Agents’ commissions, through payments to sub-agents, on the commission checks, this option should be 

turned on. The payments will be noted, on an optional addendum, as line items beginning “(Less) sub-

agents name” and showing the amount paid as a negative number, reducing the primary agent’s gross 

commission down to the net paid on the check. Up to five sub-agents may participate in each Listing, 

Selling, or Other Broker check. A separate check is issued for each sub-agent’s commission. 

Prompt User for Full Address when Printing Checks – This option will trigger a prompt for a full 

address on any check about to be printed that is missing address information. 

Require 1099-S Prior to Disbursement – This option, if selected, will require the 1099-S process to 

have been completed prior to any funds being disbursed from the file. If the file is flagged Reportable, the 

information for one or more 1099-S forms must have been completed and the form(s) generated. If the 

file is flagged Non-reportable, this flag is ignored. This option may enforce compliance with the 1099-S 

process, but may introduce a possibly undesirable hurdle for pre-closing disbursement items. Impact/SQL 

is designed for 1099-S forms to be distributed at closing, not for mass mailings after year-end. 

Remind to do 1099-S After Disbursement – After a user has printed the revenue check, a message is 

presented to the user if the file is marked as Reportable and a 1099-S has not yet been completed. The 

user is then given the opportunity to enter their 1099-S information. It is recommended that this setting be 

enabled, as it is less restrictive that the Require 1099-S prior to disbursement option (above), but still 

warns the user that there is an outstanding issue. 

Allow Escrow to Post Date Checks up to 5 Days – This option will permit Escrow users to advance 

date (postdate) checks by up to 5 days. Checks that are post-dated will Post to the ledger (s) (move from 

“in process” to “posted”) with the posting (in Accounting) of the check date(s), not the date of creation. 

Allow Escrow to Enter Reason Funds Held on Open Files – If this option is selected and funds remain 

in the escrow file after the fee check/fee slip is generated, the user will be prompted to enter a reason for 

holding the funds. A version of the Trial Balance can be printed that presents the reasons entered on 

these files. This can make it easy to document why funds are held and to prompt follow-up action on 

those items whose reasons no longer seem valid. It is recommended that a follow-up date be provided in 

the reason field. 

Require File Balance = 0 Prior to Disbursement – If this option is enabled, it will require disbursements 

to completely exhaust the funds in a file each time they are made. Checks and/or wires out must exactly 

total all of the funds receipted in the file at the time of the generation of the disbursement file. This will 

prevent held funds from being an issue, but can raise some difficulties in practice.  
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Enable Dual Authorization on Disbursements – This option is used to enable the control that 

mandates two different users must be involved in the issuance of checks.  Once enabled, when a 

disbursement file is ready for check printing, the user will click the Submit button and the item(s) will be 

put in a status of pending approval.  The checks will not be able to be printed until approved by another 

user.  When enabled, the Approve Disbursements permission is made usable, in Users.  Users must be 

granted permission to approve checks.  They can be restricted as to which other users items they may 

approve.   

Enable Emailing of Authorization Requests – When enabled, this option will trigger an email to 

the email address (may be a distribution list address) assigned to the branch of the file involved 

upon submission of checks for approval.  This speeds communications between users. 

Prompt for Email – When enabled, this option brings up the authorization request email 

so that additional information can be added, instead of automatically sending the email. 

On Buyer Refund Checks use forwarding address if available – This option will have the buyer’s 

forwarding address automatically be used on buyer refund checks, if there has been a forwarding address 

entered for the buyer. 

Keep individual checks in order entered -  This option will let the listing of pending checks, entered via 

the Create and Print Individual Checks disbursement function, stay in the order they were entered; and, 

checks will print in that order.  Without this option enabled, the listing and printing is in alphabetic order. 

Set Disbursement Date on issuance of Fees – This option will result in the Disbursement Date field, 

on the first screen of Initial Questions, being filled with the date of the fee check/fee slip when issued. 

Auto Publish Checks to Doc Management System – This option will only be available for use if a 

document management system is installed (currently functions with smartVIEW).  If enabled, each 

disbursement batch of checks will be published as a single document to the document management 

system. 

Auto Publish Checks to Doc Management System with Copy Watermark – This sub-option 

will place a “COPY” watermark on the pages of the published disbursement batch. 

Prompt for Final Disbursement Report After Printing Checks – This option will prompt users, after 

they print any check(s), as to whether they wish to print the Final Disbursement Report.  Some 

companies have an established practice of printing a Final after each and every check run, and this 

option facilitates that routine. 
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HUD Printing 

These options relate to the generation of the HUD document.  

 

Default HUD size (files without GFE only) –The HUD (for files prepared with the “with no GFE” formats) 

can be printed in either legal-sized or letter-sized format. This option merely selects which format should 

be pre-selected by the system.  

Legal (8 ½ x 14): The legal-sized format will print all standard lines, whether used or not, and all 

extra lines with data on them.  The HUD for files prepared “with GFE” is always a legal-sized 

document.  

Letter (8 ½ x 11): The letter-sized format will only print lines that have buyer and/or seller dollar 

amounts on them. 

Show POC Paid By (Files Without GFE Only) – If the company’s policy is to present the payer (Buyer 

or Seller) of “paid outside closing” (POC) items, then this option should be turned on. The payer will be 

presented in the description field of the POC item along with the amount paid (as “Buyer” or “Seller”).  

This option is only applicable to files prepared with the “with no GFE” formats.  The formatting on files 

prepared via the “with GFE” formats have a fixed style of just presenting “B” for buyer or “S” for seller – as 

there is insufficient room with the new HUD layout to spell out the words. 

Display Initials on HUD (Files Without GFE Only) – The addition of “initial lines” on the bottom of each 

page of the HUD report is controlled by this option.   Some companies want each page of the HUD-C 

initialed by parties to the transaction. This option is only applicable to files prepared with the “with no 

GFE” formats.    

Default HUD Printing to ‘Without Certification’ – The certification page of the HUD is where the parties 

to the transaction certify that they have reviewed the HUD and concur with what it presents – aka the 

signature page. This option determines whether the default setting, when printing the HUD, is for this 

page to print or not. Regardless of this setting, the certification page can be printed, or not, each time the 

HUD is generated. This option just makes the most desired choice the default, thereby speeding up the 

user’s interaction with the system. 

Suppress ‘Printed by’ Line in HUD Footer – The “Printed by” verbiage on the bottom of the HUD and 

Settlement Statement can be disabled or enabled with this option.  It will indicate the user’s name and the 

date & time of the printing of the document. 
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Print Company Name in HUD Box H – Box H, on the HUD page 1, contains the name of the settlement 

agent and the place of settlement (address of the settlement agent). This will be automatically filled with 

the Company Name identified on the XREF > Page 2 screen, if this option is checked. If the majority of 

closings are handled by the company at the company offices, this box will normally be checked. 

Enable HUD/Worksheet Stamp Functionality – This option enables the ability to add an image/stamp, 

to a user’s setup, that will appear on the HUD or Settlement Statement.  The image files should be a 

small (<64K) bitmap (BMP) file.  See the Users section earlier in this manual for image assignment 

details. 

 

CDF Printing 

There is a single option on the CDF Printing screen of Escrow Functions. 

 

Enable Commission Breakdown – This option provides for the generation of a Commission Breakdown, 

on the Attachment, when printing the CDF. 

 

Statement Printing 

There are two options on the Statement Printing screen of Escrow Functions. 

 

When Printing the Exchange Statements use Qualified Intermediary Verbiage – This option will put 

the name(s) of the Accommodator(s) in front of the buyer &/or seller names, with “as Qualified 

Intermediary” between the party names, on Exchange Statements.  This is instead of replacing the buyer 

&/or seller names with the Accommodator’s name(s). 

Enable ALTA Statements – this option will present users with the option of generating ALTA Settlement 

Statements on CDF files. 
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Miscellaneous 

This screen contains an assortment of disparate options relating to Escrow functionality. 

 

Retain Check Stub Information – When turned on, this option will provide for full check stub details to 

be retained and presented on the Final Disbursement report. If the option is not turned on, the Final 

Disbursement report will only print the payee information and the total of the check, but will not present 

the full check breakdown.  This option, if on, makes it easy to review check detail, without having to locate 

the original check stubs in the paper file. 

Show ‘Approved by’ on Preliminary & Final Disbursement Reports – When selected, this option will 

cause an “Approved by:____________” signature line to appear on the Preliminary and Final 

Disbursement reports. 

Payoffs, Default NAF Search to Payoff Lenders – This option will pre-select the Payoff Lenders 

category on the NAF search screen when the user is entering information about payoffs. This simply 

saves a mouse click or two, but does speed up use of the system. This option should only be enabled, 

however, if the business routinely categorizes appropriate NAF entries as Payoff Lenders.  

Enable Escrow Custom Reports – While most custom reports, written in Crystal Reports, are available 

through the MIS module, the company may wish for some to be made available to Escrow users. If so, 

this option should be enabled. Then, while in the Escrow module, users can generate custom reports that 

have been established for them or even develop their own depending on the configuration of the system. 

When turned on, the users will find the reports under Escrow > Reports > Custom Reports.  

Allow Escrow to Generate Trial Balances – One consideration to be evaluated in turning on this option 

is the ready availability of listings of aged files with balances, which are at higher risk for fraudulent 

activity. Escrow users will only be permitted to generate Trial Balance reports for their specific branch. 

The “upside” of this option is that Escrow can use the Trial to work aged files without Accounting having 

to send them reports. 

Do Not Allow Total Amount Withheld to Exceed Loan Amount – When enabled, this option will warn 

the user that an item being flagged to be withheld from lender’s funds (WTH) pushes the total being 

withheld over the available funds, and they will not be permitted to flag the item WTH. 

Auto Send Email When File is Opened and Sent to Title – When enabled, this option will automatically 

send an email to outside parties when the file is opened and when it is sent to title.  The parties must 

have email addresses in the file and, if their email addresses are found in the NAF, the NAF entries must 

have the “Can Receive Auto Emails” checkbox checked.  The Auto Email DSI Messaging component is 

required for this function. 

Auto Send Email When File is Closed – When enabled, this option will automatically send an email to 

outside parties when the file is closed.  The parties must have email addresses in the file and, if their 

email addresses are found in the NAF, the NAF entries must have the “Can Receive Auto Emails” 

checkbox checked.    The Auto Email DSI Messaging component is required for this function.  
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Receipts 

This screen’s options relate to receipting of funds in escrow trust accounts and interest bearing accounts 

(savings). 

 

Allow Additional Deposits Without Receipts – If this option is enabled, then on the Additional 

Buyer/Borrower Deposits screen an Enter Receipt checkbox will be displayed and checking it will 

provide for a receipt to be created for the additional deposit. The user can manually uncheck the 

checkbox in order to enter items into Impact/SQL without creating a receipt.  

Allow Escrow to Do Receipt Corrections Per California DOC Regs – This setting is only applicable to 

companies that fall under the jurisdiction of the California Department of Corporations (DOC); “Escrow 

Only” companies in California. It is USA Digital Solutions, Inc. understanding that the regulatory 

requirement is that if funds are receipted into an escrow file and it is determined at a later date that the 

funds should have been entered into a different file, correcting receipts, with the same receipt number on 

each, are to be entered into the original file (with a negative amount) and into the correct file (with a 

positive amount). This setting automates the procedure by allowing the user to answer a few questions 

(original escrow number, receipt number, and new escrow number) and then the system will automatically 

generate the needed transactions. Both escrows must be on the same bank account and the correction 

cannot cause an overdraft in the original file. If turned on, the menu item Receipt Correction appears 

under the Escrow > Receipts menu. 

Allow Accounting to Do Receipt Corrections Per California DOC Regs – This option is the 

Accounting module equivalent of the Escrow option discussed immediately above.  If turned on, the menu 

item Receipt Correction appears under the Accounting > Receipts menu. 

Allow Escrow to Do Receipt Transfers – If this option is enabled, a Transfer Funds menu item is 

provided on the Escrow > Receipts menu. This option makes it easier to transfer funds between escrow 

files that share the same bank. Rather than the users having to enter two receipts, they must simply 

identify the two file numbers and the amount to be moved. The system will generate the receipts. 

Allow Accounting to Do Receipt Transfers – If this option is enabled, it will provide a menu item, 

Transfer Funds, on the Accounting > Receipts menu. This option is identical to the Escrow option 

discussed immediately above. 

Allow Escrow to Do Savings Transfers – The ability to transfer funds to/from Savings accounts in one 

step (as opposed to the SAV and STF receipt pairs historically entered) has been introduced with version 

7.0, and this option extends that ability to Escrow users.  The transfer function is on the Escrow > 

Receipts menu, labeled Transfer Savings, if this option is enabled. 



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 86 of 183 

Allow Accounting to Do Savings Transfers – This option is identical to the Escrow option discussed 

immediately above.  The transfer function is on the Accounting > Receipts menu, labeled Transfer 

Savings, if this option is enabled. 

Email EO on Receipt of NSF – After Accounting personnel enter a receipt for an NSF item, when this 

option is enabled, an email will be sent to the escrow officer whose user initials are linked to the file. The 

email will let the escrow officer know that the item deposited was returned by the bank. This can improve 

the communication between Accounting and Escrow regarding NSF items. As with the emailing of notices 

from Title to Escrow, this option requires that the email addresses for escrow officers be properly 

maintained in the Users table. The NSF receipt type must be used to trigger this behavior.  

Allow Escrow to Delete Receipts – Errors can be made during receipt entry. The issue is whether the 

company wishes all receipts to be retained in order to provide an audit trail of all activity, with sequential 

receipt numbering, or permit a receipt to be deleted by Escrow users prior to posting. The alternative to 

deleting a receipt completely is for the user to zero out the amount of the receipt, but leave the numbered 

receipt in place. Turning this option off will deny Escrow users the ability to delete a receipt. They can 

only zero it out prior to posting. The system will check that the file involved will not be overdrawn by the 

change in amount and the user may be prompted for an overdraft-authorizing password before 

proceeding. If the option is turned on, a requested deletion that will cause an overdraft will have the same 

effect. It is not recommended that this option be turned on. 

 

Receivables 

 

Show Pending Receipts/Receivables on Disbursement Entry – for states that do table funding, this 

option will show the escrow user the amount that should be receipted into the file to cover the 

disbursements currently set up.  

Show Mortgage Broker Receivables and Disbursements – This option is only available if the 

Show Pending Receipts/Receivables on Disbursement Entry is checked. The system will 

calculate the Mortgage broker’s check by deducting any items marked as POC by the broker. If 

the Mortgage broker’s check is insufficient to cover the POC by the broker items, then a 

receivables item is shown for the difference. 
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CDF Defaults 

There is a single option on the CDF Defaults screen of Escrow Functions. 

 

On CDF files when Withhold from Loan is selected default the payee to the lender – when enabled, 

this option will do exactly as its label indicates, if the Payee field is blank.  An existing Payee will not be 

overridden. 

Title Functions 

Data Entry 

 

Subset of Initial Questions Which Title is Allowed to Update – The Company must determine whether 

Title users should be permitted to edit all information in the Escrow Initial Questions menu set or a 

limited set of data.  The drop-down list options are: 

Select None if Title users are not to be permitted to edit any data entered by Escrow, in Initial 

Questions, with the exception of the Full Legal Description. 

Select Partial to allow only Property Information, Buyer/Seller Names/Addresses, and the Prelim 

Distribution List (if enabled) to be edited. 

Select All if Title is permitted to edit all screens of Initial Questions, in addition to the Full Legal. 

Click  for additional information about this field’s options. 

Allow Title to Update Title Charges (HUD 1100) – This option will only be available if the All or Partial 

option above is selected. It will permit Title users to edit the data entered on the title charges line(s) of the 

HUD 1100 section of Residential fiels, and Title Charges on Commercial files. The company must decide 

if this will do more good than harm, as it will permit Title to alter the balances on the HUD. Good 

communication between Title and Escrow personnel would be a necessity if this option were enabled. 

Click  for additional information about this field’s options. 

Enable Direct Orders – The ability to work with the file type Direct Orders is controlled by this option.  If 

unchecked, no Direct Orders will be able to be created (and no existing Direct Orders will be accessible); 

it is a complete disabling of Direct Orders, if unchecked.  Direct Orders are fully explained in the Title 

manual. 

Enable Misc. Data Entry for Direct Orders – A custom data entry screen for Direct Orders, 

which can be utilized in Title, can be created through the Utilities module. The company can 

identify data fields they wish to collect information in through this utility. If enabled, this screen is 

available from the Edit > Opening Info menu for a Direct Order file.   
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Policy 

These options relate specifically to policy production. 

 

Default Approved Date (Submission Date) to Date Policy Typed – When this option is enabled, it will 

default fill the Approved Date field on the Policy Entry screen to the current day as the policy is being 

typed. This will help ensure that the Approved Date is filled, which is important, as this is the field that is 

used to determine if a policy will appear on the Underwriter Remittance (Submission) report. The auto-

entered date can be changed. Care needs to be taken when changing the date to make sure the date is 

not moved back earlier than the date for which remittance reports have already been run or the policy will 

never be reported to the underwriter. If the field is blank, the policy will appear on the Policy Exception 

Report. 

Enable Endorsement Tracking (for Inclusion in Submission Reporting) – This option provides a sub-

screen on the Policy Entry screen for endorsement information to be entered in conjunction with policy 

preparation. Endorsements entered here will be made part of the Underwriter’s Remittance (Submission) 

Report. Generally, this option would be selected.  Endorsements prepared from the separate 

Endorsement Menu are not available for inclusion in remittance (submission) reporting. 
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Prelim 

These options relate specifically to the production routine for the preliminary report or commitment – 

called “Prelim” in Impact/SQL. 

 

Send Email Notification(s) On Release of Prelim – If this option is enabled, email notifications are sent 

when the prelim is released by Title.  The sub-options specify who should be notified by email.  

Email Escrow Officer on Release of Prelim – Select this option to indicate “Yes”. 

Email Processor on Release of Prelim – Select this option to indicate “Yes”. 

NOTE: The e-mail addresses for EO and Processor are pulled from the User file, so the data 

there must be kept up-to-date.   

Prompt for Additional Email Addresses on Release of Prelim – When this option is enabled, 

the notice of the release of the prelim can be emailed to multiple parties instead of just the 

processor and escrow officer. Once enabled, the user will be prompted as to whether others 

should be notified and if the response is positive, the email screen will be presented for more 

addresses to be added by the user.   

Auto Send Email to Outside Parties on Release of Prelim – When this option is enabled, the 

notice of the release of the prelim is automatically emailed to outside parties that are listed in the 

Prelim Distribution Via table to receive at least one copy of the prelim, with a “Via” method of 

“Email”, and who have email addresses.  A PDF of the prelim is attached to the email.  The Auto 

Email DSI Messaging component is required for this function. 

Prompt for Release of Prelim After Edit – If this option is enabled, the prelim typist, upon exiting the 

editing of a prelim, will be presented a dialog box asking if the prelim should be released to Escrow.  If 

this prompting is not enabled, the typist must remember to manually release the prelim to Escrow upon 

completion. 

Auto Publish Prelim When Released – If this option is enabled, the notice of the release of the prelim is 

automatically published to a third-party vendor, if the database is configured for a Document Management 

system. 

Require Re-release of Prelim/Commitment upon amendment – This option is used to require Title to 

re-release the prelim or commitment after amending it.  The prior Release Date will be cleared when an 

amended order is submitted to Title. 

For CDF files show full loan and simultaneous rate on Prelim/Commitment in Title Charges – This 

option is used to present both the full and simultaneous loan policy rates under the Title Charges section, 

on a prelim/commitment configured to reflect Title Charges, on CDF files. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 90 of 183 

Sub Escrow 

 

Enable Sub-Escrow – This functionality was created for use primarily in the Southern California market. 

Within the Escrow module, a set of menu options dedicated to “sub-escrow” behavior was created that 

consolidated existing functions together for ease of use by the “sub-escrow” user. A special user-level 

access of Sub-Escrow was created and only those users will see the sub-escrow functionality.  If the next 

option is not enabled, the original sub-escrow functionality will be in place.   

Charges Not Shared with Escrow – When enabled, this option will introduce a new set of Sub Escrow 

programming (these changes were initially described in separate Impact/SQL version 7.7 documentation 

which should be reviewed prior to setting these options).  Both the Title and Escrow modules will reflect 

altered sub-escrow changes if this functionality is turned on.  In the Title module, screens have been 

made available on a three-tab window for the Title Officer to enter Title, Recording, and Additional 

charges. 

Allow – Click on the  Info icon on the screen for additional information about this field. Select one of 

the following options from the drop-down list to set the access level for Sub Escrow and Title users:  

Shared – both Title and Sub-Escrow users can edit the same charges 

Title – only Title can enter charges; Sub-Escrow can view but not edit charges 

Separate – Title and Sub-Escrow users can edit charges, but cannot edit each other’s entries 

Title Status Default Notification Options – Use this option to select the Title charge status default email 

notifications.  

Select Send Email, and then select additional options for the email: 

Add EO and Processor to Recipients: Adds the Escrow Officer and Processor to the email 

recipients. 

Attach Billing Statement: Attaches the Billing Statement to the email. 

Attach Sub Escrow Instructions: Attaches the Sub Escrow Instructions to the email. 

Allow :E – This option will allow for the use of the “:E” payee shortcut for Escrow charges, entered by 

Escrow personnel, to distinguish them from the “:T” payee shortcut used on Title charges, entered by the 

sub-escrow group, in a situation where the sub-escrow functionality was in use. Both “:E” and “:T” entries 

will end up on the same fee slip/check.  “:E” is just a substitute for “:T” in this situation to distinguish who 

entered which charges. 
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Order Desk 

The Order Desk screen is used to fine tune the configuration of the Order Desk module. 

 

Enable Publish File in Order Desk Upon Acceptance – This option enables the automatic publishing of 

the file to a third-party file management system (such as smartVIEW) upon Order Desk acceptance 

(creation of the file).  An  Info icon will present next to this option, if no file management Messaging 

component is located on the system, and clicking on it will present a message saying just that. 

Prompt for Email, Publish and Print – This option will substitute the routine prompt about printing the 

Title Instructions, received after submitting the order to Title, with a prompt asking the user whether they 

wish to Email &/or Print &/or Publish the Title Instructions.  The user may select any or all of the options.  

The three sub-options below, if checked, will pre-select the identified action on the prompt screen. 

Default Prompt to Email 

Default Prompt to Print 

Default Prompt to Publish 

Use Escrow Company Party Type – This option will put the data that is entered into the main Order 

Desk entry screen, for the Escrow Company, into a party designated as “Escrow Company” rather than 

into “Other Party #1” (which was the original behavior).  If this option is to be enabled, a review of 

document masters that might be using “Other Party #1” information to identify the outside escrow 

company (possibly the prelim/commitment masters) must be done and affected document masters would 

need to be updated.  That effort (doc maintenance) will need to be coordinated with the option setting 

change.  If there are files that were started before the option was changed, that do not yet have the 

affected documents prepared from the old setting, the users will need to copy the “Other Party #1” party 

information to the “Escrow Company” party, then prepare the newly-formatted document(s). 

Default Source of Business to: - This option lets a default party be set as the Source of Business on the 

Order Desk screen.  The options are Other, Escrow Company, one of the Brokers or one of the Lenders. 

Default Bill to Customer to: - This option lets a default party be set as the Bill to Customer on the Order 

Desk screen.  The options are the Source of Business (defined above) or the same alternatives 

discussed above. 

Suppress duplicate warning on closed and cancelled files. – This option will restrict the testing of 

existing files for duplicate Address 1 or APN values being entered on a new Order Desk file to files that 

have an Open status; Closed and Cancelled files will not be looked at in the testing for duplicates. 

When opening a residential file set the entry type to: - This option is used to set the default entry type 

on a new file opened via the Order Desk.  Options are None, HUD, HUD w/ GFE, Worksheet, Worksheet 

w/ GFE, and CDF (Closing Disclosure Form).  
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Word Functions 

This option screen deals entirely with the MS Word integration with Impact/SQL.  The descriptions of 

these options, presented below, are not a substitute for Document Administration training, available from 

USA Digital Solutions, Inc.   

 

There are no sub-sections to this group of options.  

Clear Headers on All Exhibits – Whenever Impact/SQL creates an Exhibit in a document, this option 

controls whether the header from the previous section in the document will be copied into the new section 

created for the exhibited text. If this option is enabled, then the exhibited text will have a blank header. If 

this option is not enabled, then the exhibited text will use the same header as the previous section.  

Enabling this option is recommended by USA Digital Solutions, Inc. 

Clear Footers on All Exhibits – Whenever Impact/SQL creates an Exhibit in a document, this option 

controls whether the footer from the previous section in the document will be copied into the new section 

created for the exhibited text. When this option is enabled, the exhibited text will have a blank footer. 

When it is not enabled, the exhibited text will use the same footer as the previous section.  Enabling this 

option is recommended by USA Digital Solutions, Inc. 

Paragraph Format Legal Descriptions – Legal descriptions (the Full Legal, contained in a special MS 

Word document, not to be confused with the Brief Legal, available in a DDE field) are typically included in 

a document through the use of the INCLUDETEXT field. This is an active link to another MS Word 

document, which could have its own paragraph and character formatting. This option determines whether 

the linked text will keep its own formatting when placed into the User document or will it be reformatted to 

match the rest of the document. When this option is enabled, the legal description will be reformatted to 

match the main document. If it is not enabled, the legal description will keep its own formatting. 
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Only Update Fields in the Main Story, First Header and First Footer – When Impact/SQL opens a 

document, it updates all the fields linked to the database with the current information in the database. The 

Impact/SQL user may experience a delay while this processing occurs. This option controls the time 

spent updating these fields when the document is opened by skipping the fields contained in headers and 

footers outside of page one. If you use bookmarks and REF fields for information in these 

headers/footers, this option should be turned on. When this option is enabled, headers and footers 

outside of page one will not be updated when the document is opened. When this option is not enabled, 

all fields regardless of their location will be updated when the document is opened. 

Leave Prelim Open As XXX.Doc when Editing Policies – Impact/SQL opens the Prelim document 

when it is creating policies in order to copy information from the Prelim to the policy(ies). When this 

process is finished, Impact/SQL normally closes the Prelim and the Impact/SQL user is presented with a 

list of policy documents to edit. This option controls whether Impact/SQL will leave the prelim document 

open as “XXX.doc” - a read-only document. The Impact/SQL user can then switch back and forth 

between the policies and the Prelim on their own. When this option is enabled, the prelim is left open as 

“XXX.doc”. When this option is not enabled, the prelim is closed after the polices have been created. 

Only Remove Fill-Ins from the Main Story, Not From Headers and Footers – Impact/SQL searches 

the document before printing or emailing and changes all unfilled Fill-Ins to hidden text. This means they 

will not show up on the printed page or in the emailed version of the document but can be brought back 

when the document is edited again. This option is similar to the Only Update Fields in The Main Story, 

First Header and First Footer option (above). Since it is very rare to find a Fill-In field in a header or a 

footer, this option could be enabled to speed up processing of the documents. When this option is 

enabled, only unused Fill-Ins in the main body of the document will be hidden during the printing or e-

mailing processing. When this option is not enabled, all unused Fill-Ins in the document will be hidden 

during the printing or e-mailing processing. 

Special Policy Clause Processing (12 Points Before Old Style Clauses) – This option will only effect 

Policy documents. When clauses are inserted into the document, Impact/SQL can make sure there is one 

blank line before the clause. The first paragraph of the clause will be reformatted to include a 12 point line 

before the paragraph begins. This guarantees there will be a blank link before each clause inserted into 

the document. When this option is enabled, each clause inserted into the Policy will have a blank line 

before the clause begins. When this option is not enabled, there will be no blank lines inserted between 

clauses. 

Force Legal Description Boldness to 100% (as in Doc’s Legal Description Table) – Impact/SQL can 

change the legal description’s formatting when it is inserted into the document. This option determines 

whether the Bold attribute should be changed to match the Master.  

If the legal description is within a table, Impact/SQL will look at how the table itself is formatted. If the 

legal description is not in a table, it will look at the paragraph formatting. If the table or paragraph is 

bolded, the legal description will be bolded when this option is enabled. The Bold attribute for the text in 

the legal description will be changed to match the formatting applied to the table or paragraph containing 

the INCLUDETEXT field in the Master. If this option is not enabled, the bolding will be untouched. Only 

the text that was initially bolded in the legal description will be bolded. The Bold attribute for the text in the 

legal description will not be changed from how it appears outside of the Master. 
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Bookmark Styles Before Starting Prelims (for MSWord 95 Prelims) – This option will affect only 

Prelims. Impact/SQL will search through the Prelim and place bookmarks around any text formatting with 

the following character “styles”: 

Exceptions 

Requirements 

Notes 

Restrictions 

InsA, B, C, D 

FeeType 

Vested  

If this option is enabled, then the formatted text will have bookmarks applied. If this option is not enabled, 

no bookmarks will be automatically inserted 

Enable DDE’s in Legal Descriptions – Impact/SQL will allow you to place DDE fields from a certain 

subset into your legal descriptions. These fields will be preserved when the legal description is then 

transferred into a User document. Be aware that only a subset of DDE fields work in the legal description 

so you need to be careful when you copy and paste text from other documents. If this option is enabled, 

any legal description DDE fields will be preserved when the text is copied into a document. If this option is 

not enabled, all DDE fields in the legal description are ignored by Impact/SQL.  Enabling this option is 

recommended by USA Digital Solutions, Inc. 

Add Fill-In After Exceptions Bookmark –  In the Prelim/Commitment master documents, the 

Exceptions bookmark contains the Fill-In field [=clause=]. This Fill-In opens the Insert Clause dialog box 

and makes it easy for the Impact/SQL user to add Exceptions to the document.  When they have finished 

selecting clauses, the Fill-In field is automatically removed and the clauses are inserted within the 

Exceptions bookmark. When the policy is created, all text within the Exceptions bookmark is copied from 

the Prelim into the Exceptions area in the policy. 

If the Add Blank Hot Stop sub-option is selected, Impact/SQL will automatically add a regular 

Fill-In field, [°°°°°], to the end of the Exceptions bookmark. This allows the Impact/SQL user to 

easily locate the position where additional clauses could be entered directly into the policy. 

If the Add “=Clause=” Hot Stop sub-option is selected, Impact/SQL will insert the [=clause=] 

Fill-In instead of the normal [°°°°°] Fill-In. 

Do Not Re-Bookmark Styles During CopyBase Functions – It is recommended that this option be 

enabled.  The option prevents Impact/SQL from re-bookmarking all areas of the Prelim document based 

on applied character styles.  Under normal operations, when the Prelim is used as a base document for 

the CopyBase function, the default bookmarks, such as Requirements and Exceptions, are removed from 

the original file and redefined based on the current character style.  In other words, all text that has the 

Exceptions characters style will be within the Exceptions bookmark.  Allowing the DOT to bookmark text 

automatically in this manner has resulted in too many errors.  This is because the Impact/SQL user will 

copy text from one location in a document to another not realizing they are also copying the character 

style.  If the Exception character style exists in several separate locations in the document, the DOT will 

automatically include all the instances within one Exceptions bookmark.  This caused unexpected results.  

With this option enabled, the existing bookmarks in a Prelim will be left alone if the document becomes 

the base document for a CopyBase function. 

Do Not Pull Exceptions From the Prelim/Commitment When Creating a Policy – This option allows 

the system to be configured to automatically include or exclude the Exceptions, from the 

prelim/commitment, into a policy. 
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Allow Emailing Of 3 or More Docs at Once – This option is not used by the system in versions from 7.8 

and beyond. 

Do Not Use Prelim Exceptions Style in Policies – This option prevents the Exceptions character style 

in a policy document from being automatically changed to match what the current settings are for the 

Exceptions style in the Prelim.  For example, if the Prelim Exceptions character style is defined as Arial 10 

and the Policy Exceptions character style is defined as Tahoma 12, the enabling of this option will make 

sure the Exceptions in the Policy are Tahoma 12. 

Allow Multiple Documents to Print at Once – Under certain circumstances, a setting of “Yes” for 

Background Printing in MS Word (Options -> Print tab) may contribute to automation errors when 

printing from a list of documents.  This option allows the Impact/SQL user to keep Background Printing 

set to “Yes”. 

Copy Fee Type Wording From Prelim to Policies – This option prevents the program from deleting all 

text inside the ‘FeeType’ bookmark except for the words Fee Simple when it is copied from the Prelim to 

the Policy.  This option should be enabled. 

Do Not Display Tooltips – Some Citrix environments have, historically, had a problem with MS Word 

reverting to the background and documents printing with the Fill-in brackets still in place     (“[  ]”).  It was 

determined that if Tooltips were disabled, the issue went away.  This option should only be turned on if 

such behavior is being experienced. 

Run Hide Brackets Twice when Saving – This option was introduced to counter a condition in some 

environments that result in the square brackets (“[ ]”) for Fill-In fields being printed on the document.  

Under normal operations, they should have been marked as hidden text.  This switch will cause the 

routine to run a second time before documents are printed.  This option should only be enabled if the 

brackets are appearing. 

Keep Documents in 2003 Format – This option is used to retain the “DOC” extension on all user docs, 

as opposed to reverting to the “DOCX” extension used by Word 2007 & 2010.  For sites that are 

transitioning from Office 2003 to 2010, this option should be enabled.  Only after all users are using Word 

2010, and will not be using 2003 again, should the option be disabled. 

Use Alternate Search Routine for Saving Docs – This option is for client sites running MS Word 2002 

or higher.  The behavior of MS Word, when saving prior to printing of a document, changed with Word 

2002, so this option was developed to accommodate the change.  The DOT’s use a ReplaceAll routine to 

hide the square brackets associated with Fill-In fields when the document is printed. If there is more than 

one document open when this routine is run, MS Word tends to lose track of which document is the active 

document. 

Enable Documents by State – If a company operates in several states and is using a common SQL 

database for those operations, Impact/SQL can customize the Escrow menu for master documents with 

documents unique to each state. This is driven by the state identified on each property in the file being 

worked. This option should not be turned on and off as that can cause major problems with the Escrow 

document menu. 

Fix Missing Extension in INCLUDETEXT –  Word 2010 does not support an INCLUDETEXT statement 

where a file name does not include an extension (Word 2003 did), and this option addresses that issue.  It 

should be enabled if the problem is being experienced. 
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Email Functions 

This group of options deals with the email integration within Impact/SQL.  There are no sub-sections to 

this group of options. 

 

Add The Following Text to All Emails Sent Through Impact – This option provides for the addition of a 

Privacy Notice, or other message, to all email sent out of Impact/SQL.  The message to be added should 

be entered into the space provided. 

Display MSWord Document Password On Screen When Emailing MSWord Document – When email 

attachments are prepared in MS Word format, rather than PDF, they are most often password protected, 

so the recipient cannot change the document without the password.  This option will present the 

password to the user, so that they can know it and provide it to the recipient if they wish the recipient to 

be able to modify the document being emailed.  If this is done, understand that the default password will 

become common knowledge in short order. 

Prefer PDF Attachments on Email, if Available – This option will default the option of what format an 

email attachment should take to PDF, but will make available to the user the option to select the MS Word 

format, alternatively, at the time of the preparation of the email attachment.  A separate PDF “printer” is 

no longer required for this functionality; the capability is part of Impact/SQL. 

Require Email Attachments to be PDF –  If this option is enabled, then all email attachments are forced 

to be in PDF form, protecting them from being edited.  A separate PDF “printer” is no longer required for 

this functionality; the capability is part of Impact/SQL. 
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Allow User Control of Email Preferences – This option permits the user to see and change the email 

password (if they are sending an MS Word formatted attachment), and permits the user to select the 

format to be used (MS Word or PDF), if the Prefer PDF Attachments on Email, if Available option 

(above) is also selected.  In Escrow, a screen like the one shown below is presented for the user’s 

interaction when they request to email documents.  In this sample, both MS Word and PDF attachments 

are available, and the user is permitted to see and change the MS Word password on the attachment; in 

addition, parties to the file can be selected as recipients of the email with its attachment. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Default MSWord Document Password – If the site is going to email attachments in MS Word format, 

the default password to be used to protect the attachments is entered into this field. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 98 of 183 

CRRAR Functions 

CRRAR is a propriety accounting data transfer routine, utilized exclusively by Fidelity National Financial 

subsidiaries.  Configuration of these settings can only be done if the Enable FNF Standards flag has been 

set on the database, by USA Digital Solutions, Inc. personnel.  Non-FNF clients should ignore these 

options. 

 

Enable CRRAR Interface – This option indicates that the CRRAR interface is to be utilized.   

The URL for the interface to send data through should be entered in the field provided.  This information 

will be provided by FNF Accounting. 

Allow Escrow to Choose Fee Check/Transfer or Invoice – This option will give the Escrow user a 

facility, on the first screen on Initial Questions, to identify whether they intend to report revenue via a fee 

check or invoice.  The system will then only permit the selected action to be taken.  Up to the point that 

either a fee check or invoice is issued, the user can alter their selection.  If this option is enabled, the 

Default Fee Type field will activate and let you select the Default Fee Type (Invoice or Fee Check).   

Enable Dual Send (Fee Check/Transfer and Invoice on Same File) – When this option is enabled, the 

Allow Escrow to Choose option (immediately above) is precluded from being selected.  As it states, the 

option will allow both fee check and invoice data to be generated on the same file and have that data 

transfer via CRRAR. 

If neither Allow Escrow to Choose or Enable Dual Send is selected, the first action done by the user 

(Fee check or invoice) is accepted and the file is locked to that format.  Either option will be permitted 

(unlike with the Allow Escrow to Choose option) until one is utilized. 

On Submission of an Invoice Prompt to Close File – This option automatically sends a prompt to close 

the file on submission of an invoice, instead of the user manually closing the file. 
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Output Log File for Data Sent to CRRAR – This option identifies that there will be a CRRAR data log 

file created. 

Output Log File Directory – This field is used to identify the output directory for the log file. 

Send Source of Business to CRRAR – This option controls whether information on the Source of 

Business is sent to CRRAR or not. 

Disbursements; Display Warning if Source of Business is Not Valid – This sub-option will 

enable the validation of the SOB information vs. the NAF. 

Title and Escrow Fees are to be Reported to Different UTC Operation Codes – This option provides 

for separate revenue flows for Title and Escrow fees, for Southern California operations that follow that 

reporting pattern.  The categorization of Income Codes is key to this functionality. 

Cash Push Op Code – The appropriate value must be entered here. 

Cash Push Bank Number – The appropriate value must be entered here. 

Allow Receipt Modification for Current Day Only – The FNF Standards, by default, do not permit 

receipt modifications.  This option overrides that default. 

Allow Voiding of Deposit Ticket in Closed Month – The FNF Standards, by default, do not permit 

voiding of Deposit Tickets in closed months.  This option overrides that default. 
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License Manager  

The primary activity in the License Manager is managing user licenses for Impact/SQL.  Administrators 

with Utilities access can open the License Manager using Utilities > System Files > License Manager.  

The License Manager screen shows the currently licensed products on the site.  Some product licenses 

are managed “by user” counts and others “by site”. 

 

Automated routines are integrated into the License Manager. New licenses are registered and activated 

by communicating with a licensing server at USA Digital Solutions, Inc.  In addition, product licenses 

(applications and integration services) are managed via the License Manager.  Unused user licenses are 

automatically freed up, upon an extended period of inactivity, and are made available to new users.  

Access to the Internet from the client network is required. 

Activate a Product License 

If a new product is installed, it must be “Activated”.  An e-mail notification could be sent to the Product 

License contact on record at USA Digital Solutions, Inc. for the database, with the Activation Key in it.  

Click  on the License Manager screen to open the Activations screen, highlight the product to 

be activated and enter the Activation Key to complete the process. 

NOTE: Normally, new product activation would be managed by USA Digital Solutions, Inc. 

personnel. 

Print a Report of Licenses 

Click  at the top of the screen to print a report of all licenses. 

Export Data to USA Digital Solutions, Inc. 

Click  to export product license data to USA Digital Solutions, Inc. A message displays 

when the data has been successfully sent to USA Digital Solutions, Inc. 

NOTE: Use the Export Data to USA Digital Solutions, Inc. function only if requested by Support at 

USA Digital Solutions, Inc. 
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View/Modify License Details 

To view or change user license detail of a product, click  Details in the selected Product’s row. The 

License Detail screen is displayed, with a listing of all registered users for the product.  

NOTE: Only products with a License Method of User have the  Details icon.  

 

The Days From Login column reflects the number of days since the user’s last login.  If a user name is 

tagged as Temporary, the license has been activated, but not yet reported to USA Digital Solutions, Inc.  

Non-billable users’ accounts will be highlighted in yellow; only DSI can control billability of users. 

You can search for a particular user using the Filter at the top of the screen. Enter part or all letters of 

user’s name in the box. The records that match entered information display in the list. Click  to clear 

the filter. 

The toolbar at the top of the License Detail screen provides the following options: 

 

 

 

 

 

Print 

Select one or more users for whom you want to print the User Details report, and then click  at the 

top of the screen.   
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Unregister Selected 

If an employee no longer needs access to Impact/SQL (from termination, for example) their license 

should be “unregistered” in the License Manager, so it will be immediately available for a new user to pick 

up. 

Check the box in front of the user and click  at the top of the screen to unregister a user’s 

license, freeing it up for another user.   Click Yes when the prompt displays. This will free up their license 

immediately for use by another. 

 

Purchase 

Click  at the top of the screen to purchase additional licenses.  The system will check on the 

total number of licenses purchased, and the number that are registered to users. This option is only used 

to manually purchase licenses.  Most sites will be set to AutoRegister users (see license options below).   

 

Click Yes to display the Purchase Licenses dialog box. 

 

Enter the number to be purchased and click OK.  The licenses will be made available, and USA Digital 

Solutions, Inc. will automatically receive notice that new licenses have been acquired and are billable.  

Should any of the newly-acquired licenses be considered non-billable by the client, for whatever reason, 

USA Digital Solutions, Inc. must be contacted with that information, and USA Digital Solutions, Inc. will 

adjust our records appropriately.   



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 103 of 183 

License Options 

Click  at the top of the screen to display the License Options dialog box. 

 

From the License Options dialog box, select one of the following: 

The AutoRegister license option will provide for the system to automatically purchase individual 

licenses when a user logs in, if there are no unused licenses available to be assigned.  This 

option is the most automated but does require the system administrator to be on top of 

terminations and prompt new hiring, as the system will not auto-unregister inactive licenses for a 

lengthy period (over 120 days) from the date of last use.   

The AutoPurchase license option will permit authorized personnel at each site to purchase one 

or more licenses without calling USA Digital Solutions, Inc.  This forces some manual intervention 

so that in the event the un-registration process is not kept current, licenses will not be ordered 

when they are not needed. 

The Manual license option is similar to that in place in earlier releases.  The administrator will 

initiate the addition of licenses and will call USA Digital Solutions, Inc. for a license authorization 

key. 
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Edit Workgroups 

Click  at the top of the screen to display the Edit Workgroup screen to create workgroup 

assignments.  

 

Workgroups are handy for grouping users into various categories (Admin, Accounting, Escrow, Title, etc.).   

You can search for a particular user using the Filter at the top of the screen. Enter part or all letters of 

user’s name in the box. The records that match entered information display in the list. Click  to clear 

the filter. 

To assign a workgroup, check the user(s) for the workgroup, enter a workgroup name in the field at the 

bottom of the screen, and then click Apply. 
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Messaging Manager 

The Message Manager is only applicable to sites with integrations installed that utilize the USA Digital 

Solutions, Inc. Messaging service.  Configuration of these components is normally only done by DSI 

personnel.  Changes can have significant impacts on the user experience and should only be 

made by trained personnel. 

 

The Status column on the Messaging Manager screen indicates if a component is active or not.  The  

Active icon indicates a component is active.  The  Inactive icon indicates a component is inactive.  

Add a New Component 

To add a new component to the Messaging Manager, click  at the top of the screen.  The 

applicable DLL must then be located, via the browser and selected.  The dialog box that displays, once 

the component is selected, is specific to the type of component that you are adding. Complete the fields 

on the dialog box, and then click OK to add the component to the Messaging Manager. 

Modify an Existing Component 

To view or change the settings for an existing component, highlight the component on the screen you 

wish to modify, and then click  Modify to the right of the selected component. The dialog box that 

displays will be specific to the component selected. Modify the settings, as needed. Click OK to save your 

changes or click Cancel to exit without saving. 

Delete a Component 

To delete the component highlighted on the Messaging Manager screen, click  Delete to the right of 

the selected component. The component is deleted from the system.  
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User Tables 

There are many lookup tables and drop-down lists that appear throughout Impact/SQL. The values that 

appear on most of those lists are entered and maintained from the User Tables menu. The contents of 

these tables, if carefully considered in advance of their entry, and if carefully maintained as business 

conditions warrant, can make the users of the system much more efficient and reporting out of the system 

can be extremely valuable in decision-making situations. The initial loading of data into these tables will 

generally be made by USA Digital Solutions, Inc. personnel, in conjunction with the Company’s 

representatives. Company representatives must be involved, as only they know the company’s mode of 

operation and unique naming conventions and product offerings.   

The User Tables menu routinely has twenty-four items on it: 

NOTE: A Print Taxes menu entry, with sub-categories of Excise Tax and Sales Tax, will appear on 

the menu if the Enable Washington State Requirements is turned on (not shown here). 

Marketing Reps 

External Title Officers 

Hold Title As 

Transaction Types 

Rate Charts 

Title Rates Descriptions 

Property Descriptions ► 

Recording Fees 

Receipt Types 

Income Codes 

Invoice Descriptions 

Auto Ticklers 

Dynamic Data Fields 

Tracking Descriptions ► 

Closing Statement Categories ► 

Settlement Statement Headers 

Prelim Distribution VIA 

Mandatory Fields 

Check Templates 

Payoff Descriptions 

Disbursement Hold Reasons 

User Defaults 

Party Types 

Contact Roles 

FNF Flash Codes (conditional) 

Custom Lookups ► 
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Standard User Table Maintenance Screens 

Many of the maintenance screens for user tables are similar in form and have common screen tools, so 

this section will provide an explanation of the common functionality available in all user tables. In the 

sections that follow, only the differences of the individual tables will be detailed. 

The standard User Table maintenance screen has a listing of existing entries in the body of the screen 

and icons at the top of the screen, and icons on each record, which are used to initiate actions.  When a 

Code field exists, unique codes are required.  

 

The standard icons and their functions are described below. 

New Record – Click  to add a new entry to the table. A data entry dialog box, like the 

one shown below, displays.  When the cursor is in a field, the field background will be white, and 

all required fields (if you are not in one) will have a green background, as shown in this example. 

 

Complete the fields on the dialog box, as needed. Click OK to save your entry, or if you change 

your mind, click Cancel to close the data entry screen without saving your entry. 

Print – To generate a formatted report of the codes and entries associated with them, click 

. It is recommended that the person responsible for maintaining the user tables keep a 

copy of the current contents of each table handy for reference. All of the tables’ contents should 

be routinely reviewed for accuracy and relevance. 
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Move Up & Move Down – The order of presentation of the table on this screen is the same that 

will be seen in the list box displayed for the user in the Escrow module. If you have a preferred 

order of display, you can highlight an entry and then click  or  to reposition it 

in the table. The order of initial entry is not important as the list can be re-arranged with these 

buttons. As an alphabetical sort is not always the way companies wish to see such data 

presented, this approach has been selected to provide the most flexibility for the users. It is 

recommended that the most frequently used selection(s) be placed at the top of the list to speed 

up the user involvement with the drop-down list.  When entries are being added to the tables, the 

user will often be prompted as to whether they wish to enter the new item before the currently 

selected record…so, if the effort is made during data entry, re-organizing with the Move Up and 

Move Down icons can be minimized. 

Active column – The  Active icon indicates an entry is active, and the  Inactive icon 

indicates an entry is inactive.  

Modify – To modify an existing entry, from the main listing, click  Modify to the right of the 

selected record. The data entry dialog box is displayed. Modify the data, as needed. Alternatively, 

you can double-click the entry to edit the data. 

Delete – If you wish to delete an entry from the table, click  Delete to the right of the specific 

record to be deleted.  

Cancel – To close the user table maintenance screen without saving changes that have been 

made, click Cancel in the lower-right corner of the screen. 

OK – To save your changes and close the maintenance screen, click OK in the lower-right corner 

of the screen. 
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Marketing Reps 

The marketing representative listing is maintained in this table. The marketing representatives listing is 

utilized in list boxes on the Initial Questions data entry area of the Escrow module. As was noted above, 

in the System Files > Setup Options > Escrow Functions > Data Entry, the base number of marketing 

reps per file accommodated by the system is two, but that can be increased to four per file by enabling 

the option, Enable Marketing Reps #3 and #4 in Initial Questions. 

 

Each marketing representative is assigned a two- or three-digit code, with 10 being the lowest permitted. 

There must be an item coded 00 with the description None in the table and is now a default in this table. 

And, the description of None, on Marketing Rep 00, cannot be changed. The codes are used internally by 

Impact/SQL rather than storing the full name on each file. Therefore, changing the names on existing 

marketing rep numbers will invalidate historic reporting. It is recommended that if a marketing rep leaves, 

their code and name combination be marked as Inactive and be left intact for a sufficient period so that 

any reporting done by marketing reps is completed and will not need to be re-generated.  A marketing rep 

entry that is marked Inactive will then not appear to be able to be assigned to new files.   

Click  to add a new entry to the table; or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Marketing Reps dialog box is displayed. 
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Complete or modify the following fields: 

Active: This field is selected by default. 

Code: Enter a new two- or three-digit code, “10” or higher. 

Description: Enter the marketing rep’s name. 

Email Address: Enter the marketing rep’s email address.  

Employee ID: Enter the marketing rep’s employee ID, if to be used for reporting. 

Click OK to save your changes, or click Cancel to close without saving. 
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External Title Officers 

All outside title officers that the company works with may be listed in the External Title Officers table, 

maintained through this menu item. The table is used for the lookup list on the Edit > Initial Questions > 

Title Information screens in both the Title and Escrow modules. This is not the listing of internal title 

officers used on the Initial Questions > Dates/Transaction Information screen. Care should be taken in 

training so the two fields are not confused.  

 

Click  to add a new entry to the table; or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The External Title Officers dialog box is displayed. 

 

Complete or modify the following fields: 

Active: This field is selected by default. 

Name: Enter the Title Officer’s name. 

Employee ID: Enter the Title Officer’s employee ID. 

NOTE: The inclusion of an Employee ID field in this listing was made to accommodate 

clients who wanted to use this table for internal title officers, but, again, this listing is 

normally of outside title officers, so an Employee ID would not normally be entered. 

Click OK to save your changes, or click Cancel to close without saving. 
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Hold Title As 

The entries to the Hold Title As table establish default vesting clauses. Some examples would be: 

“husband and wife”, “husband and wife, as community property”, and “as tenants in common”. These 

phrases are used to fill the vesting description fields associated with each buyer and seller name (labeled 

Hold Title Code on the Buyers’ Names and Sellers’ Names screens). The user may override an entry 

selected from the list box and enter a vesting clause of up to 8,000 characters, per name.  

 

Each clause is assigned a two-digit code. These code/clause combinations, once used, must not be 

changed or the information that already exists in the database will be invalid. A blank entry with the code 

“00” is required in this table. If the blank entry is selected by users from the list box, they will need to enter 

a customized clause manually. 

Click  to add a new entry to the table; or to modify an existing entry, highlight a record and 

click (Modify or double-click the entry. The Hold Title As dialog box is displayed. 

 

Complete or modify the following fields: 

Code: Enter a new two-digit code. 

Description: Enter a phrase that will fill the vesting description fields associated with each buyer 

and seller name. Examples include: “husband and wife”, “husband and wife, as community 

property”, and “as tenant in common”.  

Click OK to save your changes, or click Cancel to close without saving. 
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Transaction Type 

Transaction types are used to distinguish categories of escrows providing a mechanism for grouping 

them for statistical reporting, for automatic ticklers (through the Automatic Ticklers table), and for 

customizing of tracking routines (through the Tracking Descriptions tables). The number of types 

created and the categorizations made are very dependent on the individual company’s product set and 

market. Some examples of transaction types might include “Residential Sale”, “Residential Refinance”, 

and “Commercial Sale”. Again, some companies will have very short lists of transaction types and some 

will have longer lists. Two points to keep in mind when establishing the types are: what kind of 

management reporting will be expected and to what extent does the company want customized workflow 

tracking structures established for different types of escrows.   

 

Click  to add a new entry to the table; or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Transaction Types dialog box is displayed. 

 

Complete or modify the following fields: 

Active: Check the checkbox if the code is to be available to users. 

Code: Enter a new two-character code. 

Description: Enter the transaction type’s description. 

Refinance: Select this checkbox to flag the transaction type as exclusively Refinance related.  

IRS Reportable: Select this checkbox to flag the transaction type as reportable to the IRS, with 

regard to the 1099-S process. If the type is generically flagged IRS Reportable, on the 

maintenance screen, the function within Escrow that is used to definitively identify a specific 

transaction as reportable or not is made available. If the transaction type is not generically 

flagged as reportable on the maintenance screen, the user will not have the ability to mark any 

escrow assigned that type as reportable to the IRS. 

Click OK to save your changes, or click Cancel to close without saving.  
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Rate Charts 

Please note that the Rate Calculator in Impact/SQL does not currently handle some common 

pricing practices and is under review for revision (as of July 2016).  It is not recommended that it 

be used. 

Impact/SQL can compute Escrow and Title charges for the users for a fixed dollar range of transactions if 

rate tables are established for the underwriter(s) that have been set up in the system. Rate charts are, at 

a minimum, by Underwriter, but can also be by State and County within Underwriter.  There are two types 

of rate charts:  the regular charts cover owner’s and lender’s policies and “Loan Escrow” charts are used 

only for refinance transactions and have fewer options than the regular charts.  Discounts can be used, in 

regular rate charts, instead of setting up “Loan Escrow” rate charts.  

The rate chart structure in use prior to version 8.0 of Impact/SQL was comprised of a set of external “flat” 

files that held the information for the rate chart and discounts, etc.  With version 8.0 and later, those files 

are still in place but a new interface for editing the data within them is provided and the user should not 

edit the external files directly.  It is intended that the new interface will make setting up and editing of rate 

charts easier than in the past. 

 

When the Rate Charts function is initially selected, a screen like that shown above will be presented, it 

shows a listing of all rate charts that have already been established in the database.   

If a new chart is to be created, the   New Rate Chart icon, at the top of the screen should be clicked.   

If an existing rate chart is to be edited, the   Modify icon, on the record of the chart to be modified, 

should be clicked. 

The Underwriter: filter drop-down list, at the top of the screen, can be used to limit the charts listed to a 

select underwriter.  This is helpful if there are many charts entered (for various counties for various 

underwriters). 

The screens presented for a new chart are the same as those for modifying a chart, with the top of the 

screen being fully editable on a new chart only.  The discussion that follows will present a new chart being 

created.   The modification screen initially presented is on the following page. 

Having a printed rate chart in hand, which is to be duplicated in Impact, is imperative, as the body of the 

base chart must be typed into Impact.  Very often, the figures on the base chart are not mathematically 

exactly calculable with formulas.  The figures beyond the base chart are calculated, based on the 

information entered into the system. 
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The name of the Underwriter is at the top of the screen.  On a new chart, the field will present with a drop-

down of the underwriters established in the database.   

If the chart is to be one of several for the underwriter, with state and county identifiers for each, then enter 

the State and County for the chart being set up.  There will be a separate chart created for each 

Underwriter, State and County combination desired.   

If the chart is to be a Loan Escrow chart (for refinance transactions only), that box should be checked,  

when establishing a new chart.  It will reflect as “Yes” if that is the case when modifying an existing chart.  

A “No” indicates it is a regular rate chart.  

Once set, the above fields cannot be changed on an existing chart. 

On a new chart, the Effective Date should be entered.  The Effective Date of the chart can be changed, 

when and if the chart is being updated for new rates.   

The screen above is completely blank, save for the default, current, date at opening of a new chart.   

NOTE:  The figures used in the following example of a new chart setup are fictitious and should not 

be utilized in a real chart.  

The Rate Chart tab, right below the County field, will contain the meat of the base rate chart.  The three 

tabs BELOW the Rate Chart tab, Rate Lines, Base Data and Increment Above Base, are used to 

establish the bulk of the rate information.   

 

The Other Rate and Discounts tabs will be discussed after the Rate Chart tab and its sub-tabs are 

explained. 
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The  Clear and Regenerate Rate Lines icon, right below the Rate Chart tab heading, should be used 

AFTER the six fields right below the Rate Lines heading are completed. 

Table Start: enter the base dollar amount for the first entry in the basic rate chart.  In the example, 35,000 

has been used.  Do not enter the comma for the thousands designator, the system will do so.  Just enter 

35000 (or whatever the starting number should be). 

Table End: enter the highest dollar amount to be covered by the base rate chart.  In the example, 300,000 

has been used.  Again, don’t enter commas. 

Increment Amount: this is the incremental step between lines on the base rate chart.  If the title rates are 

to change at every $5,000 change in sales price or loan amount, then “5000” would be entered.  

Escrow Increment: this value is not used on the base chart, but is taken into consideration in calculations 

for escrow fees beyond the scope of the base chart.  This increment is that change in sales price at which 

the escrow rate will change…every $5,000 dollars, for example. 

Max for Increment: this value is also used in calculation of escrow fees beyond the scope of the base 

chart, and is the highest sales price at which the escrow fees will change.  In this sample, $1,000,000 is 

the limit, entered as 1000000. 

Calculation Max: a non-zero amount entered here will limit the calculation of rates to policies with a 

liability amount less than or equal to the value entered.  If “0” (zero) is entered, the calculation will be 

done on any sized policy.  If your underwriter does not want you to calculate rates on any policy over 

$1,500,000, for example, you would enter that amount in this field.  A message will be received by the 

user, if they ask for a rate to be calculated on a policy with a liability amount over that amount, to consult 

with the title department for the rate.  In this sample, 1500000 was entered. 

When the six figures above have been entered, for a new chart, the  Clear and Regenerate Rate Lines 

icon, right below the Rate Chart tab heading, can be used to generate the rate lines for the new chart.   

When editing a chart, If the user tabs out of the sixth field, after entering &/or changing data in the six 

fields discussed above, the following message will be received and a Yes response has the effect of 

presenting new Amount increments, but does not eliminate any of the fee amounts that have been 

entered. 

 

On the next page, the results of entering the six values and clicking the  Clear and Regenerate Rate 

Lines icon are presented.  The reader will note that the values in the Escrow Fee, Owners Fee, Combo 

Fee, Std Mortgage and ALTA Mortgage columns are all “0.00”.  These values must be entered, manually, 

from the printed rate chart.  The scroll bar, on the right, is used to move down through the chart. 

At this point, the base figures for the Escrow Fee, Owners Fee, Combo Fee, Std Mortgage and ALTA 

Mortgage columns are entered, by the user, manually, per the company’s printed rate chart for the 

underwriter, state and county.  These figures must be keyed in manually; there is not an “import” function. 
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Below, are the beginning and end of the Rate Lines table, after data has been entered manually.  Again, 

this is fictional data, but the values at the end of the chart are used on subsequent screens, so showing 

the transition from one screen to the next is important. 

 

<<Top of schedule 

 

 

 

 

Bottom of schedule >>     

 

 

 

Once the Rate Lines tab’s fields have been completed (all data entered through the end of the rate lines 

established), then the user should click the Base Data tab, to enter information there. 
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The Base Data tab (above) contains a series of 7 rows, on which are presented the figures, for each of 

the rate categories, at the end of each range for which calculation factors are to be entered on the 

Increment Above Base tab (below). 

 

Once the Rate Lines table is complete, the first line of the Base Data table will be the last line from the 

Rate Lines table, as shown above.  The Amount column is then filled, by the user, with the maximum 

dollar level at which the fees are to be adjusted at different rates.  In this sample, the fees are to be 

computed with different rates between $300,000 and $500,000, then at different rates between $500,000 

and $750,000, and with subsequent rate changes at each $250,000, with the last computed rates 

stopping at $1,500,000.  The last line is repeated, in this sample, to let the system know that there are no 

additional rate changes.  Again, up to seven lines may be used.   

The Amount values entered on this tab will flow to the Increment Above Base tab, where the 

incremental rates within each range are defined, as is explained next. 

Clicking on the Increment Above Base tab, the user would be presented with a grid into which they will 

enter the dollars per escrow or title increment (as appropriate) for each increment until the incremental 

rates change again.  In this example, the incremental change, at each $5,000 increment (coincidentally, 

in this case, the same for Escrow and Title fees, but not necessarily) until the Amount exceeds $500,000, 

at which point new incremental rates are to be applied.  Above, the first line has been completed, showing 

that Escrow Fees would increase by $10.00 at every $5,000 change in the Sales Price; the Owners Fee 

by $12.00 for every $5,000 change in Sales Price; the Combo Fee by $6.00 for every $5,000 change in 

Sales Price; and the Std and ALTA Mortgage rates by $8.00 and $14.00, respectively, for every $5,000 

change in Loan Amount. 

Those figures, when applied at the range maximum (the range between $300,000 and ending at 

$500,000) result in fees of set amounts, which are then entered, manually, into the Base Data screen, as 

shown above. 

The screen shot of the Increment Above Base table, above, is filled with all of the sample rates, for each 

of the sample rate ranges.  Again, these are entered by the user, from the information in the Underwriter’s 

Rate Manual.  Note: the last range is repeated until all seven rows are completed. 
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The screen shot of the Base Data tab, above, reflects all of the top-of-tier values, for each of the rate 

ranges.  Again, these values are computed and entered manually. 

With the three tabs (Rate Lines, Base Data and Increment Above Base) completed, the core of the rate 

calculator is loaded.  The next step is to address the Other Rate and Discounts tabs. 

The Other Rate tab is used to enter factors used to calculate extended rates, for values above the Base 

Chart entered in the Rate Lines table, and the fees to be added for simultaneous issues.  The buyer’s 

split percentage is identified in the Split Percent field.  The Other Rate tab, when first used on a new 

rate chart, appears as shown below. 

 

Owners Extended Rate – enter the percentage that should be used to amplify the owner’s standard rate 

to get to the extended rate – 110 (for 110%) would be an example. 

Lenders Extended Rate – enter the percentage that should be used to amplify the lender’s standard rate 

to get to the extended rate – 120 (for 120%) would be an example. 

Simultaneous Standard Fee – enter the dollar amount to be charged in the situation where there is a 

simultaneous issue of standard policies – 50.00 (for $50.00) would be an example. 

Simultaneous Extended Fee – enter the dollar amount to be charged in the situation where there is a 

simultaneous issue of extended policies - 55.00 (for $55.00) would be an example. 

Simultaneous Combo Fee – enter the percentage that should be applied to the owners policy to get the 

lenders policy premium, in a simultaneous issue situation – 50 (for 50%) would be an example. 

Simultaneous Escrow Fee – enter the dollar amount to be added to the base escrow fee when there is a 

simultaneous issue of policies – 10.00 (for $10.00) would be an example. 

Split Percent – enter the percentage of the fees/premiums to be charged to the Buyer – 50 (for 50%) 

would be an example. 

Check the Owners Premium Less Lender checkbox, in conjunction with, or rather than the simultaneous 

fees, if that is the pricing model. 

A completed screen would look like the one shown to the right.  The 

system will add the % and $ signs as applicable 
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The Discounts tab (shown below) is used to detail builder (escrow and title) and developer discounts.  

When first presented, the screen is blank with three tabs: Escrow Builder, Title Builder and Developer.  

Be sure the correct tab is selected and then use the   New Line icon to initiate the addition of a record 

to the tab selected. 

Escrow Builder – on this tab, entries are detailed with a short description (34 characters max) and a 

percentage.  The percentage is entered as ## (70 – for 70%), and is a percentage of the escrow fee that 

will be charged, when the discount is selected. 

Title Builder – on this tab, entries are detailed with a short description (34 characters max) and a 

percentage.  The percentage is entered as ## (70 for 70%), and is a percentage of the title premium that 

will be charged, when the discount is selected.  In the sample below, two discounts are detailed. 

Developer – on this tab, entries are detailed with a short description (34 characters max) and a 

percentage.  The percentage is entered as ## (80 for 80%), and is a percentage of the title premium that 

will be charged, when the discount is selected.  In the sample below, two discounts are detailed – note 

that the percentage of the discount may be included in the Description, if you wish. 
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Title Rates Descriptions 

The information maintained in the Title Rates Descriptions table is used to identify the policy or polices 

that are being purchased through each file. It also can be used in conjunction with Rate Chart data to 

compute rates within Impact/SQL. The user will see the listing on the first Initial Questions screen under 

the field heading Premium Rate.  

The Title Rate Descriptions are maintained in a series of tables, one for each underwriter established in 

the system. The various policies offered by each underwriter and the combinations of policies that might 

be sold are used as the factors in determining the items to be entered on these tables. For example, you 

may have items for each type of owner’s policy offered, for each lender policy offered, and for the various 

combinations of owner’s and lender’s policies offered. 

NOTE: The underwriters must be created in the system, prior to Title Rate Descriptions tables 

being set up, through Title > Documents > Document Maintenance > Edit > Underwriter Menu 

Table.   

 

Once an Underwriter is selected, the Escrow Title Rates Table Maintenance screen is displayed for the 

selected Underwriter, if one exists. 
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Click  to add a new entry to the table; or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Escrow Title Rates dialog box is displayed. 

 

Complete or modify the following fields: 

Active: Check the checkbox if the code is to be available to users. 

Code: Enter a unique two-digit code. Each description has a unique two-digit code within each 

underwriter. Once a code/description combination has been used, it cannot be changed.  

NOTE: If the Title Rates Descriptions table is modified, the Title Order Sheets, which are 

Crystal Reports, may also need to be modified – depending on their design. 

Description: Enter a description. The descriptions are to be stylized with the description of the 

owner’s policy first (if any) and then the lender’s policy or policies (up to three), if any, separated 

by commas.  The comma separators are critical. 

Rate Fields: There are also four Rate fields for each description, which are used to categorize 

the policy or policies identified in the descriptions as Standard (S) or Extended (E): 

- Owner Rate: Enter the Owner’s policy as Standard (S) or Extended 

(E). If there is no owner’s policy being issued this field will be blank. 

- Lender 1 Rate: Enter the first lender’s policy as Standard (S) or 

Extended (E). 

- Lender 2 Rate: Enter the second lender’s policy as Standard (S) or 

Extended (E). 

- Lender 3 Rate: Enter the third lender’s policy as Standard (S) or 

Extended (E). 

NOTE: When the descriptions and codes are combined, they tell the user (in text) and the 

system (in codes) what they need to know to identify the policy(ies) being issued and, if so 

configured, the rates to use.  

 

Files using the “with GFE” styles of data entry will use the coding above to default the text on the Owner, 

1st, 2nd and 3rd Lender policy description fields (on the 1103 & 1104 breakdown screens). 
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The following are some examples of code, description, and rate combinations: 

Code:  01 

Desc: Owner’s Policy, ALTA Lender’s Policy   

Rate fields: S E _ _ 

 

Code: 02 

Desc: Owner’s Policy  

Rate fields: S _ _ _  

 

Code: 03 

Desc: Lender’s Policy 

Rate fields: _ S _ _ 

 

Code: 04 

Desc: Extended Owner’s, ALTA Lender’s Ext., Standard Lender’s 

Rate fields: E E S _ 

The same codes and descriptions can be used for each underwriter, if appropriate. 
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Property Descriptions ► 

There are six menu choices under this heading that provide maintenance screens for tables related to the 

properties on transactions. 

States 

Counties 

Cities 

Municipality Types 

Subdivisions 

Property Types 

 

In addition, the Transfer Tax and Tax Stamp table configuration functions, which were reached via User 

Table menu paths in pre-8.0 versions of Impact, are now reached through the States, Cities and 

Counties maintenance screens.  Washington Excise Taxes and Sales Taxes, for databases configured 

for use in Washington State, are also addressed through these maintenance screens. 

 

States 

The States table contains all of the United States and the District of Columbia.  The GSA Code of each is 

pre-loaded.  There is no maintenance required with this table, except for the configuring of state tax 

stamps, if required in the area the Company does business (discussed below). 
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To modify an existing entry, highlight a record and click  Modify or double-click the entry. The State 

Tax Stamps dialog box is displayed, with the selected state information at the top of the screen.  If you 

are going to enter tax stamp calculation variables, check the Implement Tax Stamps checkbox, and the 

fields below it will become available for editing. 

 

Complete or modify the following fields: 

Implement Tax Stamps: Select this checkbox to activate the sections below. 

Deed Calculations and Mortgage Calculations sections 

Amount: Enter the amount to be charged. 

Per: Enter per increment (for example, per 1,000.00). 

Round: Select Up or Down from the drop-down list. 

Round to Nearest: Enter the amount to Round to Nearest. 

Default Charge to: Select Buyer or Seller from the drop-down list. 

Based on Sales Price: Identifies the tax stamp is to be based on sales price. 

Based on Mortgage: Identifies the tax stamp is to be based on mortgage. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Counties 

The Counties table is pre-loaded with all United States counties, along with their State and GSA Code.  

There should be no maintenance required in this table, except for the configuring of County Transfer 

Taxes and Tax Stamps, if required in the area(s) the Company does business in (discussed below).  The 

list feeds the City table maintenance screen and, more importantly, feeds the County field on the Initial 

Questions > Property Information screen, ensuring consistency of spelling on documents.  The County 

Name, State and County transaction taxes are maintained here. 

The County Table Maintenance screen lists the counties entered, and their state.   

 

Click  to add a new entry to the table; or, to modify an existing entry click the  Modify icon 

on the County entry to be edited, or double-click the entry.  There should be no need to add a county, and 

the user is not able to enter a GSA code on a county added manually.  USA Digital Solutions, Inc. will 

maintain the County listing via the upgrade cycle, as needed. 
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Transfer Tax Tab 

The Transfer Tax tab at the bottom of the screen is used for entry of County Transfer Tax rates, if 

appropriate.   

 

Complete or modify the following fields: 

Implement Transfer Tax: Select this checkbox to begin the process of entering tax rates.  That 

will open up the data fields for data entry. 

Use Tiered Calculations: Select this checkbox if the Transfer Taxes are based on tiered 

calculations in the specific county (see tiered screen below). 

The non-tiered screen asks for the tax Amount, the Per increment, how the Rounding will be done, and 

Default Charge To (who the cost is applied to by default).  Exemption information can also be identified. 

Amount: Enter the amount to be charged. 

Per: Enter per increment (for example, per 1,000.00). 

Round: Select Up or Down from the drop-down list. 

Round to Nearest: Enter the amount to Round to Nearest. 

Default Charge to: Select Buyer or Seller from the drop-down list. 

First Time Home Buyer Exemption Amount:  

First Time Home Buyer Amount:  

Principal Residence Exemption Amount:  
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The tiered screen asks for similar Amount and Per increment information, but for each of up to four 

“tiers” of sales price. 

 

Tax Stamps Tab 

The Tax Stamps tab at the bottom of the Modify County screen is used for entry of County Tax Stamp 

rates, if appropriate.   

Implement Tax Stamps: Select this checkbox to activate the sections below. 

 

Deed Calculations and Mortgage Calculations sections 

Amount: Enter the amount to be charged. 

Per: Enter per increment (for example, per 1,000.00). 

Round: Select Up or Down from the drop-down list. 

Round to Nearest: Enter the amount to Round to Nearest. 

Default Charge to: Select Buyer or Seller from the drop-down list. 

Based on Sales Price: Identifies the tax stamp is to be based on sales price. 

Based on Mortgage: Identifies the tax stamp is to be based on mortgage. 

 

Click OK to save your changes, or click Cancel to close without saving.  
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Cities 

The Cities table is pre-loaded with all United States cities, along with their County, State and GSA 

Code.  There should be no maintenance required in this table, except for the configuring of City 

Transfer, Excise and Sales Taxes, if required in the cities the Company does business in (discussed 

below).  The Cities table is the source for the City field drop-down on the Initial Questions > Property 

Information screen.  The drop-down is used to speed data entry by Escrow personnel and to ensure 

consistency of spelling on documents. The user may enter a city that is not on the drop-down list.   

 

Click  to add a new entry to the table; or, to modify an existing entry click the  Modify icon 

on the City entry to be edited, or double-click the entry.  There should be no need to add a city, and the 

user is not able to enter a GSA code on a city added manually.  USA Digital Solutions, Inc. will maintain 

the City listing via the upgrade cycle, as needed. 

The top half of the Modify City screen is shown below.  The user could edit the Municipality Type and 

Municipality Name, if needed in your area.  The other fields should not need editing. 

 

The bottom half of the screen relates to maintenance of tax rates, and will be discussed on the next page. 
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The bottom half of the Modify City screen is used for entry of City Transfer, Excise and Sales Tax 

rates, if appropriate.  This configuration is done to support the system’s ability to compute transfer, excise 

and sales taxes, for those locales that have such taxes, in the data entry areas for Recording Expenses. 

Depending on configuration, you will see a tab for each type of tax that can be configured for the city.  

Normally, you will only have a Transfer Taxes tab.  Transfer taxes are based on the Sales Price.  

Databases configured for business in Washington State will have Excise and Sales Tax tabs as well.  

Complete or modify the following fields: 

Implement Transfer Tax: Select this checkbox to begin the process of entering tax rates.  That 

will open up the data fields for data entry. 

Use Tiered Calculations: Select this checkbox if the Transfer Taxes are based on tiered 

calculations in the specific city (see tiered screen below). 

The non-tiered screen asks for the tax Amount, the Per increment, how the Rounding will be done, and 

Default Charge To (who the cost is applied to by default).  Exemption information can also be identified. 

Amount: Enter the amount to be charged. 

Per: Enter per increment (for example, per 1,000.00). 

Round: Select Up or Down from the drop-down list. 

Round to Nearest: Enter the amount to Round to Nearest. 

Default Charge to: Select Buyer or Seller from the drop-down list. 

First Time Home Buyer Exemption Amount:  

First Time Home Buyer Amount:  

Principal Residence Exemption Amount:  
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Check the Use Tiered Calculations if appropriate for the city.  The Tiered screen asks for similar 

Amount and Per increment information, but for each of up to four “tiers” of sales price. 

 

Click OK to save your changes, or click Cancel to close without saving.  
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Municipality Types 

The Municipality Types table feeds the field of that name on the Initial Questions > Property 

Information data entry screen.   

 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Add Municipality Type dialog box is displayed.  

 

Description: Enter the officially recognized description of each municipality type in the state. 

Click OK to save your changes, or click Cancel to close without saving.  
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Subdivisions 

The Subdivision table provides data for the Subdivison drop-down list on the Initial Questions > 

Property Information screen. If the user selects a Subdivision Name from the drop-down and then 

clicks inside the Brief Legal field, this field will be filled with the Tract, Map Book, and Map Page 

information stored for the particular subdivision. The Legal Clause value is the file name of the master 

document prepared, for the subdivision, under Escrow > Documents > Document Maintenance > 

Legal Clauses. The Legal Clause must exist before it can be referenced in this table. 

 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Subdivision dialog box is displayed.  

 

Complete or modify the following fields: 

Name: Enter the name of the subdivision. 

Tract: Enter the tract information for the subdivision. 

Map Book: Enter the map book location for the subdivision. 

Map Page: Enter the map page location for the subdivision. 

Legal Clause: Enter the file name of the master document prepared under Escrow (or Title) > 

Documents > Document Maintenance > Legal Clauses. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Property Types 

The Property Type field, in the Initial Questions > Property Information, is filled with values from this 

table. The descriptions entered are used in Management Information System (MIS) reports to segment 

the company’s business by property type (for example: 1-4 Family Residential).  It is critical that this table 

properly reflect the reporting breakdown that Company management desires. 

 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Property Types dialog box is displayed.  

 

Complete or modify the following fields: 

Code: Enter a unique one- or two-digit code. 

Description: Enter a description for the property type. The description cannot be changed in this 

table without affecting what is seen in the files, and on reports. 

NOTE: When modifying an existing entry, the Code cannot be changed, just the 

Description.  An altered Description should still reference the same Property Type, or 

historical reporting – based on the Code – will be impacted.  Add new Codes, rather than 

altering existing Descriptions, for new Property Types. 

 

Click OK to save your changes, or click Cancel to close without saving. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 135 of 183 

Recording Fees 

The company will use the Recording Fees screen to set up the parameters for computing the recording 

fees for the Deed of Trust, Mortgage and Release. They can be entered for all of the state and county 

combinations with which the company’s offices do business.  

When the Escrow users are in the Government Recording and Transfer Charges section of the data 

entry screens, they will see a check box to Calculate the fees and if the state and county combination for 

the transaction involved is configured here, the system will display a screen of the calculated charges. 

The user can edit the calculated data if so desired. If the particular state and county combination involved 

has not had parameters set for it, an alternate screen will appear to the Escrow user stating that fact and 

asking the user to enter the fees applicable to the buyer and seller. 

 

Select the State and County from the drop-down lists and press TAB to begin data entry or editing. 

The Recording Fees setup screen has sections for each of the three document types:  

Deed 

Mortgage 

Release 

Enter the charges for the customary manner computed for each section:  

Amount: $x.xx for first x pages 

Additional pages at $x.xx per Page 

Plus Sercharge of: If surcharges are collected, enter an amount. 

Default charge to: To whom the charge should default to (Buyer or Seller). 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Receipt Types 

The Receipt Types are very important to the workflow processes in Impact. Depending on which type 

code is assigned to each receipt, different behaviors will be triggered in Impact/SQL. There are several 

settings associated with each receipt type that prompt these differences, as will be explained below. The 

receipt type that is assigned to each receipt is presented in the Ledger for each file. Receipt Journal 

reports can be sorted by receipt type. The Receipt Type drop-down list is used on the Receipt Entry 

screen. 

 

While each company may create and utilize the receipt types they need for their business process, there 

are some codes which are required for proper execution of Impact/SQL’s programs and which cannot be 

altered or deleted (they are marked with an  Info icon on the listing). These are: 

WIN: Wire In – used by incoming wire processing. 

SAV: Savings – used with the savings (interest bearing) account ledgers to add or remove funds 

manually. Receipts of this type only affect savings ledgers.  The SVD and SVC receipt types 

relate to the more automated savings transfer action. 

INT: Interest earned – used to record interest earned within the savings ledgers only. 

SVC: Debit Escrow, Credit Savings – used by the system with the automated savings transfer 

function to move funds from an escrow ledger to a savings ledger. 

SVD: Credit Escrow, Debit Savings – used by the system with the automated savings transfer 

function to move funds from a savings ledger to an escrow ledger. 

TRF: Transfers – used if funds transfer between files with the same branch and bank has been 

permitted through the setup options for Escrow and/or Accounting. 

NSF: Non-Sufficient Funds – in the event of an NSF being receipted an e-mail notification can be 

sent to the escrow officer of the file, if the setup option to e-mail escrow officers is enabled. 

FST: Used for fee slip transfers from escrow ledgers. 

FSV: Voids of FST’s. 

FSR: Fee slip reversal of a FSV. 

TBB: Transfers with change in Branch and Bank. 

TBK: Transfers between Banks. 

TBR: Transfers between Branches. 

EC:  Error Correction (DOC sites only) 
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NOTE: WIO: Wire Out – outgoing wires are considered disbursements within Impact/SQL, not 

receipts, and this code will not appear in the code table and should not be added to it to avoid the 

erroneous use of the code. 

The BCF Balance Carried Forward receipt type, while not mandated, can be used and it will return 

zeroes for the receipt number and is used during a conversion to reflect a starting balance in an escrow 

that was originated in another system. 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Receipt Types dialog box is displayed.  

 

Complete or modify the following fields: 

Code: Enter a unique up-to-three character code (cannot modify an existing item, just add new). 

Description: Enter a description for the receipt type.  

Allow Escrow: This check box identifies whether the code will be made available to Escrow 

module users or whether the code will be limited to Accounting users. 

Depositable: If a receipt type is configured to be depositable, each receipt tagged with the code 

will appear on the Deposit Slip screen and will not appear directly within a reconciliation. This flag 

should be used for receipt codes that are to be assigned to items that are physically deposited at 

the bank, either singly or in aggregate, along with a deposit slip whether prepared within 

Impact/SQL or manually. If depositable, the receipt will appear on the Deposit Slip preparation 

screen until included in a deposit.  

Math Sign: Receipt types can be configured to accept a positive value only, a negative value 

only, or either type of value. This can help reduce data entry errors. 

Applies To: There are three options: RCT – Receipts, WIN – Wire In, and WIO – Wire Out. This 

setting identifies which particular functionality the receipt code is involved with. This setting is 

used to sort receipts by broader categories in the reconciliation module. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Income Codes 

Escrow users, when coding the fee check or fee slip detail lines, use the Income Codes entered in this 

table. The codes must be numeric, can be up to five digits long, and can have leading zeroes. It is typical 

to have the codes match up with the account numbers used in the company’s general ledger system for 

the various revenue items and pass-throughs being tracked (Title Premiums, Escrow Fees, Delivery 

Fees, etc.).  The income codes can be categorized, which will filter the codes seen on specific data entry 

screens to just those that are applicable to those screens. 

The Income Code Table Maintenance screen presents the Income Codes, their Descriptions and 

whether they are Active or not.  Inactive codes will not be available for use on fee slip or fee check line 

items.  The listing can be filtered to show only active, only inactive or all codes, via the Filter drop-down 

in the upper right. 

 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Income Codes dialog box is displayed.  The Active flag, 

Code, Description, Category and Liability From fields are presented.  All are editable except for the 

Code, which, once established, cannot be changed.  The Category field is used to filter the codes 

displayed on different charge entry screens.  The Liability From field is used to identify whether the sales 

price or one of the three loan amounts should automatically be linked to the income code – this 

functionality comes into play on invoicing and some data exports. 
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Complete or modify the following fields: 

Active: Select to indicate a code is Active. Deactivate an existing code by unchecking the Active 

box. 

Code: Enter a unique income code of up to five digits. 

Description: Enter a description for the code.  

Category: The categories are None (All categories), Title Fees Premium, Title Fees Non-

Premium, Escrow Fees, Recording Fees, Sub Escrow Fees, and Endorsements.  The charts 

on the following pages detail how the categorization coding will filter codes to specific data entry 

screens.  If categorization is not desired, select None (All categories) on each code. 

Liability From: This option is used to identify whether the sales price or one of the three loan 

amounts should automatically be linked to the income code; for invoice and reporting purposes.  

If categorization is being used, some of the Liability From settings will default. 

 

Click OK to save your changes, or click Cancel to close without saving. 

 

The coded income entries, once posted, are passed to the Income Analysis table and are then available 

for reporting. Once the codes are established, USA Digital Solutions, Inc.’s Crystal Reports Team will 

need to initially configure the Accounting Income Analysis reports (Summary and Detail) and will need 

to edit any income reports, which report on selected or groupings of income codes, whenever codes are 

changed or added to the system. 
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Categorization of Income Codes – Filtering Behavior 

 

 

Income Code Filtering Chart, with Endorsement Category
"None" category appears in all 

dropdowns

Escrow Module - Residential HUD with GFE Category Liability From

1102 - Settlement or Closing Fees
Escrow Fees

Title Fees Premium
None

1103 - Owner's Policy & Add'l Charges Title Fees Premium Sales Price

1103 - Title charges Applicable to Owner's Policy - Endorsement Endorsement
Sales Price

Optional

1103 - Title charges Applicable to Owner's Policy - Other
Title Fees Premium

Title Fees Non-Premium

Optional

None

1104 - Lender's Policy & Add'l Charges Title Fees Premium Lender Loan Amount

1104 - Title charges Applicable to Lender's Policy - Endorsement Endorsement
Lender Loan Amount

Optional

1104 - Title charges Applicable to Lender's Policy - Other
Title Fees Premium

Title Fees Non-Premium

Optional

None

Escrow Module - Closing Disclosure Form (CDF) Category Liability From

Title Insurance Premiums \ Title Ins. - Lender's Policy Title Fees Premium Lender Loan Amount

Title Insurance Premiums \ Title Ins. - Lender's Policy - Endorsement Endorsement
Lender Loan Amount

Optional

Title Insurance Premiums \ Title Ins. - Owner's Policy Title Fees Premium Sales Price

Title Insurance Premiums \ Title Ins. - Owner's Policy - Endorsement Endorsement
Sales Price

Optional

Sections B, C or H

    Fee Types:

      • Misc. Escrow Charge

      • Settlement Fee (B only)

      • Title Closing Fee (B only)

      • Title Document Preparation Fee (Not H)

      • Title Notary Fee (Not H)

Escrow Fees

Title Fees Premium
None

    Fee Types:

      • Misc. Title Charges 

      • Title Closing Protection Letter Fee (Not H)

      • Title Examination Fee (Not H)

      • Title Insurance Binder Fee (Not H)

      • Title Underwriting Issue Resolution Fee (Not H)

Sub Escrow Fees

Title Fees Premium

Title Fees Non-Premium

Optional

None

    Fee Types:

      • Title Endorsement Fee 
Endorsement

Sales Price

Lender Loan Amount

Optional

    All other Fee Types

Escrow Fees

Sub Escrow Fees

Title Fees Premium

Title Fees Non-Premium

Optional

None

E. Taxes and Other Government Fees Recording Fees None



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 141 of 183 

  

Escrow Module - Commercial Orders (Settlement Charges screens) Category Liability From

Escrow Charge
Escrow Fees

Title Fees Premium
None

Title Charges - Title Charge
Sub Escrow Fees

Title Fees Premium

Title Fees Non-Premium

Optional

None

Title Charges - Owners Policy Title Fees Premium Sales Price

Title Charges - Lenders Policy Title Fees Premium Lender Loan Amount

Title Charges - Other Policy Charges Title Fees Premium Optional

Title Charges - Endorsements Endorsement

Sales Price

Lender Loan Amount

Optional

Recording Fee - all types Recording Fees None

Additional Charges - Additional Charge
Escrow Fees

Title Fees Premium
None

Escrow Module - Sub Escrow User (Charges screens) Category Liability From

Title Charges - Title Charge
Sub Escrow Fees

Title Fees Premium

Title Fees Non-Premium

None

Title Charges - Owners Policy Title Fees Premium Sales Price

Title Charges - Lenders Policy Title Fees Premium Lender Loan Amount

Title Charges - Other Policy Charges Title Fees Premium Optional

Title Charges - Endorsements Endorsement

Sales Price

Lender Loan Amount

Optional

Recording Fee - all types Recording Fees None

Additional Charges - Additional Charge sub
Escrow Fees

Title Fees Non-Premium
None

Title Module - Title Charges (if Sub Escrow Enabled) Category Liability From

Title Charges - Title Charge
Sub Escrow Fees

Title Fees Premium

Title Fees Non-Premium

None

Title Charges - Owners Policy Title Fees Premium Sales Price

Title Charges - Lenders Policy Title Fees Premium Lender Loan Amount

Title Charges - Other Policy Charges Title Fees Premium Optional

Title Charges - Endorsements Endorsement

Sales Price

Lender Loan Amount

Optional

Recording Fee - all types Recording Fees None

Additional Charges - Additional Charge sub
Escrow Fees

Title Fees Non-Premium
None
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Invoice Description 

The Invoice Description table entries are used to provide standardized selections for users when 

preparing an invoice.  The Invoice Descriptions are tied to Income Codes (discussed above).  While 

there cannot be duplicate income codes, there can be multiple Invoice Descriptions tied to a single 

Income Code.  This provides for more detailed alternatives for invoice entry.  There need not be a 

correlation between the Invoice Description Codes and the Income Codes, but some sites like to make 

them common, except for those situations where multiples are assigned to a common income code.  The 

codes can be up to five digits in length.  A default dollar Amount can be assigned to each invoice item. 

This can make preparation of an invoice a very quick and accurate process. During invoice preparation, 

the users can edit descriptions selected from the list. They can edit both the text and the dollar amount. 

 

Click  to add a new entry to the table, or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Invoices Codes dialog box is displayed.  

 

Complete or modify the following fields: 

Active: Select to indicate a code is Active. Deactivate an existing code by unchecking the Active 

box. 

Code: Enter a unique invoice description code of up to five digits. 

Description: Enter a description for the code. This description will pull to the Invoice Entry 

screen when that particular code is selected from the drop-down list during invoice preparation. 

Product Code: Enter a value to be printed on a customized invoice, if so customized. 

Title Code: Enter a value to be printed on a customized invoice, if so customized. 

Income Code: Select a value to be printed on a customized invoice, if so customized. The drop-

down for this field is populated from Income Codes. 

Amount: The Amount, if entered, will pull to the Invoice Entry screen and to the printed invoice. 
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Click OK to save your changes, or click Cancel to close without saving. 

Impact/SQL does not have an Accounts Receivable module, but invoice data can be exported to an 

outside package (see Impact/SQL Invoice Export). USA Digital Solutions, Inc. can create custom filter 

programs for the export module if the current filters are inadequate. 

 

 

Auto Ticklers 

Auto Ticklers are pre-determined reminders that can be established for any one or for all Transaction 

Types based on a specific number of days from the date the escrow was opened or before the expected 

close date. They can be triggered based on the presence of a value in one of five fields: Lender #1 

Name, Lender #2 Name, Lender #3 Name, Buyer Payoff #1, or Seller Payoff #1.   

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Auto Ticklers dialog box is displayed.  
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Complete or modify the following fields: 

Transaction Type: Select a specific Transaction Type or ALL from the drop-down list.  

Date to Base on: Choose Date Opened or Date Closed.  

Days from/to base:  Enter a positive number to reflect the number of days after the opened date 

or a negative number to reflect the number of days before the estimated closing date that the 

tickled item will reflect as due on under Escrow > Ticklers > Reminders (and Select & Edit).  

Description:  The actual tickler message that the user will see.  

Based On: Select a value to limit the tickler to only appear if there is an entry  in one of the five 

fields: 

- Lender #1 Name 

- Lender #2 Name 

- Lender #3 Name 

- Buyer Payoff #1 

- Seller Payoff #1 

If this field is left blank, there is no restriction. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Dynamic Data Fields 

The ability to add company-specific data collection fields was added in version 5.11 of Impact/SQL.  Data 

Types for the Misc Data Entry screen are set up under this option. Either Escrow, Title, or both can be 

enabled to fill these data fields. The field set is common to both. 

The Escrow option is enabled by choosing the Enable Misc Escrow Data in Initial Questions under the 

Setup Options > Escrow Functions > Data Entry menu in the Utilities module. The Title option is 

enabled by choosing the Enable Misc Data Entry for Direct Orders option under Setup Options > Title 

Functions > Data Entry.  The data entered by users is available for reporting, but not for use in 

documents. 

The Filter, in the upper right corner, can limit the display to Active, Inactive or All table entries. 

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Modify Dynamic Data Entry dialog box is displayed.  

 

Complete or modify the following fields: 

Active: The checkbox can be used to deactivate a field.  

Fields that have been deactivated will not present on 

new files from that time forward. 

Data Type: Select the type of control for the data entry 

process.  The options are String, Date, List, Checkbox 

and Numeric. 

Caption: Enter the field name. This will aid the user to 

know what data is expected to be entered. 

List Values: If List is selected as the Data Type, enter 

the values from which the user can choose, separated 

by a tilde (~) character. 

Field Length: If String is selected as the Data Type, enter the maximum number of characters 

that the user can enter in that field. 

Report Code:  This field can be used to select fields for use on Custom MIS; up to 10 characters. 

 

Click OK to save your changes, or click Cancel to close without saving.  
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Tracking Descriptions ► 

The tracking function, turned on or off under Utilities > Setup Options > General Functions > 

Miscellaneous > Enable File Tracking, relies on the entries created here under two broad categories: 

Escrow and Direct Order. The direct order tracking descriptions are used for Title Only transactions, 

created through the Title module, where no escrow is involved.  

The tracking function provides a place where dates can be recorded relating to the start date/time and 

completion date/time of various requirements of each file, along with comments on any item.  Items can 

be flagged as “Tasks”, which cannot be deleted.  Items can be set inactive.  A default-tracking table with 

the descriptions of these various requirements can be established for all files OR specific tracking items 

can be designated for specific Transaction Types. See the Transaction Types section above for a 

discussion of transaction types. For example, some items might include: Demand for the payoff for the 1st 

mortgage, the appraisal, and the termite inspection. A default tracking table can be established for both 

Escrow and Direct Orders. The users may customize the tracking items by file as well. The entries of the 

Date Ordered, Date Received and Comments are made manually through the Escrow and/or Title 

modules, for each item on the tracking table, for each file. 

From the Tracking Descriptions menu, you can select Escrow or Direct Order from the sub-menu. 

Selecting either of those options displays the Select Transaction Type dialog box, with {Default} as the 

first choice.   

 

Use the drop-down arrow to select a specific Transaction Type or {Default} (for all files), and click OK to 

continue. The Tracking Default Table Maintenance screen is displayed, listing all of the tracking items 

that have already been defined for the {Default} group or whichever Transaction Type was selected for 

editing.  In the example below, the {Default} group is selected. 

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Escrow Tracking Descriptions dialog box is displayed.  
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Complete or modify the following fields: 

Description: Enter a tracking description up to fifty-three character positions, including spaces. 

Event Code: If your system is configured for the Track My File integration, enter an Event Code 

for each Description.  The Event Code column is utilized with the Track My File integration, only. 

Task Item: Check this box if the item is not able to be deleted by the user and which must have 

its date/time entered via the checkbox method. 

Active: Check this box if the item is to be available to users.  Inactive items will not present to 

users, but are helpful when preparing changes to the listing(s). 

 

Click OK to save your changes, or click Cancel to close without saving. 

 

In practice, the Escrow or Title user will see a screen accessed via File > Tracking. Users will enter 

dates in the Date Ordered and Date Received fields as items are dealt with. The dates will be entered 

via a checkbox that will fill the date fields with dates and times (this approach must be used on “Task” 

items).  Dates on non-Task items can be entered manually or via the Calendar tool.  The Comments 

column to the right of the Date Received field is used for comments up to 50 characters in length. As was 

mentioned previously, users can customize the tracking detail for each file, once established, through that 

screen.  Users can delete non-task items. 
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Closing Statement Categories – HUD and Settlement 

Statement ► 

Two category groupings are maintained under this menu item: HUD and Settlement Statement. 

Depending on whether the company utilizes both documents, you may or may not need to edit both 

tables. It is recommended that you keep both the same for consistency. However, depending on the 

verbiage norm in your marketplace, they may be different. The purpose of these two listings is to provide 

a heading for the HUD and Settlement Statement documents that indicates which version of the 

document is being printed, such as Final, Estimated, Pre-Audit and Amended. 

The listings will show up under Print Options when the documents are generated. The value selected will 

appear right above Line B on the “with GFE” HUD, above Line C on the traditional HUD, and under the 

main title on the Settlement Statement.  

HUD Statements 

The same HUD template is used for all heading choices.   

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The HUD Statement Categories dialog box is displayed.  
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Complete or modify the following fields: 

Code: Enter a unique code for the category. 

Description: Enter a description for the code. 

Click OK to save your changes, or click Cancel to close without saving. 

Settlement Statements 

Settlement Statements can be customized so each Category could present different verbiage or 

signature lines, if desired.  The “Sub Escrow” code must exist in the table if Sub Escrow functionality is 

being used. 

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Settlement Statement Categories dialog box is displayed.  

 

Complete or modify the following fields: 

Code: Enter a unique code for the category. 

Description: Enter a description for the code. This will appear in the heading of the generated 

statement. 

Form Type: Enter a code (a single character) to trigger which document variation to utilize.  This 

field is not required and the default Settlement Statement will be used if no Form Type code is 

entered, or if the code entered does not trigger a match with an existing report variant.  USA 

Digital Solutions, Inc. personnel will normally create alternative formats for Settlement 

Statements, as requested, and will enter the Form Type codes. 

 

Click OK to save your changes, or click Cancel to close without saving.  
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Settlement Statement Headers 

The Settlement Statement Headers maintenance screen is used by the Company to rearrange the 

groupings of charges on the Settlement Statement(s) to meet the company’s preferred manner of 

presentation. There is a fixed set of eleven (11) heading categories, and while all eleven lines must 

always be displayed in the maintenance table, the entry descriptions can be changed or blanked out, if 

desired, to re-group lines. For this reason, you will not see the New Record or Delete icons on this 

screen, only the Modify, Move Up and Move Down icons. When the headings are rearranged, the detail 

charge lines under each heading will move with the headings. 

 

To modify an existing entry, highlight a record and click  Modify or double-click the entry. The 

Settlement Statement Headers dialog box is displayed.  

 

Modify the following fields: 

Code: This field is grayed out and cannot be modified. 

Description: Modify or blank out the description, as needed. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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The full screen is shown here with one category’s description blanked out. The standard Title Charges 

and Escrow Charges entries have been combined by editing the Description to include both and 

keeping the related group of charges (the 03 group) under the 02 group. 
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Prelim Distribution Via 

If the Enable Escrow Prelim Distribution option has been turned on (System Files > Setup Options > 

Escrow Functions > Data Entry > Enable Prelim Distribution in Initial Questions), then the process 

of entering the method of documenting the distribution method for each document is sped up and 

standardized through the use of the Via lookup table, the contents of which are entered through this 

screen. Similar in nature to many of the other lookup table maintenance screens, the listing table and 

entry/edit screens look like this: 

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Prelim Distribution VIA dialog box is displayed.  

 

Modify the following fields: 

Code: Enter a character code for each distribution type. 

Description: Enter the full name of the distribution method. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Mandatory Fields 

The company may wish to make some fields on data entry screens used by Escrow and Title, on escrow 

files and direct orders, mandatory. The user will not be permitted to exit the data entry screen they are on 

until a value has been entered into all of the mandatory fields on that screen. A Missing Information 

message box will pop-up, identifying which field must be completed. The setting of mandatory fields is 

managed here. 

There are several data entry screens for each module (Escrow and Title) that have fields which can be 

made mandatory. The screens/fields that can be made mandatory are presented via a menu tree, as 

shown below.  Each of the screens that can have fields on them set to be mandatory is listed under the 

Escrow and Direct headings, on the left side of the screen. 

 

Once a screen name is highlighted in the tree on the left of the screen, a listing of available fields that can 

be made mandatory, on that screen, is presented with a checkbox for each field that is used to make the 

field mandatory.  Check each field that you wish to make mandatory, then select the next screen on the 

list.  A table of the fields that can be made mandatory is on the following page. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Fields that can be made Mandatory 

Screen / Field Name Escrow Files Direct Orders 

Dates/Transaction Information   

     Transaction Type   

     Rate Code   

     Marketing Rep #1   

     Marketing Rep #2   

     Underwriter   

     Title Officer   

Property Information   

     Brief Legal   

     Property Address   

     Property County   

     Parcel ID #1   

     Property City   

     Property State   

     Property Type Code   

Source of Business   

     Source of Business Name   

     Source of Business Address   

     Source of Business Location   

     Source of Business-Indv. Name   

     Source of Business Address #2   

Billing to Customer (E)/Billing Information (D)   

     Bill to Name   

     Bill to Attention   

     Bill to Address #1   

     Bill to Address #2   

     Bill to Location   

Title Information   

     Title Need By Date  N/A 

     Title Officer Name  N/A 

Receipts   

     Payor Name  N/A 
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Check Templates 

The Check Template entries are used by the system to pre-process data in the system before check 

generation on “with no GFE” files only. While actual checks are generated via Crystal Reports files, the 

data is collected and consolidated by payee based on the settings in this table. This permits re-naming of 

fields for the purpose of their presentation on checks and associates specific fields with specific parties to 

the transactions. These settings can provide for some very company-specific configurations. These 

settings, as they are universal to the database, are critical and once set should not be modified, except by 

knowledgeable USA Digital Solutions, Inc. staff. 

USA Digital Solutions, Inc. staff, in conjunction with company management, will determine what 

the settings should be on these fields and they should only be altered by USA Digital Solutions 

personnel. 

The initial screen presented contains a listing of payees, the descriptions of the disbursement items for 

each, and income codes associated with them, if any. These are items that have already been defined.  

 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 156 of 183 

Click  to add a new entry to the table or to modify an existing entry, highlight a record 

and click  Modify or double-click the entry. The New / Modify Check Template dialog box is 

displayed. 

 

Complete the following fields: 

Sort Code:  This code is utilized on payoff-related items to order them into a standardized 

presentation. 

Comments: This field is for information only and is not available for printing on a check. 

The PID parameters are Prompt Identification Numbers and are used to make an assignment of a 

system field for each of the various categories for the disbursement item being defined. Default 

values may be entered for each PID parameter. It may be that not all of the settings will be 

utilized for each possible check detail item. 

Next to each PID field, click the  Lookup button to display the Lookup Escrow Prompt. 
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To quickly find a specific record, use the Filter box. Enter letters/numbers or partial 

letters/numbers of a prompt ID or description. The records that match entered information display 

in the grid. Click  to clear the filter. Select a record from the list and click OK. 

Charge to PID 

Pay to PID 

Address # 1 & 2 PID: If multiple disbursement items are being defined, in separate entries for 

one Pay to PID, the address PID’s need only be defined for one of the items.   

City, State and Zip PID 

Amount PID 

Amount 2 PID 

Sales Tax PID 

Sales Tax 2 PID 

POC PID 

Income PID: If a specific line on the HUD is to be related to a specific Income Code, enter that 

code in the Default field. The user may override it at the time of check creation. 

Description PID: If the company does not like the description for an item on the HUD, enter a 

default value in the Default field. 

Memo PID:  Enter the Loan Number, Tax Parcel Number, or any other field label the company 

wishes to appear on the face of the check. The memo line is generally formatted to print under 

the City, State and Zip line on the check. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Payoff Descriptions 

The breakdown information for each payoff has a description and an amount for each charge (beyond 

principal and interest). There can be an unlimited number of charges listed. The user can select a pre-

determined description from the table maintained here or may enter their own. Selecting from a well-

thought-out listing can be a big time-saver.  

 

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Payoff Descriptions dialog box is displayed.  

 

Complete the following field: 

Description: Enter the description of the payoff. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Disbursements Hold Reasons 

Disbursements can be placed on Hold which will reduce the File Balance, but will not reduce the 

Available Balance and the items on hold will not appear In Process. When a disbursement is placed on 

Hold, a Reason box is made available for the user to select a pre-defined hold reason or enter a reason 

of their choice. The pre-defined hold reasons are entered through this maintenance screen, which is 

similar in format to many of the others.  

 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Disbursement Hold Reasons dialog box is displayed.  

 

Complete the following field: 

Description: Enter the full name of the distribution method. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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User Defaults 

The User Defaults screen is used to pre-set the defaults for Payoff interest and Rent proration 

calculations for non-GFE and non-CDF residential files only.  GFE, Commercial, and CDF proration 

defaults are set in Setup Options > Escrow Functions > Proration Defaults (GFE, COM, CDF).  Users 

will be able to change the settings for specific files, if the default is not appropriate in their specific 

circumstance. 

 

Complete the following fields: 

Payoffs:  Set the default Days in the Year factor for computing payoff interest to either 360 or 

365 days. 

Rent Schedule: Set the default Days in the Year factor for rent prorations to either 360 or 365 

days, or Days in period. Select Annual, Semi-annual, Quarterly, Monthly and Daily from the 

Term drop-down list. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Party Types 

The Party Types Table Maintenance screen is used to add/modify additional Descriptions, which are 

all a sub-set of the Other Party type. 

 

All of the standard Party Types are presented on the screen, but cannot be modified nor deleted.  They 

are identified with the presence of the  Info icon next to each. 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Party Types dialog box is displayed.  

 

Complete the following field: 

Description: Enter the description for the party type to be added.  The Description can be up to 

50 characters in length.  Once used, a Party Type cannot be deleted from the Party Types table. 

 

Click OK to save your changes, or click Cancel to close without saving. 
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Contact Roles 

The Contact Roles Table Maintenance screen is used to add/modify additional Descriptions of Contact 

Roles. 

 

All of the standard Contract Roles are presented on the screen, but cannot be modified nor deleted.  

They are identified with the presence of the  Info icon next to each. 

Click  to add a new entry to the table or to modify an existing entry, highlight a record and 

click  Modify or double-click the entry. The Contact Roles dialog box is displayed.  

 

Complete the following field: 

Description: Enter the description for the contact role to be added. 

 

Click OK to save your changes, or click Cancel to close without saving. 

 

FNF Flash Codes (only on FNF sites) 

FNF Flash Codes can be maintained through this function.  The codes are utilized in some Custom MIS. 
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Custom Lookups ► 

There are four menu choices under this heading that provide maintenance screens for tables related to 

the Title Charges Descriptions entry-assistance.  The maintenance screens for each are identical. 

Owner Policy Descriptions 

Lender Policy Descriptions 

Other Policy Descriptions 

Endorsement Descriptions 

 

The typical  New Record,  Print,  Move Up, and  Move Down icons are across the top of the 

opening Table Maintenance screen. 

 

Clicking on the  New Record icon will bring up the 

Custom Lookups enter/edit screen, like that shown 

here.  The desired text should be entered and OK 

clicked.  The user will be returned to the Table 

Maintenance screen and the addition/edit will be seen 

there.  Click OK on the Table Maintenance screen to 

save all changes.   

 

 

 

 

 

Again, there are four tables that can be developed:  Owner Policy Descriptions, Lender Policy 

Descriptions, Other Policy Descriptions, and Endorsement Descriptions.   
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Tools Menu 

There are several tools built into Impact/SQL, which are available to a restricted set of users that can be 

used to correct problems that may arise or to perform functions that are not routine and can have major 

impacts on data in the system. The full Tools menu, available only to users with the access level of 

System Administrator, contains the items as seen below.   

 

 

Users with the access level of Utilities will only see the following items on the Tools menu: 

Load ABA Routing Numbers 

Update Escrow Information 

Copy NAF Branch (if not Central NAF) 

View Table Statistics 

DSI Messaging Queue Manager 

Email Templates 

Report Statistics 

 

Each of the functions on the Tools menu will be described in detail in the following pages. 

  



 

USA Digital Solutions, Inc. Utilities v10.6.545 Manual 
07/08/2016 Page 165 of 183 

Load ABA Routing Numbers 

If the company has turned on the use of Wire Out Processing, Impact/SQL will compare the ABA 

numbers entered by users with those in a table filled with a download from the Federal Wire Directory. If a 

match is not found, the wire out will not be permitted. This data update should be done at least once a 

month to ensure it is kept current. Should the system tell you that an ABA number is not correct and you 

are reasonably sure it is (and you know, for example, the bank involved is relatively new), the first step to 

take would be the updating of the routing number table with this function. 

 

NOTE: While the Name and Address File (NAF) can store the ABA Routing Number for a bank, that 

field, on existing NAF entries, will not be updated through this function. 

When selected, the screen above will be shown. On it is a reminder as to the Website from which the file 

containing the data will be downloaded.   

Due to a recent change in the Federal Reserve’s website, the Import From: Website option is not able to 

be used (at least as of this writing – 5/18/15).   A message will be received if the Import From Website 

option is selected, indicating a manual effort is required.  

As of this writing, the Import From File function must be used, after the file of ABA routing numbers is 

manually downloaded by the user.   The site listed on the Load ABA Routing Numbers screen has been 

updated to the path the user should use in their Internet browser (shown above) – where they will be 

prompted to “Agree” to the terms of use, and then they should save the data that is presented to a 

location accessible from within Utilities.  The URL listed can be edited within Utilities > Setup Options > 

DSI Functions (by DSI Support personnel) in case there is another change to the URL in the future.   

The Import From: File radio button selection will let you point to the file to be imported and complete the 

replacement of the current table with the new data.   
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Update Escrow Information 

This function is available to both System Administrator and Utilities access levels. 

This function is rarely used. This function can be used to update escrow information if the Close Date 

&/or Recording Date are incorrect (they are generally set by the issuance of the “:T” payee check). 

Lastly, it can be used to change the IRS 1099-S reporting status if the Transaction Type of the file is set 

to a reportable type. When called for, the user will be prompted for the escrow number and then will be 

presented with the Update Escrow Information screen. 

 

If the screen is pulled up just to check on the status of a file or if no changes are to be made, click Cancel 

to close the screen. If changes have been made and you wish to save them, click OK. Both buttons will 

close the screen and return you to the Utilities desktop. 

 

Copy NAF Branch 

If the database is configured for NAF by Branch (not Centralized), this option will be available on the 

Tools menu.  It is used to make a duplicate of the NAF entries from one branch for another branch.  

When selected, the screen below will be presented. 

 

The drop-downs should be used to select the Branch to Copy From and the Branch to Copy To.   Click 

OK to execute the copy, or Cancel to return to the Utilities desktop. 
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Fix Ledger 

In rare instances, it may be necessary for the system administrator or a USA Digital Solutions, Inc. staff 

member to add, modify, or delete an entry in an escrow ledger through this function (rather than through 

normal front end functionality). This should be considered drastic action and should only be undertaken 

when all possible “front end” procedures have been evaluated to fix the issue at hand and the situation 

has been well researched and documented. Please consult USA Digital Solutions, Inc. staff before 

utilizing this function. 

The first screen presented, when this function is called, asks for the escrow number to be worked on. 

While the Search function is available, you really should know what escrow you intend to alter if you are 

using this function. Click Cancel to terminate the function. Click OK to continue once the escrow number 

has been entered. 

 

The Fix Ledger screen displays the posted ledger for the selected file. Unposted items can be corrected 

through the front end. Initially, no record is selected.  

 

   

NOTE: If an item is deleted, the branch balances will need to be updated through Utilities > 

System Files > Branch to reflect the missing transactions or an audit error will result. It is always a 

good idea to run an accounting audit before and after making any changes through the Fix Ledger 

function. 
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To create a new transaction, click  at the top of the screen. If you want to insert an entry above 

a specific record, highlight that record and then click . You will be asked to confirm that the new 

entry is to go above the highlighted entry.  If you indicate it should not be placed above the existing entry, 

a message will be provided that states that the new entry will be placed in date order. An empty Escrow 

Ledger screen is displayed below, on the left side. To modify an existing record within the ledger, 

highlight the record and click  Modify.  A populated Escrow Ledger screen is displayed below, on the 

right side.  These entries are not to be confused with the open check file entries. 

 

Either a receipt or disbursement item can be entered/modified through this screen. Again, it is very 

important that you are clear on what you are changing and have exhausted all other methods for 

correcting the situation before resorting to using this function. Document the ledger before and after any 

changes and keep good notes on what was done and why. If a new record is being entered, the fields will 

largely be blank; if modifying an existing item, they will be filled. 

Date: The date of the item is entered in the first field. This can be any historic date (up to the 

latest posting date). 

Post Order: Auto populated by the system on existing records. 

Initials: Enter the initials of the user entering the transaction. It will not default to the user logged 

in when adding a new transaction. When modifying a transaction, the initials of the user that 

created it will be listed in this box. 

Escrow Name: This field is filled in, as the escrow has already been identified. 

Payor: Enter the payor (on a receipt). If modifying a check, this field will be blank. 

Cleared: Identify the cleared status of a new item. The item will appear in the applicable 

reconciliation if set to No (uncleared).  It will not if set to Yes (cleared) to. 

Receipt Number: Enter the receipt number (all zeros if a check). 

Receipt Type: Select the receipt type from the drop-down list. 

Hold: Select Yes or No from the drop-down list to identify if the Hold flag is linked to the receipt. 

As these are posted items only, a held check would never appear here. 

Check Number: If there is an existing check, the number displays in this field. 
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Bank Number: Select the bank involved with the transaction. 

Manual: Indicates if the check is a manual check.  

NOTE: This is NOT the routine for entering a manual check, which is through Accounting > 

Disbursements > Manual Check Entry. 

Amount: Enter the amount of the transaction in this field. It will generally be positive for a receipt 

and negative for a check. Correcting receipts and voids will be counter to that. 

Click OK to save your changes, or click Cancel to close without saving. 

To modify an existing record within the ledger, highlight the record and click  Modify. 

To delete an existing record within the ledger, highlight the record and click  Delete. 

 

To work with a savings ledger associated with an escrow ledger, click on the savings account to be 

worked on the tree on the left side of the full ledger screen presented.  This will result in the selected 

savings ledger detail being presented on the right side of the screen, as shown below. 

 

The  or  Modify functionality discussed with the regular ledger exists with the savings ledger, 

but the screens are a bit different, and are presented below (one being add on the left, modify on the 

right). 

                                   

The fields presented are specifically applicable to savings ledger transactions. 

The    icon, at the top left of the Fix Ledger screen, when clicked, will prompt the user for the 

file number to be pulled up.  

The  icon, at the top right of the Fix Ledger screen, when clicked, will remove the 

summary data at the top of the screen and expand the area for ledger records.  It will switch to an 

 icon in that situation. 
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Fix Open Check File 

The Fix Open Check File menu option, on the Tools menu, is utilized to add a check into the Open 

Check File table or to change the status of a check that is already in the system. As with the Fix Ledger 

functions, these functions are only to be used after extensive research and consultation with USA 

Digital Solutions, Inc. staff. 

While this may sound similar to the discussion above for Fix Regular Ledgers, it is different. This section 

relates to checks in the Open Check File table. The Ledger is a separate and distinct data set from the 

Open Check File. While both contain information about checks, that information is kept in two different 

tables. In rare instances, an item may be in the ledger, but missing from the open check file, or visa-

versa, and so you may need to use one utility or both to correct an issue with a check. 

 

When the Fix Open Check screen first displays, it will look like the example above.  The body of the 

screen will display a message of No records found, and the  icon is at the top of the screen.  

There is also a Check Number: field and a Find button which are utilized to conduct a search for an 

existing check.  Modifications to an existing check would begin with a search for it. 

If a check is in the ledger of an escrow, but has been deleted out of the open check file or has never 

made it there for some reason, it can be added back through this screen. This would be a very unusual 

circumstance and USA Digital Solutions, Inc. staff should be consulted before using this functionality.   
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To start the process of adding an item, click  at the top of the screen to display the Add Open 

Check screen. 

 

Complete the following fields: 

Escrow Number: Enter the Escrow number for the check. 

Bank: This field auto-fills. 

Branch: This field auto-fills. 

Check Number: Enter the check number. 

Check Date: Enter the check date. 

Check Amount: Enter the check amount. 

Pay to Name: Enter the payee. 

Three status checkboxes are at the bottom of the screen:  

Manual Check – check this box if it was a manual check originally; 

Income Check/Fee Slip will be activated and checked if “:T” is entered in the Pay to Name field. 

Submitted for Positive Pay – check if you do not wish the check to appear in the next Positive 

Pay upload file (if it was already sent). 

The Cleared and Void date fields can be filled, as is warranted. 

There may also be very rare occurrences when the status flags on a check fail to maintain their correct 

setting(s), or the check status may need to altered if it were flagged as cleared improperly through a 

reconciliation, for example.  If this is the case, you can change their status through the Fix Open Check 

utility.  The first step is to enter the check number in the search field at the top of the screen and click the 

Find button.  In the sample below, a “5” was entered and all checks in the database numbered “5” 

(multiple banks exist) are presented.   
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The  Info icon, on a particular item, should be clicked on to present a static screen of information on the 

check, as shown to the right. 

The  Delete icon, when clicked will remove the check from the Open Check File, after prompting for a 

confirmation of that action. 

The  Modify icon, when clicked will present a screen like the one below, displaying the check 

information, through which three status flags and two dates can be altered.  The Submitted to Positive 

Pay flag can be turned on or off.  The Cleared and Void status flags, and related dates can also be 

changed, as needed.  

 

Click OK to save your changes, or click Cancel to close without saving. 
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Change Date on Unposted Batch 

A situation may arise where an Accounting batch has the incorrect date on it. This can happen if a local 

workstation or a Citrix or terminal server environment has an incorrect system date on it and an escrow 

user on that machine/system creates receipts and/or disbursements. An Accounting batch will be created 

with that machine’s incorrect date.  The Accounting user responsible for posting should notice that there 

is a batch with an unexpected date and should bring it to the attention of the system administrator.  

The system administrator can use this tool to correct the date on the file containing the Accounting data 

after an investigation determines that is the proper course of action. There are times when backdated 

transactions are legitimate and those will result in backdated batches, which would not be adjusted. 

When selected, the screen below will be presented. The records displayed will be of all the unposted 

batches. The date of the batch, the bank involved, the source branch, the branch name, the type of 

transactions contained in the batch, and the total amount of the transactions within the batch are detailed. 

Prior to changing the date on an unposted batch, it is a good idea to generate a report of the unposted 

listing in its original state by clicking , at the top left of the screen. This will generate the listing of all 

of the unposted batches. It does not contain the detail of each batch. The unposted Receipts Journal and 

the unposted Disbursements Journal should also be printed from the Accounting module before changing 

the date. To do this, login to the Accounting module, go to Receipts > Print Daily Receipt Journal for 

the unposted receipts and Disbursements > Print Daily Disbursements Journal for the unposted 

disbursements. 
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Click Modify, on a specific record to display the Change Date on Unposted Batch screen.  

 

Enter the correcting date in the New Date field and click OK to complete the change. All transactions 

within the batch will be re-dated. Click Cancel to close without making a change. 
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View File Statistics 

This function is available to both System Administrator and Utilities access code levels.  

There are times when troubleshooting issues that the System Administrator or USA Digital Solutions, Inc. 

staff would like to know the number of records in one or more of the system tables that make up the full 

data set of the Impact/SQL installation at the site. This menu selection is used to do just that. When 

opened, a screen like that shown is displayed. 

The table names and the number of records in each are listed in alphabetic order with a scroll bar down 

the right side. Click  to monitor changes to the record count(s) for one or more tables as the 

system runs. This might be used to observe the progress of a posting cycle, for example. This is also a 

good tool to use to see if features of Impact/SQL are being fully utilized.  
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Record Locks View/Clear 

SQL database systems rely on record locks to control access to data that is in the process of being 

altered, or potentially may be altered, based on where a user is viewing the data from. Should a user 

have a lock on one or more file records (including those on documents, prelims/commitments and 

invoices) and their computer freezes up or they get kicked out of Impact/SQL for some reason, the locks 

may not be released as they would normally be when a user closed the Impact/SQL module they were 

using or if they saved the file.   

This utility is provided to enable a System Administrator to monitor the file and document locks, as they 

are placed and released, and to clear a lock that has not been properly released. When selected, the 

system will grab a snapshot of the current locks that are in place and display them on a screen like that 

shown below (usually there will be far more displayed). The file number involved, the user, the lock 

origination date/time, server, and the table involved with the lock are all presented. 

 

Click  to display an updated list of locks that are in place at the moment the button is clicked. As 

locks are placed and released constantly, the listing can be updated every few seconds or minutes to aid 

in researching an issue, for example.  

The Filter field can be used to enter information to filter the listing with (such as a file number).  Once 

entered, click the Filter button to execute the filter function.  This is helpful in an active database with lots 

of users working on lots of files, to limit the data presented on the screen. 

To release a lock that persists after a user closes all Impact/SQL modules they were logged into, click on 

the checkbox in front of the record detailing the lock and then click the Clear Selected button. You will be 

prompted to confirm that you wish to remove the lock. 

Care should be taken to not clear locks unless it has been confirmed that the item is not actively being 

worked. 

Click Cancel to close the window, without affecting any locks that are displayed. 
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Event Log 

Impact/SQL maintains a rolling event log, of a controlled size, of SQL errors and other message 

generated by the system in response to unexpected user actions or data / system conditions that are 

unanticipated.  The Event Log function will present a screen listing of the current contents of the event 

log. 

Many of the events will be reported at the time they occur to the user, on their screen, but not all of them 

are.   

 

The screen listing identifies the Category of the event (Error , Warning  or Information ), User 

Name, Date/Time of the event and the beginning of the Description of the 

event.   

Click  to refresh the view. 

A filter can be applied to the listing, by clicking on the  New Filter icon. 

The Filter screen is shown to the right.  Start and End Dates, Category, 

User Name, Description Contains and Computer Name are all filter 

options.  

Clicking on an event notice will bring up a more detailed screen, like that 

shown to the left.  The information in the message can be copied to the 

user’s clipboard with the Copy icon.  The Email and Send To DSI 

buttons will let the user route error information to Support.  Many of these 

details will be meaningful only to the USA Digital Solutions, Inc. staff.  

The user can move through the event listing with the  and arrow icons. 
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USA Digital Solutions, Inc. Messaging Queue Manager 

The DSI Messaging Queue Manager can be used to determine the status of messaging events.  Specific 

integrations can be interrogated, and filters can be used to narrow the returned data.  This tool is primarily 

for the use of USA Digital Solutions, Inc. personnel. 
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Email Templates 

The Email Templates function is used to customize the content of automatic emails that are generated 

through various Impact functions.  The Description of each indicates when it is used in Impact/SQL. 

The  Print icon will generate a report listing all of the data shown on the Email Templates screen. 

 

The  Modify icon is used to access the screen through which any particular template is customized.  

Once customized, an indication that the template has been modified is shown on the main screen 

(Customized = Y).  A template that has been customized can be returned to its default state via the 

modification screen, with the Restore Default button. 

The email template can be customized for appearance, text, subject line and HTML coding, as will be 

described on the following page. 

The email templates cannot be deleted.  They are required for Impact/SQL operation.  Some can be 

turned off via Setup Options. 
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In the sample below, the  Modify icon was clicked on the TIAMMENDORDER record. 

 

The information presented, in this sample, is the default template for email sent when an Amended Title 

Order is submitted. 

On the left side of the screen are database fields that are available for inclusion in the particular template 

being edited.  In this sample, 14 of the 16 available fields are used in the default Design. 

At the top of the screen, the Email Subject line text can be edited.  Click on the Custom Email Subject 

checkbox to open the Email Subject field for editing.  Database fields can be included in the Email 

Subject line by placing the cursor where the field should occur and then double clicking on the field to be 

included (on the list on the left).  Unchecking the Custom Email Subject checkbox will return the Email 

Subject to the default description. 

The Email Body can be customized in the same manner.  Check on the Custom Email Body checkbox 

and, on the Design tab, the content of the body of the email can be altered.  Text should be typed in, and 

fields added, where the cursor is located, by double clicking on the applicable field on the listing on the 

left side of the screen.  Unchecking the Custom Email Body checkbox will return the Email Body to the 

default body. 

The HTML tab can be used to further customize presentation – by someone who has HTML knowledge. 

If changes have been made, and they are unacceptable, and the user wants to start over with the original 

template, the Restore Default button, at the bottom left of the screen, should be clicked.  A prompt will 

confirm that the default should be restored. 

The Test button, at the bottom left of the screen, is used to present a sample of the email that would be 

produced from the template as it sits. 

The OK button is used to keep the changes made to the template. 

Cancel will close the screen without saving any edits that might have been made. 
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Report Statistics 

Statistics are collected on Crystal Reports (standard and custom) that are run via the Escrow, Title, 

Accounting, MIS, Reconveyance Tracking, and Utilities modules.  Title Instructions printed via the Impact 

Windows Service are not tracked by this new process, as they are already being logged in the Event Log.   

Users with Utilities access can see reports on all modules’ report-running statistics, via the 

Tools>Report Statistics menu path, in the Utilities module. Note there are report tabs on the left of the 

screen for each module’s report.   

Both the Escrow and MIS Custom Reports statistical reports will present the custom report menus and 

indicate the number of times (since the upgrade to version 10.3) each report has been run, the first and 

last dates each was run, and by whom.  This will aid in the effort to determine which custom reports are 

actively used and should be maintained when changes to underlying report criteria (income code 

groupings, for example) are made. 

 

SoftPro 360 

This entry will only be present if the site is configured for SoftPro 360.  Please consult with DSI Support 

for information about SoftPro 360. 

Please see the Impact SoftPro 360 Administration Guide for an explanation of the options under this 

menu entry. 

 

 

SoftPro 360 

About 

This entry will only be present if the site is configured for SoftPro 360. 

The SoftPro 360 menu,  has a single entry on it:  About.  Clicking on this menu entry will bring up an 

information screen about the SoftPro 360 integration that is installed. 
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About 

The About menu displays a splash screen of information about the current installation of Impact/SQL, as 

shown below. When a call is placed to USA Digital Solutions, Inc. Support about an issue, you may be 

asked to refer to this screen for the version and build number.  The scroll bar, on the right, will let the user 

scroll through a listing of all installed components relating to Impact/SQL. 

A link to the USA Digital Solutions, Inc. web-site is in the upper right corner of the screen.  Documentation 

for all Impact/SQL modules is available on the website, in addition to documentation on changes that 

have been made to each module since the last full manuals were prepared. 

Similar screens are available in each Impact/SQL module and build numbers may NOT be the same for 

each module. 
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Appendix A - Troubleshooting 

USA Digital Solutions, Inc. (DSI) Support personnel may ask that you make a screen shot so that you can 

e-mail Support a “picture” of the screen as it appears when the error occurs. 

To create this screen shot, save it and send it to the Support personnel, do the following: 

Press the PRINT SCREEN key on the keyboard, which is usually located on the top row of the keyboard, 

and is usually the third key from the right. 

Open your e-mail client, start a new e-mail, to Support@Digisolaz.com, and Paste the screen shot into 

the body of the e-mail.  This will work if the e-mail format is HTML.  If the screen shot does NOT paste 

properly, open an MS Word document and paste the screen shot into it; save the MS Word doc; and, 

attach it to an email addressed to Support@Digisolaz.com. 

DSI Support personnel can be reached at (602) 866-8199 extension 2. 
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